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CHAPTER 1 : LOGGING ON

This chapter explains how to:

• Log on to the Oracle Daybreak system
• Change a password
• Reset a password
• Log off from the Oracle Daybreak system.

Logging on
At the beginning of each Oracle Daybreak session and prior to working with any applica-
tion, you must log on at your workstation. Oracle Daybreak then allows you to “enter” the 
system and open the programs available according to your level of responsibility. To log 
on to Oracle Daybreak, you need to have your own user id and password. Each user id is 
attached to a responsibility level, or “profile,” that controls the user’s access to various 
areas of the system. Your user id is associated to all the applications you process. 

The ability to log on is automatically disabled after a specified number of days of inactiv-
ity. The user id and password required to log on to Oracle Daybreak may be different from 
the user id and password used to log on to your computer or network. If you are unsure of 
your user id and password for Oracle Daybreak, contact your system administrator.

To log on to the Oracle Daybreak system

1 Follow the guidelines for your business to launch the iAS window and begin a Oracle 
Daybreak session. 

After starting Oracle Daybreak, the Login form appears.

2 In the User Id field, type your user identification name.
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3 Press TAB to move to the Password field.
-or-
Click the Password field.

4 In the Password field, type your password.

5 Choose Connect.
-or-
Press ENTER.

Note: If you choose Cancel, Oracle Daybreak closes the Login form.

If your user id or password is inaccurate, Oracle Daybreak displays the following dialog 
box:

• Choose OK and retype your user id and password. If problems logging on persist, con-
tact your system administrator.

IMPORTANT: 
The length of a password is established during system setup. Special characters (&, @, #, 
$, %, ^, &, *, and so on) cannot be used to create a password. To prevent others from see-
ing your password, your password does not appear in the Password field as you type it. 
Instead, your keystrokes appear as asterisks (*). Keep your password confidential to pre-
vent access to Oracle Daybreak by unauthorized users.

If Oracle Daybreak recognizes your user id and password, the login form updates to dis-
play and automatically complete the User Id, User Name, Responsibility, Organization, 
and Division fields. Your user id appears as the title of the form.
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When you successfully log on to Oracle Daybreak, the menu items available to your 
responsibility are available. (Whatever menu items are “unavailable” are visible, but 
dimmed.)

If you have not logged out of Oracle Daybreak, have an old Oracle Daybreak session 
open, or you did not correctly exit your previous Oracle Daybreak session, when you 
attempt to log in again, the following dialog box appears:

•  Choose Yes to close your existing sessions.

Note: The majority of the time, you will choose Yes. Choose No only if you want to work 
with multiple Oracle Daybreak sessions.
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Changing passwords
Passwords will automatically expire after a period of time set by your system administra-
tor. Oracle Daybreak notifies you of approaching password expiration dates with a mes-
sage dialog box that appears after you log on. 

To change your password

1 Close all open Oracle Daybreak forms and return to the User Id form.

2 On the File menu, choose Change Password.

The Old Password, New Password, and Confirm New Password fields appear on the form, 
along with the Change Password and Cancel buttons.

3 In the Old Password field, type your old password and press TAB.

4 In the New Password field, type your new password and press TAB.

5 In the Confirm New Password field, retype your new password and choose Change 
Password.

Oracle Daybreak displays the following dialog box:

6 Choose Ok.
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Resetting passwords
Oracle Daybreak allows you to reset your password from the Login form by choosing the 
Forgot Password button. This command button can be used when:

• You forget your password
• You discover that your password is not working (as another user might have disabled 

or changed it)
• Oracle Daybreak disables your password after you entered the wrong password multi-

ple times.

To reset your password with the Forgot Password button

1 Close all open Oracle Daybreak forms and return to the User Id form.

2 In the User Id field, enter your user identification.

3 Choose Forgot Password.

Oracle Daybreak generates a random alphanumeric password and sends this new pass-
word to the email address listed in your record on the Administration form’s Users page. 
Oracle Daybreak then displays a Forms dialog box with the message “Password Reset 
Successfully. You should receive the new password in your email shortly.”
Chapter 1 :-5  User Guide - Consumer Loans Origination



Logging off
When exiting Oracle Daybreak, always use one of the following procedures:

• On the File menu, choose Exit or Re-Logon
-or-
On the Oracle Daybreak menu bar, choose Exit.
-or-
On the Login form, press CTRL+Q.

Oracle Daybreak closes the session and releases any applications you may have been 
working on.

IMPORTANT: 
Do not choose the Close button on the Oracle Daybreak menu bar to end a Oracle Day-
break session. 
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CHAPTER 2 : ENTERING AN APPLICATION

The first step in the loan origination process is entering credit application data into Oracle 
Daybreak. The Application Entry form allows you to enter information from the credit 
application into the Oracle Daybreak system and request a credit bureau report.

Credit applications are mailed or faxed to financial institutions indirectly through produc-
ers (or “dealers”) on behalf of the customer. These credit applications, if received as a fax, 
can be stored in Oracle Daybreak as images. The Application Entry form’s split screen 
allows you to view the application as an image in the upper list box while you enter the 
loan application on the form in the lower master block, pages, and sub pages.

Applications can be entered with images, or without.

This chapter explains how to use the Application Entry form to:

• View a credit application image
• Enter an credit application either with or without an image
• Validate a credit application
• Process a credit application.

IMPORTANT:
In completing the Application Entry form, as well as all other forms in the Oracle Day-
break system, type your entry (or select it from an LOV when available), then press TAB to 
move to the next field. Pressing TAB will guide the cursor to the next appropriate field. 
(Pressing SHIFT + TAB moves the cursor back to the previous field). Pressing ENTER may 
not move the cursor, and using the mouse to do so may upset the logical order of entry pro-
cess.
Chapter 2 :-1  User Guide - Consumer Loans Origination



Entering a credit application (an overview)
The following diagram depicts the workflow of entering applications into Oracle Day-
break:

There are four main steps in completing the Application Entry form:

1 Select the product type and producer in the Application Entry form’s master block. 
The product defines the type of credit application: loan, as well as any collateral, such 
as vehicles or homes, associated with the loan. When you save the application, Oracle 
Daybreak dims the tabs on the Application Entry form that are not associated with the 
product, streamlining the application process.The producer is the dealer supplying the 
application. 

2 Enter information regarding the primary applicant, such as name, social security num-
ber, address, place of employment, and financial assets and liabilities. Enter this same 
information for any other applicants, such as co-signers or joint applicants, if they 
exist.

3 Enter information about the requested credit for the loan such as loan amount and 
number of terms.

4 Enter information about the collateral, if this is a secured credit request.

When finished, Oracle Daybreak checks the application for completeness using a pre-
defined set of edits. These edits search for errors and warnings based on your system 
setup. These edits can be defined to check that specific fields are completed, as well as 
automatically change the status of the application based on its contents. For example, edits 
can be set up to automatically approve or reject an application based on a minimum salary 
of the applicant, or maximum age of asset. The prescreening checks ensure that automatic 
credit bureau reports are pulled only for applications which meet set criteria, thus saving 
cost.

After an application clears the edits check, choose Next Application. Oracle Daybreak 
begins the processes of prescreening the application and pulling a credit bureau while you 
can begin entering the next application in your queue.
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Viewing an application in Oracle Daybreak
If your company is using a fax server to receive applications, the first step is to open the 
application image with the Application Entry form. 

To view a credit application image

1 On the Lending menu, choose Application Entry.

An untitled Application Entry form appears.

2 Choose Next Application.

Oracle Daybreak displays the next application in the application queue. The image 
appears in the upper portion of the Application Entry form and the default information 
appears in the master block.

If you choose Next Application and no images are available, Oracle Daybreak displays 
the following dialog box:

• Choose Ok.
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The Application Entry form master block contains the following command buttons:

If you choose: Oracle Daybreak will:

Next Application Display the next application image.
Pr Display the previous page of the image (if one exists).
Nx Display the next page of the image (if one exists).
Up Scroll up through the selected image.
Dn Scroll down through the selected image.
Flip Image Rotate the selected image.
Print Image Send the selected image to a predefined printer.

Depending on the position of the application when it was faxed to the Oracle Daybreak, 
the image may be inverted on the Application Entry form.

3 To rotate an upside-down image, choose Flip Image on the Application Entry form master 
block.

4 To navigate through the application:

• Use the scroll bar 
-or- 

• Choose Dn and Up on the Application Entry form master block.

The Page # and Of fields display what page is currently displayed in the Application 
Entry form and the total page length of the image.

5 To view other pages of the application, if they exist, choose Nx and Pr on the Application 
Entry form master block.
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Entering an application without an image
In some cases, an application may not have an image associated with it. The application 
might be faxed directly to you, or the information might be supplied over the phone. 

To complete an application that doesn’t have as image

1 On the Lending menu, choose Application Entry.

2 Choose No Image in the master block and begin entering the application data.

Oracle Daybreak leaves the Fax Header, Status, Company, Page # and Of fields blank and 
moves the cursor to the App # field.
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Completing the Application Entry form’s master block
You can enter a credit application either with or without an image. In either case, when 
using the Application Entry form, you must complete the Product and Producer fields in 
the master block before you can begin entering information about the applicant and loan 
request. The contents of the Product and Producer fields will determine which tabs will be 
made unavailable on the Application Entry form and elsewhere in the Oracle Daybreak 
system. 

i-flex solutions recommends that you save your work periodically as you enter the applica-
tion. The first time you save an application, Oracle Daybreak assigns it an application 
number.

To complete the Application Entry form’s master block

1 On the Lending menu, choose Application Entry.

2 Choose Next Application to load an application in the upper list box.
- or -
Select No Image if there is no image in the upper list box.

3 In the Application Entry master block, enter or view the following information. Press the 
TAB key to move between fields:

In this field: Do this:

Fax Header View the fax header, the subject line data of the e-mail 
sent to Oracle Daybreak by the fax server. This data is 
dependent on the configuration of the fax server (display 
only).

Status Select the image status (required).
Company View the company (display only).
Branch (unlabeled) View the branch (display only).
Page # View the page number of the application image on dis-

play (display only).
Of View the total number of pages in the application image 

(display only).
Dt Enter the application date (required).
App Company View the company (required).
App Branch (unlabeled) View the branch (display only).
Priority Select the priority of the application (required).
CRB Pull If this box is selected, Oracle Daybreak will perform an 

initial credit bureau report pull after the application 
passes the prescreen edits. Clear the check box if you 
want to enter an application without pulling a credit 
report. To use a previously pulled credit bureau report, 
clear this box and complete the Bureau and Bureau Reor-
der # fields on the Primary Applicant page).
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Joint If this is a joint application, select Joint. A joint applicant 
is equally liable for the loan. 

Cos If this is a co-signed application, select Cos. The primary 
applicant is the purchaser/recipient of the loan. If that 
person defaults, then the cosigner is responsible
A note about Joint and Cos (co-sign):
When pulling credit bureaus, a joint pull can only occur 
for married couples. The pull will contain complete credit 
histories for both individuals in one report. 
In a co-signed application, the credit bureau will be 
pulled twice, once for each applicant.

Underwriter View the underwriter’s name (display only).
Purpose Select the purpose for lending (optional).
Contact Enter the contact of the application. This is a free form 

field that can be used to indicate who supplied the appli-
cation being entered into Oracle Daybreak (optional).

Channel Select how the application was received; for example, 
fax, web entry, or phone (required).

Product Select the type of product you are entering (required).
Lead # Select the sales lead number (optional).
Producer Select the producer associated with the product 

(required).

4 Save your application.

When you save the application for the first time, Oracle Daybreak assigns it an application 
number and, based on the contents of the Product field, dims the non-applicable tabs.
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Entering primary applicant information
Using the information supplied on the application, complete the Primary Applicant page 
and sub pages (Address, Employments, Telecoms, Financials, Liabilities, and Other 
Incomes sub pages). Oracle Daybreak uses the information on the Financial and Liabili-
ties sub pages in determining the applicant’s net worth. Oracle Daybreak uses information 
on the Employments page and Other Incomes sub page to calculate the applicant’s debt-to-
income ratio.

This section explains how to complete each page and sub pages.

IMPORTANT: 
While the following fields are marked required, display only, and optional, these are Ora-
cle Daybreak’s default settings. The actual status for a field might differ on your system, 
depending on how it is configured.

NOTE:
When completing Frequency fields, please note the following:

• Biweekly in Oracle Daybreak means “once every two weeks” and not “twice a week.”
• Bimonthly in Oracle Daybreak means “once every two months” and not “twice a 

month.”

For more information, see Appendix D: Payment Amount Conversion.

To complete the Primary Applicant page

1 Choose the Primary Applicant tab.

2 Use the application to enter the following information on the Primary Applicant page:

In this field: Do this:

First Name Enter the applicant’s first name (required).
MI Enter the applicant’s middle name or initial (optional).
Last Name Enter the applicant’s last name (required).
Suffix Select the name suffix/generation (optional).
SSN Enter the applicant’s social security number (required).
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Birth Dt Enter the applicant’s date of birth (required).
Disability Select if the application has a disability (optional).
Prior Bkrp Select if prior bankruptcy exists (optional).
Bkrp Discharge Dt Enter the discharge date of prior bankruptcy (if one 

exists) (optional).
Bureau If you want to receive a copy of a previously pulled credit 

bureau report, select the previously pulled credit bureau. 
This field is used in conjunction with the Bureau Reorder 
# and the CRB Pull check box in the master block.
Note: Currently, First American Credco (Credco) is the 
only bureau that offers the reorder feature (optional).

Bureau Reorder # If you want to receive a copy of a previously pulled credit 
bureau report, enter the credit bureau reorder number. 
This allows you to receive a previously pulled credit 
report from Credco (currently other bureaus do no pro-
vide a copy). Note: You can view the credit bureau reor-
der number from a previously pulled report on the 
Underwriting form’s Bureau (4) master tab in the Bureau 
Details block (optional).

Gender Select the gender of the applicant (optional).
Language Select the applicant’s native language (required).
License # Enter the applicant’s license number (optional).
License State Select the state of the applicant’s license (optional).
Email Enter the applicant’s email address (optional).
Class Select the applicant’s classification; for example, NOR-

MAL or EMPLOYEE. Oracle Daybreak uses this informa-
tion to restrict access to the database by recognizing 
employees as “secured applications.” 
You can create a SME (Small Medium Enterprise) appli-
cation by selecting SMALL BUSINESS. When you select 
SMALL BUSINESS and save your entry, the Business tab 
on the Application Entry form is available.(required).

Marital St Select the marital status of the applicant (optional).
Dependents Enter the number of dependents (optional).
Mother’s Maiden Nm Enter the mother’s maiden name (optional).
ECOA Select the ECOA (Equal Credit Opportunity Act) code. 

This defines the various possibilities on who is liable; 
individual, joint, cosigner, and so on (optional).

Ethnicity Select the applicant’s ethnicity. This is information the 
Home Mortgage Disclosure Act requires to be reported 
(optional).

Race Select the applicant’s race or national origin (optional).
Privacy Opt-Out If necessary, select the check box to indicate that the 

applicant has elected to refrain from the non-public shar-
ing of information (optional).

Time zone View the time zone for the applicant. This information 
appears when you enter and save the zip code for the pri-
mary applicant’s current home address on the Address 
sub page. You can also manually complete this field 
(optional).

3 Save your entry.
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To complete the Address sub page

You can enter more than one address for each applicant, such as a home address, second 
home address, and vacation home address. However, atleast one must be marked as cur-
rent. Also, only one address can be selected as the mailing address, and that address must 
be marked as current. Finally, while you can have more than one Home type address, only 
one can be marked as current.

1 Choose the Address sub tab.

2 Use the application to enter the following information on the Address sub page:

In this field: Do this:

Type Select the address type (required).
Mailing Select if this is the mailing address. Only one address 

entry can be marked as the mailing address (required).
Current Select if this is a current address. Note: The mailing 

address must be marked as current (required).
Postal Type Select the postal address type (required).
# Enter the building number (required).
Pre Select the street prefix (directional) (optional).
Street Name Enter street name (optional).
Street Type Select the street type (optional).
Post Select the street postfix (directional) (optional).
Apt No Enter the apartment number (optional).
Own / Rent Select the ownership type (required).
Address 2 (unlabeled) Enter the address line 2 (optional).
Zip Select the zip code (required).
City Enter the city (required).
St Select the state (required).
Zip Extension (unlabeled) Enter the zip extension (optional).
Country Select the country code (required).
Ph Enter the phone number (required).
Stated (Yrs) Enter the stated number of years at residence (required).
Stated (Mths) Enter the stated number of months at residence 

(required).
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Stated (Amt) Enter the stated payment amount (required).
Sated (Freq) Enter the stated payment frequency (required).
Landlord Enter the landlord’s name (optional).
Ph Enter the landlord’s phone number (optional).
Census Tract/BNA Code Enter census tract/BNA (block numbering area). These 

are defined by the US Census Bureau code (optional).
MSA Code Enter the metropolitan statistical area (MSA) code. These 

are similar in concept to a zip code, but used mostly on 
government reports (optional).

Comment Enter a comment (optional).

3 Save your entry.

4 If there are more than one addresses associated with the applicant, press F6 to clear the 
Address sub page and repeat steps 1-3.

To complete the Employments sub page

1 Choose the Employments sub tab.

2 Use the application to enter the following information on the Employments sub page:

In this field: Do this:

Current Select if this is the current employment (optional).
Type Select the address type (required).
Employer Enter the employer’s name (required). 
Address Enter the building number (optional).
Address 1 (unlabeled) Enter the address line 1 (optional).
Address 2 (unlabeled) Enter the address line 2 (optional).
Zip Select the zip code (optional).
City Enter the city (optional).
St Select the state (optional).
Zip Extension (unlabeled) Enter the zip code extension (optional).
Country Select the country (required). 
Occupation Select the occupation (optional).
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Title Enter the title (optional).
Ph Enter the work phone number (required). 
Extn Enter phone extension (optional).
Comment Enter a comment (optional).
Stated (Yrs) Enter the stated number of years with the employer 

(required).
Stated (Mths) Enter the stated number of months with the employer 

(required).
Stated (Income) Enter the stated income (required).
Stated (Freq) Enter the stated income frequency (required).

3 Save your entry.

4 If there are more than one sources of employment associated with applicant, press F6 to 
clear the Employments sub page and repeat steps 1-3.

To complete the Telecoms sub page

The Telecoms sub page only needs to be completed if additional phone numbers exist. If 
not, this sub page can be left blank. 

1 Choose the Telecoms sub tab.

2 Use the application to enter the following information on the Telecoms sub page:

In this field: Do this:

Telecom Type Select the telecommunication type (required).
Phone Enter the phone number (required).
Extn Enter the phone extension (optional).
Start Time Enter the best time to call start time (optional).
Time Period (unlabeled) Select the time period for the best time to call start time, 

AM or PM (optional).
End Time Enter the best time to call end time (optional).
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Time Period (unlabeled) Select the time period for the best time to call end time, 
AM or PM (optional).

Time Zone Select the applicant’s time zone (optional).
Current Select if this telecom number is current (optional).

3 Save your entry.

4 If there are more than one sources of telecom numbers associated with the applicant, 
repeat steps 2 and 3.

To complete the Financials sub page

The Financials sub page only needs to be completed if financial assets exist on the applica-
tion. If not, this sub page can be left blank. 

1 Choose the Financials sub tab.

2 Use the application to enter the following information on the Financials sub page:

In this field: Do this:

Type Select financial type; for example, liquid assets, retire-
ment assets, and so on (required).

Source Enter source; for example, stocks, 401K, rent received, 
and so on (optional).

Amt Enter amount (required).
Comment Enter a comment (optional).

3 Save your entry.

4 If there are more than one financial assets associated with the applicant, repeat steps 2 and 
3.
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To complete the Liabilities sub page

The Liabilities sub page only needs to be completed if financial liabilities exist on the 
application. If not, this sub page can be left blank. 

1 Choose the Liabilities sub tab.

2 Use the application to enter the following information on the Liabilities sub page:

In this field: Do this:

Type Select the liability type (required).
Amt Enter the liability amount (required).
Freq Select the frequency (required).
Account Type Enter the account type (required).
Balance Enter the account balance (required).
Comment Enter a comment (optional).

3 Save your entry.

4 If there are more financial liabilities associated with the applicant, repeat steps 2 and 3.
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To complete the Other Incomes sub page

The Other Incomes sub page only needs to be completed if other incomes exist on the 
application. If not, this sub page can be left blank. 

1 Choose the Other Incomes sub tab.

2 Use the application to enter the following required information on the Other Incomes sub 
page:

In this field: Do this:

Type Select the income type (required).
Amt Enter the income (required).
Freq Select the income frequency (required).

3 Save your entry.

4 If there is more than one other income associated with the applicant, repeat steps 2 and 3.
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Entering other applicant information
The Other Applicants page only needs to be completed if a secondary or joint applicant 
exists. If not, this page can be left blank. The Other Applicants sub pages are the same as 
the Primary Applicant sub pages, with the addition of the Copy Prim Address box on the 
Address sub page.

To enter other applicant information

1 If other applicants are included on the application, choose the Other Applicant tab.

The Other Applicants page contains the same fields as the Primary Applicant fields, with 
the addition of the Type field. Use this field to select the relationship type; for example, 
spouse, secondary, or cosigner.

2 Complete the Other Applicant page and sub pages (Address, Employments, Telecoms, 
Financials, Liabilities, and Other Incomes sub pages).

Note: If the other applicant shares the same address information as the primary applicant, 
on the Address sub page, select Copy Prim Address to copy the primary applicant’s cur-
rent mailing address to this sub page.

3 Save your entry after you complete each page and sub page.

Note: If there is more than one other applicant, press F6 to refresh the Other Applicant 
page and repeat steps 2 and 3. Each other applicant must have a unique entry in the Type 
field.
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Entering business applications (SME Lending)
Oracle Daybreak can record SME business related financial information and business 
partners on the Business page to assist in approving the loan application during underwrit-
ing. The Business page is available for loans and contains the following sub pages:

• Address
• Telecoms
• Financials
• Liabilities
• Partners
• Affiliates
• Other Details

To enter business information

1 If SME business information is included on the application, select SMALL BUSINESS in 
the Class field on the Primary Applicant page and save your entry.

The Business tab on the Application Entry form is available.

2 Use the application to enter the following information on the Business page:

In this field: Do this:

Organization Type Select the organization type (required).
Type of Business Select the type of the business (required).
Name of the Business Enter the name of the business (required).
Legal Name Enter the legal name of the business (required).
Tax Id # Enter the tax identification number (required).
Start Date Enter the business start date (required).
# of Employees (Curr) Enter the current number of employees at the business 

(required).
# of Employees Enter the number of employees at the business after 

financing (required).
Contact person Enter the contact person at the business (optional).
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Business Checking Bank Enter the bank name of the business’s checking account 
(required).

Bank Account Number Enter the bank account number (required).
Average Checking Balance Enter the average checking balance (required).
# of Locations Enter the number of locations of the business (required).
Management Since Enter the year the current management was established 

(required).

3 Save your entry.

To complete the Business tab’s Address sub page

You can enter more than one address for the business.

1 Choose the Business tab’s Address sub tab.

2 Use the application to enter the following information on the Business tab’s Address sub 
tab:

In this field: Do this:

Postal Type Select the postal address type (required).
# Enter the building number (required).
Pre Select the street prefix (directional) (optional).
Street Name Enter street name (optional).
Street Type Select the street type (optional).
Post Select the street postfix (directional) (optional).
Apt No Enter the apartment number (optional).
Address 2 (unlabeled) Enter the address line 2 (optional).
Zip Select the zip code (required).
City Enter the city (required).
St Select the state (required).
Zip Extension (unlabeled) Enter the zip extension (optional).
Country Select the country code (required).
Ph Enter the phone number (required).
Ph Enter the landlord’s phone number (optional).
Own / Rent Select the ownership type (required).
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Comment Enter a comment (optional).

3 Save your entry.

4 If there are more than one addresses associated with business, press F6 to clear the 
Address sub page and repeat steps 1-3.

To complete the Business tab’s Telecoms sub page

The Business tab’s Telecoms sub page only needs to be completed if additional phone 
numbers for the business exist. If not, this sub page can be left blank. 

1 Choose the Business tab’s Telecoms sub tab.

2 Use the application to enter the following information on the Business tab’s Telecoms sub 
page:

In this field: Do this:

Telecom Type Select the telecommunication type (required).
Phone Enter the phone number (required).
Extn Enter the phone extension (optional).

3 Save your entry.

4 If there are more than one sources of telecom numbers associated with the business, repeat 
steps 2 and 3.
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To complete Business tab’s Financials sub page

The Business tab’s Financials sub page only needs to be completed if financial assets exist 
on the application for the business. If not, this sub page can be left blank. 

1 Choose the Business tab’s Financials sub tab.

2 Use the application to enter the following information on the Business tab’s Financials 
sub page:

In this field: Do this:

Type Select financial type; for example, liquid assets, retire-
ment assets, and so on (required).

Source Enter source; for example, stocks, 401K, rent received, 
and so on (optional).

Amt Enter amount (required).
Comment Enter a comment (optional).

3 Save your entry.

4 If there are more than one financial assets associated with the business, repeat steps 2 and 
3.
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To complete Business tab’s Liabilities sub page

The Business tab’s Liabilities sub page only needs to be completed if financial liabilities 
exist on the application for the business. If not, this sub page can be left blank. 

1 Choose the Business tab’s Liabilities sub tab.

2 Use the application to enter the following information on the Business tab’s Liabilities sub 
page:

In this field: Do this:

Type Select the liability type (required).
Amt Enter the liability amount (required).
Freq Select the frequency (required).
Account Type Enter the account type (required).
Balance Enter the account balance (required).
Comment Enter a comment (optional).

3 Save your entry.

4 If there are more financial liabilities associated with the business, repeat steps 2 and 3.
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To complete the Business tab’s Partners sub page

You can enter more than one partner for the business.

1 Choose the Business tab’s Partners sub tab.

2 Use the application to enter the following information on the Business tab’s Partners sub 
tab:

In this field: Do this:

First Name Enter the partner’s first name (required).
MI Select the partner’s middle name (optional).
Last Name Enter the partner’s last name (required).
Suffix Enter the partner’s suffix (optional).
SSN Enter the partner’s social security number (required).
Birth Dt Enter the partner’s birth date (required).
Birth Place Enter the partner’s birth place (optional).
Title Select the partner’s title (optional).
Ownership (%) Enter the percentage of ownership held by the customer 

(required).
Networth Enter the partner’s net worth (required).
Gross Income Enter the partner’s gross income. (required).
Language Enter the partner’s language (required).
Nationality Enter the partner’s nationality (optional).

Address block
Address (#) Enter the partner’s address number (required).
Address (unlabeled) Enter the partner’s address (required).
Address 2 (unlabeled) Enter the partner’s address line 2 (optional).
Zip Select the partner’s zip code (required).
City Enter the partner’s city (required).
St Select the partner’s state (required).
Zip Extension (unlabeled) Enter the partner’s zip extension (optional).
Country Select the partner’s country code (required).
Ph Enter the partner’s phone number (required).
Email Enter the partner’s email (optional).

3 Save your entry.

4 If there are more partners associated with the business, press F6 to clear the Partners sub 
page and repeat steps 2 and 3.
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To complete the Business tab’s Affiliates sub page

You can enter more than one affiliate for the business.

1 Choose the Business tab’s Affiliates sub tab.

2 Use the application to enter the following information on the Business tab’s Affiliates sub 
tab:

In this field: Do this:

Organization Type Select the affiliate’s organization type (required)
Legal Name Enter the affiliate’s legal name (required)
Business Name Enter the affiliate’s business name (required)
Tax ID Enter the affiliate’s tax identification (required)
Ownership (%) Enter the affiliate’s percentage of ownership (required)
Number of Employees Enter the affiliate’s number of employees (required)
NAICS CODE Enter the affiliate’s North American Industry Classifica-

tion System code (required).

Address block
Address (#) Enter the affiliate’s address number (required).
Address (unlabeled) Enter the affiliate’s address (required).
Address 2 (unlabeled) Enter the affiliate’s address line 2 (optional).
Zip Select the affiliate’s zip code (required).
City Enter the affiliate’s city (required).
St Select the affiliate’s state (required).
Zip Extension (unlabeled) Enter the affiliate’s zip extension (optional).
Country Select the affiliate’s country code (required).
Ph Enter the affiliate’s phone number (required).
Email Enter the affiliate’s partner’s email (optional).

3 Save your entry.

4 If there are more partners associated with the business, press F6 to clear the Affiliates sub 
page and repeat steps 2 and 3.
Chapter 2 :-23  User Guide - Consumer Loans Origination



To complete the Business tab’s Other Details sub page

The Other Details sub page records information regarding monetary amounts associated 
with the business such as profits, sales, and expenses.

1 Choose the Business tab’s Other Details sub tab.

2 Use the application to enter the following information on the Business tab’s Affiliates sub 
tab:

In this field: Do this:

Analysis Frequency Select the analysis frequency (required).
Gross Margin Enter the company gross margin factor (required).
Income Amt Enter the business income amount (required).
Business Expenses Amt Enter the business expenses amount (required).
Personal Expenses Amt Enter the personal expenses amount (required).
Sales Revenue (Annual) Enter the annual sales revenue (required).
Projected Sales Amt Enter the sales amount projected (required).
Collection Average Enter the collection average (required).
Proj Coll Avg Annual Enter the projected collection average annual (required).
Book List Enter the business booklist (required).
Open Delq Enter the open delinquency (required).
Turnover Enter the turnover amount (required).
Equity Enter the equity amount (required).

Signatures block
Title Enter the title (optional).
Signature Enter the signature (optional).

3 Save your entry.
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Entering credit request details
Depending on the type of product you selected, one of three following lending tab will be 
available: Loan. Complete the available page. The Loan page all share the following sub 
pages: Itemization, Trade-In, Subvention (Loan only), and Comments. Complete these 
sub pages, if information exists.

To complete the Loan page

1 Choose the Loan tab.

2 Use the application to supply the following information on the Loan page:

In this field: Do this:

Requested Advance Enter the requested advance amount (required).
Pmt Enter the requested payment amount (required).
Term Enter the requested term (number of payments) 

(required).
Rate Enter the requested rate (required).
Down Enter the approximate down payment percentage 

(required).
Down Pmt Enter the approximate down payment amount (required).
Approx Price Enter the approximate cash price (required).
Promotion Select the requested promotion (required). Note: The 

only current predefined promotion types are NO PAY-
MENT or NO INTEREST FOR A NUMBER OF TERMS.

3 Save your entry.
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To complete the Itemization sub page
The Itemization sub page lists the particulars regarding the payment of the loan. This pre-
defined list is configured during setup and linked to the type of product you selected in this 
form’s master block.

1 If there are itemizations in the application, choose the Itemization sub tab.

2 Use the application to supply the following information on the Itemization sub page:

In this field: Do this:

Itemization Select the itemization code you want to use (display 
only).

+/- View the sign. Note: A positive itemization increases the 
amount of the loan, a negative itemization decreases the 
amount of the loan (display only).

Requested Amt Enter amount (required).
Comment Enter a comment relating to the itemization entry; for 

example, if a fee is abnormally high or low, this field 
might be used to record the reason (optional).

Total View the total (display only).

3 Save your entry.

4 If there is more than one itemization associated with the loan, repeat steps 2 and 3.
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To complete the Trade-In sub page
1 If there is a trade-in associated with the application, choose the Trade-In sub tab.

2 Use the application to supply the following information on the Trade-In sub page:

In this field: Do this:

Asset Type Select the asset class (required).
Sub Type Select the asset sub type (optional).
Year Enter the year of the asset (required).
Make Enter the make of the asset (required).
Model Enter the model of the asset (required).
Body Enter the body of the asset (optional).
Identification Number Enter the asset identification number (optional).
Wholesale Enter the wholesale value (required).
Desc View the asset description (display only).
Valuation Dt* Enter the valuation date for the asset (optional).
Source* Select the valuation source (optional).
Supplement* Enter the valuation supplement (optional).
Edition* Enter the valuation edition (optional). 

* These fields are related to the source of the valuation of 
the asset and are dependent on the type of asset; for 
example, an auto loan might use Kelly or NADA, while a 
home loan might use an appraisal or a tax assessment.

Retail Enter the retail value (required).
Addons + Enter the addons value (required).
Payoff Amt - Enter the payoff amount (required).
Total Value = View the total value (display only).

3 Save your entry.
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To complete the Subvention sub page

Note: The Subvention sub page is only available for loans.

1 If there is a subvention associated with the application, choose the Subvention sub tab.

2 Use the application to supply the following information on the Subvention sub page:

In this field: Do this:

Code Select the subvention plan (required).
Description View the subvention plan description (display only).
Include Select to include the subvention entry in the application.

3 Save your entry.

To complete the Comments sub page

1 If you want to add a comment to the application, choose the Comments sub tab.
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2 Use the application to supply the following information on the Comments sub page:

In this field: Do this:

Alert Select box if the comment is an alert (optional).
Type Select the comment type (required).
Sub Type Select the comment sub type (required).
Comment Enter a comment (required).
User (unlabeled) View the user who entered or created the comment (dis-

play only).
Date (unlabeled) View the comment date time (display only).

3 Save your entry.

4 If you want to add additional comments, repeat steps 2 and 3.
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Entering the collateral information
Depending on the type of product or producer you selected, one of the three following col-
lateral tabs will be available: Vehicle, Home, or Other. Complete the page that is available 
on your Application Entry form. After that, complete the Valuations sub page, which the 
Vehicle, Home, and Other pages all share.

(Note: If you are entering an unsecured loan, none of these three tabs is available; in 
which case, skip this step.)

To complete the Vehicle page

1 Choose the Vehicle tab.

2 Select Primary if this is the main asset on the application.

3 Use the application to supply the following information on the Vehicle page:

In this field: Do this:

Class Select the asset class (required).
Type Select the asset type (required).
Sub Type Select the asset sub type (required).
Status Select the asset status (required).
Year Enter the year of the vehicle (required).
Make Enter the make of the vehicle (optional).
Model Enter the model of the vehicle (optional).
Body Enter the body of the vehicle (optional).
Id # Enter the vehicle identification number (optional).
Registration # Enter the vehicle registration number (required).
Desc View the vehicle description (display only).
Address Enter the building number (optional).
Address 1 (unlabeled) Enter the address line 1 (optional).
Address 2 (unlabeled) Enter the address line 2 (optional).
Zip Select the zip code (optional).
City Enter the city (optional).
St Select the state (optional).
Zip Extension (unlabeled) Enter the zip extension (optional).
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Country Select the country (required).
County Select the county (optional).

4 Save your entry.

5 If there are additional vehicles associated with the application, press F6 to refresh the Vehi-
cle page and complete steps 3 and 4.

To complete the Home page

1 Choose the Home tab.

2 Select Primary if this is the main asset on the application.

3 Use the application to supply the following required information on the Home page:

In this field: Do this:

Class Select the asset class (required).
Type Select the asset type (required).
Sub Type Select the asset sub type (required).
Occupancy Select owner occupancy type (optional).
Year Enter the year when the property was built (required).
Make Enter the make of the home (optional).
Model Enter the model of the home (optional).
PO# Enter the asset purchase order number (optional).
W Enter the asset width (optional).
L Enter the asset length (optional).
Id # Enter the home identification number (optional).
Geo Enter the geographical code for the property (optional).
BNA Enter census tract/BNA (block numbering area) code 

(optional).
MSA Enter the metropolitan statistical area (MSA) code 

(optional).
Desc Enter a description of the home (optional).
Address Enter the building number (required).
Address 1 (unlabeled) Enter the address line 1 (required).
Address 2 (unlabeled) Enter the address line 2 (optional).
Zip Select the zip code (required).
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City Enter the city (required).
St Select the state (required).
Zip Extension (unlabeled) Enter the zip extension (optional).
Country Select the country (required).
County Select the county (optional).

4 Save your entry.

5 If there are additional homes associated with the application, press F6 to refresh the Home 
page and complete steps 3 and 4.

To complete the Other page

1 Choose the Other tab.

2 Select Primary if this is the main asset on the application.

3 Use the application to supply the following required information on the Other page:

In this field: Do this:

Class Select the asset class (required).
Type Select the asset type (required).
Sub Type Select the asset sub-type (required).
Status Select the asset status (required).
Year Enter the year of the asset (required).
Make Enter the make of the asset (optional).
Model Enter the model of the asset (optional).
Body Enter the body of the asset (optional).
Id # Enter the asset identification number (optional).
Registration # Enter the asset registration number (required).
Desc View the asset description (display only).
Address Enter the building number (optional).
Address 1 (unlabeled) Enter the address line 1 (optional).
Address 2 (unlabeled) Enter the address line 2 (optional).
Zip Select the zip code (optional).
City Enter the city (optional).
St Select the state (optional).
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Zip Extension (unlabeled) Enter the zip extension (optional).
Country Select the country (required).
County Select the county (optional).

4 Save your entry.

5 If there are additional other assets associated with the application, press F6 to refresh the 
Other page and complete steps 3 and 4.

To complete the Valuations sub page

1 Choose the Valuations sub tab.

2 Use the application to supply the following information on the Valuations sub page:

In this field: Do this:

Current Select if this is the current valuation (optional).
Valuation Dt Enter the valuation date (required).
Source Select the valuation source (required).
Supplement Enter the valuation supplement (optional).
Edition Enter the valuation edition (optional).
Wholesale Enter the wholesale value (required).
Usage Enter the usage. This pertains to loans and usually is 

entered as the current mileage on the vehicle (required).
Retail Enter the retail value (required).
Usage Value + Enter the usage value; that is, the monetary effect that the 

current mileage has on the value of the vehicle (required).
Addons + View the add-ons value (display only).
Total Value = View the total value (display only).
Addons/Attributes Select the add-on/attribute (required).
Value Enter the value of the attribute (optional).
Amt Enter the add-on amount (required).

Note: Complete the Addons/Attributes, Value, and Amt fields for each of the asset’s add-
ons and attributes on the application.

3 Save your entry.
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Validating a credit application
When you first save the information on the Application Entry form, Oracle Daybreak 
assigns the application an application number in the App # field. When you have finished 
entering data on the Application Entry form, choose Next Application in the master block. 
Oracle Daybreak then performs the Application Entry Edits check of the application, look-
ing for errors and warnings. 

If Oracle Daybreak finds an error, a dialog box appears instructing you to review the 
Edits page and Edit Details sub page. You must correct all the listed errors before Oracle 
Daybreak changes the status of the application. 

If Oracle Daybreak finds a warning, it should be addressed, but Oracle Daybreak allows 
you to complete the application and change its status without doing so.

IMPORTANT:
The Edit Details sub page’s errors and warnings are created during the setup process.

To validate a credit application

1 Enter all the information associated with the application on the Application Entry form 
(see the Entering Credit Applications section for more details.)

2 When you are finished entering data, choose Next Application.

Oracle Daybreak checks information on the form using guidelines (edits) established dur-
ing implementation.

3 On the Application Entry form, select the Edits tab.

4 On the Edits Detail sub page is a list of errors. Complete the tasks or missing information 
listed in the Edit Name column labeled ERROR in the Results column.

5 When you are finished correcting errors, use the master block, choose Next Application. 

6 On the Edits Detail sub tab is a list of warnings. Complete the tasks or missing informa-
tion listed in the Edit Name column labeled WARNING in the Results column.
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7 When you are finished correcting warnings, use the master block choose Next Applica-
tion.

Oracle Daybreak begins processing the credit application.

If there are other applications waiting to be entered, the next application in your queue 
appears on the Application Entry form. You can close the form without making or saving 
any entries.

Processing a credit application 
If Oracle Daybreak succeeds in validating the data on the Application Entry form, it 
begins the background processes of completing the Application Prescreening Edits check, 
sending a credit report request to the credit bureau, and auto decisioning the application 
with the Oracle Daybreak credit score.

Returning to an unfinished application
You can return to any unfinished application, both those that are entered with images and 
those without, provided the unfinished application has been saved and received an appli-
cation number.

An unfinished application - one that has been saved and has received an application num-
ber, yet has not completed the edits check - will appear on the Underwriting form with a 
status of NEW - BLANK.

Click on the application to load it and continue with application entry.
.
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CHAPTER 3 : SEARCHING FOR APPLICATIONS

This chapter explains how to use the Search page found on the Underwriting and Funding 
forms to search for and retrieve applications.

Loading applications using queues
Oracle Daybreak can be configured so that when you open the Underwriting or Funding 
form, the applications in your work queue automatically appear on the Results page. You 
can be assigned to work more than one queue. The queue to which each application is 
assigned appears in the Queue Name field. 

You can begin processing the applications in the order of which they are listed, double-
clicking on the application at the top of the list to load it. 
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Using the Search page
When using the Underwriting, Funding, or Customer Service forms, you may need to 
search for and retrieve a particular application. These three forms all contain the Search 
page that allows you to locate an application using a broad range of search criteria. 

To view the Search page on the Underwriting form

1 On the Lending menu, choose Underwriting.

The Underwriting form appears, opened at the Results page.

2 Choose the Search tab. 
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To view the Search page on the Funding form

1 On the Lending menu, choose Funding.

The Funding form appears, opened at the Results page.

2 Choose the Search tab. 
Chapter 3 :-3  User Guide - Consumer Loans Origination



Search criteria
In querying the Oracle Daybreak database, search criteria allows you to locate applica-
tions. Search criteria is a filter consisting of criteria (such as an account number, account 
status, customer social security number, and so on), comparison operators, or “codes” (see 
below), and values (the data to search for). Oracle Daybreak uses the following compari-
son operators in creating search criteria:

Code Description Example Expression

< less than APPLICATION DATE < 01/22/2002
Result: Oracle Daybreak searches for all applications 
created before Jan. 22, 2002.

< = less than or APPLICATION DATE <= 01/22/2002
equal to Result: Oracle Daybreak searches for all applications 

created on or before Jan. 22, 2002.

= equal APPLICANT SSN = 111-22-3333
Result: Oracle Daybreak searches for all applications 
with an applicant whose social security number is 
111-22-3333.

< > not equal APPLICANT SSN <> 111-22-3333
Result: Oracle Daybreak searches for all applications 
except those with an applicant whose social security 
number is 111-22-3333.

> greater than APPLICATION DATE > 01/22/2002
Result: Oracle Daybreak searches for all applications 
created after Jan. 22, 2002.

> = greater than APPLICATION DATE >= 01/22/2002
or equal to Result: Oracle Daybreak searches for all applications 

created on or after Jan. 22, 2002.

IN in ACCOUNT NUMBER IN (20001000012512, 
20010100012645, 20010300012817)
Note: IN is used with values that are within paren-
thesis. 
Result: Oracle Daybreak searches for the applica-
tions with the account numbers of 
20001000012512, 20010100012645, and 
20010300012817.)

NOT IN not in ACCOUNT NUMBER NOT IN 
(20001000012512, 20010100012645, 
20010300012817)
Note: NOT IN is used with values that are within 
parenthesis.
Result: Oracle Daybreak searches for all applications 
except those with the account numbers of 
20001000012512, 20010100012645, and 
20010300012817.)
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IS is VIN IS NULL
Note: IS is only used with a value of “NULL.” It 
allows you to search for criteria that has no value; 
that is, fields where no information is present.
Result: Oracle Daybreak searches for all applications 
without a vehicle identification number.

IS NOT is not VIN IS NOT NULL
Note: IS NOT is only used with a value of “NULL.” 
It allows you to search for criteria that has any value; 
that is, fields where information is present.
Result: Oracle Daybreak searches for all accounts 
with a VIN, vehicle identification number.

LIKE like ASSET TYPE LIKE VEH%
Note: LIKE allows you to search for close matches 
using wildcard characters.
Result: Oracle Daybreak searches for all applications 
with an asset type beginning with the characters 
“veh” such as “vehicle car” or “vehicle van.”

NOT LIKE not like ASSET TYPE NOT LIKE VEH% 
Note: NOT LIKE allows you to search for close 
matches using wildcard characters.
Result: Oracle Daybreak searches for all applications 
with an asset type other than those starting with the 
characters “veh.”

Note: Choose Reset Criteria at any time to clear the Comparison Operator and Values 
columns on the Search page.
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A note about wildcard characters
A note about wildcard characters
• Wildcard characters can only be used with the operator LIKE and NOT LIKE.
• % (percent) represents any number of characters, including no characters.
• _ (underline) represents any single character.

Criteria value examples
Search criteria values of 1234% will locate character strings of any length that begin with 
“1234”

• 1234ACB
• 12345678
• 1234
• 12348
• 12340980988234ABIL230498098

Search criteria values of 1234_ will locate character strings of five characters that begin 
with “1234” 

• 12345
• 1234A
• 12340

Search criteria values of %1234 will locate character strings of any length that end with 
“1234”

• 1234
• 01234
• 098908LKJKLJLKJ000988071234

Search criteria values of _1234 will locate five character strings that end in “1234” 

• A1234
• 11234

Search criteria values of %1234% will locate character strings of any length that contain 
“1234”

• 1234
• 01234
• 12340
• AKJLKJ1234128424

Search criteria values of _1234_ will locate character strings of 6 characters that contain 
“1234”

• A1234B
• 012341
• A12341
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Search criteria examples
Criteria Comparison Operator Value
APPLICATION DATE = 05/01/2001

Result: Oracle Daybreak searches for all applications with an application date of May 1, 
2001.

Criteria Comparison Operator Value
APPLICATION DATE = 05/01/2001
APPLICATION NUMBER >= 0000000278

Result: Oracle Daybreak searches for all applications with an application date of May 1, 
2001 and an application number greater than or equal to 0000000278.

Criteria Comparison Operator Value
FIRST NAME  = JAN

Result: Oracle Daybreak searches for all applications with an applicant with a first name 
of “JAN”

JAN ARBOR
JAN FISHER

Criteria Comparison Operator Value
FIRST NAME LIKE JAN%

Result: Oracle Daybreak searches for all applications with an applicant with a first name 
of starting with “JAN”

JAN ARBOR
JAN FISHER
JANE MEYERS
JANETTE NORDSTROM
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A note about wildcard characters
To use the Search page

1 In the Search Criteria block on the Search page, use the Comparison Operator and Val-
ues columns to create the search criteria you want to use to find an application.

2 Choose the Search button.

Oracle Daybreak locates and displays on the Results page all the applications that meet 
your search criteria in the Search Criteria block.

• On the Underwriting and Funding forms, the results are sorted according to 1) priority of 
application and 2) application identification number.

• On the Customer Service form, the results are sorted according to the account identifica-
tion number (which is the last few digits of the account number). Except for backdated 
funding, the account identification number and account number should reflect the same 
order. 

For example, if you do fund an account backdated today, the account number will have the 
YYYYMM part to the backdated date, but the account will appear last since the account 
identification is a serial number and will be the highest value today.

The Underwriting form’s Results page.
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The Funding form’s Results page.

The Customer Service form’s Results page.

3 Use the Sort block to further arrange your results, if you choose. For more information, 
see the Using the Sort block section in this chapter.
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A note about wildcard characters
4 On the Results page, double-click the application you want to retrieve.

• If you are using the Underwriting form, Oracle Daybreak loads the application on the 
Applicants (2) master tab’s Primary page.

• If you are using the Funding form, Oracle Daybreak loads the application on the Appli-
cants (2) master tab’s Primary page.

You are now ready to begin work on the application.
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Using the Sort block
The Sort block allows you to sort the search results using one or two different fields. The 
Primary Sort Order and Secondary Sort Order fields have the following sort order 
entries:

• COMPANY
• BRANCH
• PRIORITY
• APP #
• DATE
• TITLE
• PRODUCT
• STATUS
• PRODUCER
• NONE

This list can be viewed as a drop down list for each field.
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Using the Sort block
You can sort the search criteria using either the Primary Sort Order field or a combination 
of the Primary Sort Order field and the Secondary Sort Order field. You can also 
choose to view the results in an ascending or descending order by selecting the corre-
sponding option button (A for ascending, D for descending) next to either field.

The following screen shot displays the unsorted results of a “View All” search.

To use the Search block

1 Follow steps 1 and 2 in To use the Search page section above.

2 In the Sort block, use the Primary Sort Order field to choose how you want to sort the 
search results. (Press the arrow keys or click the down arrow to view the fields contents).

3 Choose A to sort the results in ascending order 
or
Choose D to sort the results in descending order.

4 To further sort your results, repeat steps 2 and 3 using the Secondary Sort Order field.

5 Choose Sort.

Oracle Daybreak sorts the results on display.
Chapter 3 :-12  User Guide - Consumer Loans Origination



Other features on the Results page (Underwriting and Funding forms)
The Results page on the Underwriting form and Funding form share these common fea-
tures (these features are not present on the Result page on the Customer Service form):

What is it? What does it do?

View All box If you choose View All, all applications in the Oracle 
Daybreak system accessible with your user id defined 
responsibility appear in the Results page list box.

Queue Name field This display only field indicates which queue the selected 
application is currently in. (This in normally related to 
one or more of the following, based on setup: producer, 
state, or status.)

 
Secured Application box Indicates that the selected application is secured (that is, 

that the applicant is an employee of the organization) and 
may only be loaded by authorized users.

Copy Application button Creates a copy of the selected application. This feature is 
usually used when an applicant has submitted a previous 
application or when an applicant submits a second appli-
cation and you don’t want to retype the information. 

Next Application button Loads the next available unlocked application from the 
search results currently displayed. (Note: An unlocked 
application is one that is not currently opened by another 
Oracle Daybreak LS user). 

If the Oracle Daybreak LS user that initially opened the Funding form and selected View 
All had attempted at that time to open either application 0000112227 and 0000120229, 
Oracle Daybreak LS would have identified the user who has opened (or “locked”) on the 
Underwriting and Funding forms. In such cases, Oracle Daybreak displays a dialog box 
with the name and phone number of the user who has opened the application and offers the 
option of sending an email to request that person closes the application. 
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Other features on the Results page (Underwriting and Funding forms)
The email is sent to the user’s email address recorded on the Administration form’s User 
page. 

Note: Valid email address should be set up for each user in order to use this and other 
email functions efficiently.

If there are no applications available, Oracle Daybreak LS displays a Forms dialog box 
with the message “No Unlocked Application Found.”
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Copying an application
Using the Results page on the Underwriting or Funding forms, you can copy the informa-
tion of an existing application into a new application. The new application will contain 
duplicated data of the application information, the requested loan information, credit 
bureau data, and collateral information. The new application will have a status/sub status 
of NEW - REVIEW REQUIRED.

To copy an application

1 Open the Underwriting or Funding form and use the Search page to locate the applica-
tion you want to copy.

2 Select the application you want to copy on the Results page. 

3 Choose Copy Application.

A  Forms dialog box appears with the message “Do you want to copy application (number 
of application you selected)?”

4 Choose Yes.

A Forms dialog box appears with the message: “Application copy successful. New appli-
cation # (new application number).”
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Other features on the Results page (Underwriting and Funding forms)
5 Choose Ok.

Oracle Daybreak creates a new application with the new application number and the infor-
mation from the duplicated application. The new application has a status of NEW - 
REVIEW REQUIRED and can be opened on the Underwriting form. Oracle Daybreak also 
notes that this is a copied application with a system generated comment.
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Archive / Purge feature
Oracle Daybreak includes a purge / archive feature that provides you with the capability to 
archive old data and store it in a different table. A Oracle Daybreak batch process runs the 
purge / archive feature based on the system parameter setup. Oracle Daybreak archives the 
following items:

• Applications and related data
• General ledger data
• Securitization related data
• Producers
• Producer transactions

Oracle Daybreak purges the following items:

• Job request data
• User logins
• Output data dump related data.

In Oracle Daybreak, archiving is a two-way process:

1 All the archived data is moved and stored in O tables.
2 The archived data in the O tables is then moved and stored into OO tables. 

You may set the “default days” for the archive feature by setting the following system 
parameters on the Administration form. The parameters marked with _O are the items 
moved from O to OO tables. The other parameters are the items moved to O tables.

Parameter Default Days Description
PAP_ARCHIVE_DAYS 999 PURGE DAYS FOR APPLICATIONS 

LEVEL 1: PUR_APP_STATUS_CD IS 
USED TO DECIDE APPLICATIONS 
WITH WHAT STATUS ARE PURGED 

PAP_OARCHIVE_DAYS 999 PURGE DAYS FOR APPLICATIONS 
LEVEL 2

PGL_ARCHIVE_DAYS 999 PURGE DAYS FOR GL LEVEL 1: NO 
OF DAYS AFTER THE GL TXN WAS 
CREATED 

PGL_OARCHIVE_DAYS 999 PURGE DAYS FOR GL LEVEL 2

PJR_PURGE_DAYS 999 PURGE DAYS FOR JOB REQUEST 
LEVEL 1: NO OF DAYS AFTER JOB 
REQUEST COMPLETION DATE

POD_PURGE_DAYS 999 PURGE DAYS FOR OUTPUT DATA 
DUMP LEVEL 1: NO OF DAYS AFTER 
PROCESS RUN DATE

PPR_ARCHIVE_DAYS 999 PURGE DAYS FOR PRODUCERS 
LEVEL 1: NO OF DAYS AFTER THE 
PRODUCER STATUS IS SET TO 
ACTIVE AND THERE EXISTS NO 
“NOT PURGED” ACCOUNT WITH 
THIS PRODUCER NAME.
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Other features on the Results page (Underwriting and Funding forms)
PPR_OARCHIVE_DAYS 999 PURGE DAYS FOR PRODUCERS 
LEVEL 2:

PPX_ARCHIVE_DAYS 999 PURGE DAYS FOR PRODUCER TXNS 
LEVEL 1: NO OF DAYS AFTER THE 
PRODUCER TXN WAS CREATED

PPX_OARCHIVE_DAYS 999 PURGE DAYS FOR PRODUCER TXNS 
LEVEL 2:

PST_ARCHIVE_DAYS 999 PURGE DAYS FOR STATEMENTS 
LEVEL 1: NO OF DAYS AFTER THE 
STATEMENT WAS GENERATED

PST_OARCHIVE_DAYS 999 PURGE DAYS FOR STATEMENTS 
LEVEL 2

PUL_PURGE_DAYS 999 PURGE DAYS FOR USER LOGINS 
LEVEL 1: NO OF DAYS AFTER THE 
LOGIN END DATE

You can retrieve archived applications with the Application Retrieve form (Lending menu 
> Application Retrieval command). As of this release, you can only retrieve archived 
applications. 

To retrieve an archived application

1 On the Lending menu, choose Application Retrieval.

The Application Retrieve form appears.

2 In the Archive Applications Search block on the Search page, use the Comparison 
Operator and Values columns to create the search criteria you want to use to find an 
application.

3 Choose the Search button.

Oracle Daybreak locates and displays on the Results page all the applications that meet 
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your search criteria in the Search Criteria block.
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Other features on the Results page (Underwriting and Funding forms)
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CHAPTER 4 : UNDERWRITING

Underwriting is the next step after application entry in the loan origination cycle. At the 
beginning of the underwriting process, the application has been entered into Oracle Day-
break, received an application number, and passed through the initial prescreening checks 
and received a credit bureau report. (Credit bureau pulls are based upon zip code setup.) 
Oracle Daybreak has assigned it a custom credit score and based on this, automatically 
updated its status, and sent the application to the appropriate queue. In doing so, one of 
three things has happened to the application:

1) The application passed all the prescreening requirements and was automatically 
approved based on the auto-decisioning process. Oracle Daybreak then automatically 
notifies the producer with a decision fax.

-or-

2) The application failed the prescreening requirements and was automatically rejected 
based on the auto-decisioning process. Again, Oracle Daybreak then automatically 
notifies the producer with a decision fax.

-or-

3) The application received a status requiring a manual review and was sent to the under-
writing queue. It’s now up to the underwriter to verify the data and manually change 
the status of the application.

The following flowchart depicts this process:
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This chapter explains how to use Oracle Daybreak’s Underwriting form to complete the 
following tasks:

• Load an application on the Underwriting form
• Verify the applicant information
• Verify the credit bureau data
• Calculate and validate the debt-to-income ratios
• Manually request a credit bureau report
• Add comments and tracking attributes
• Make a decision about an application
• Verify the edits
• Rehash an application
• Copy an application.

Underwriting with Oracle Daybreak (an overview)
In Oracle Daybreak, the underwriting process follows these basic steps:

1 Open the Underwriting form and load the application you want to work with.

2 View and verify information about the applicant (and business, if present) supplied 
from the Application Entry form.

3 View information from the credit bureau report. This is display only information and 
cannot be edited.

4 View and verify information regarding the collateral.

5 Calculate and validate the debt-to-income ratios.

6 On the Loan page of the Decision (3) master tab, select the pricing for the application.

7 Complete the Stipulations, Itemizations, Checklist, Trade-In, Subvention (loans only), 
and Rate Schedule (variable rate loans only) sub pages, if necessary. (The Checklist 
sub page can be configured to display a list of tasks to follow when using the Under-
writing form.)

8 If you are approving the loan, complete the Approved block on the Loan page of the 
Decision (3) master tab.

If you are rejecting the loan, complete the Stipulations sub page of the Decision (3) 
master tab with the Adverse Action Reasons.

9 Change the status of the application on the master block of the Underwriting form.

10 On the Verification (9) master tab, view any errors and warnings that prevent the sta-
tus change.

11 Make changes to the application data that correct the errors until you can change the 
status of the application.
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Loading an application on the Underwriting form 
The first step in the Underwriting process is to load the application you want to work with. 
This can be done either manually or automatically. You can manually select an application 
using the Search (1) master tab. If your system is configured to automatically load applica-
tions based on work queues, applications appear on the Results page when you open the 
Underwriting form. 

Note: Work queues can be set up to allocate applications to different underwriters or teams 
based on product type, funding type, underwriter, application status, application sub sta-
tus, state, channel, dealer type, and dealer.

To manually load an application

1 On the Lending menu, choose Underwriting.

The Underwriting form appears.

2 Use the Search and Results pages under the Search (1) tab to find and load the applica-
tion you want to work with. (See the Searching for Applications chapter for more infor-
mation on this process.)

Oracle Daybreak opens the Applicant (2) master tab, loaded with information about the 
application you selected.
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To automatically load an application

1 On the Lending menu, choose Underwriting.

The Underwriting form appears at the Results page. Applications automatically appear in 
the list box. 

2 Begin the underwriting process by selecting the first application on the list.

Oracle Daybreak opens the Applicant (2) master tab, loaded with information about the 
application you selected.
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Underwriting form’s master block
The Underwriting form’s master block displays information from the Application Entry 
form’s master block, such as the application number, product, and producer.

In this field: Do this:

App # View the application number (display only).
Dt View the application number (display only)
Joint Joint application indicator. If selected, indicates this is a 

joint application.
Cos Co-singed application indicator. If selected, indicates this 

is a co-signed application.
Purpose Select or view the purpose of the application (optional).
Priority Select or view the priority of the application (required).
Status Select or view the status of the application (required).
Sub Status (unlabeled) View the sub status of the application (display only).
Company Select or view the company of the application (required).
Branch (unlabeled) View the branch of the application (display only).
Product Select or view the product of the application (required).
Existing Customer Existing customer indicator. If selected, indicates this 

applicant has a previous account.
Dup Duplicate application indicator. If selected, indicates this 

is a duplicate application.
Contact Select or view the contact of the application (optional).
Channel Select or view how the application was received 

(optional).
Producer Select or view the producer type of the application 

(required).
Producer (unlabeled) Select or view the producer of the application (required).
Sales Agent Select or view the sales agent of the application 

(required).
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Verifying applicant information
Having selected and loaded an application, you can view the information about the appli-
cant (s). This is information that was recorded on the Application Entry form or gathered 
during the credit pull. You can edit the data from the Application Entry form at anytime in 
the following steps. Remember to save your work with each change. Information from the 
credit bureau pull is available to view only. 

(For more information about the individual fields on the pages and sub pages in this sec-
tion, see the Entering an Application chapter.)

Note: If the actual application was attached as an image, you can view it by choosing the 
Image (8) master tab. This can be used to double-check data.

To verify applicant information from the Applicants (2) master tab

1 Open the Underwriting form and load the application you want to verify.

2 Choose the Applicants (2) master tab, then choose the Primary tab.

3 Use the Primary page to verify personal information about the primary applicant, includ-
ing name, license, and e-mail address. Two check boxes indicate if this is an existing cus-
tomer or a prior applicant. The Existing Customer field allows you to select the existing 
customer.
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4 Open the Address sub page to verify data about the applicant’s place of residence. The 
Stated/Actual block allows you to record the actual monthly housing payment against the 
amount stated on the application. (This information will appear on the Summary sub 
page.)

5 Open the Employment Information sub page to verify data about the applicant’s place of 
employment. The Stated/Actual block allows you to record the actual monthly income 
against the amount stated on the application. (This information will appear on the Sum-
mary sub page.)
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6 Open the Telecoms sub page to verify all of the applicant’s phone numbers. You can add 
new numbers or edit existing numbers.

7 Open the Financials sub page to verify the types and sources of additional income. Oracle 
Daybreak uses this information when calculating an applicant’s net worth. 
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8 Open the Summary sub page and verify the information regarding income and liability. 
(Using the Summary sub page is discussed later in this chapter in the Validating Ratios 
section.)

9 Open the Credit Scores sub page and view the credit score based on Oracle Daybreak’s 
internal scoring models. (Using the Credit Scores sub page is discussed later in this chap-
ter in the Manually rescoring a credit bureau report section.) 
Chapter 4 :-9  User Guide - Consumer Loans Origination



10 Open the Existing Accounts sub page and view any other accounts that the applicant has 
in the Oracle Daybreak system.

In this field: View this:

Acc # The account number.
Title The account title.
Relation The customer relationship.
Status The account status.
Product The product.
Payoff Amt The payoff amount.
Amt Due The delinquent amount due.
Oldest Due Dt The due date.
Company The company.
Branch The branch.
Total The payoff amount.
Total (unlabeled) The total due amount.
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11 Choose the Applicants (2) master tab, then choose the Others tab.

12 Use the Others page to verify personal information about other applicants, including 
name, license, e-mail address, and the relationship (Type) to the primary applicant

Note: The Others page and sub pages only need to be verified if a secondary or joint 
applicant exists. 
The Others sub pages are the same as the Primary sub pages, but contain information 
regarding the other applicant(s).

You can also complete the Other page and sub pages if you are adding an additional appli-
cant to application before completing the Underwriting process.

13 Save any changes you made to the application.
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Verifying business information
If this application is an SME loan (defined in the Applicant (2) master tab Primary page’s 
Class field as SMALL BUSINESS), the Applicants (2) master tab’s Business tab is avail-
able. The Business pages displays the small business information recorded on the Applica-
tion Entry form. You can edit the data from the Application Entry form at anytime in the 
following steps. Remember to save your work with each change.

Note: If there is no business information associated with the application, the Business tab 
is unavailable.

(For more information about the individual fields on the pages and sub pages in this sec-
tion, see the Entering an Application chapter.)

To verify business information from the Applicants (2) master tab

1 Open the Underwriting form and load the application you want to verify.

2 Choose the Applicants (2) master tab, then choose the Business tab.

3 Use the Business page to verify information about the business applicant.
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4 Open the Address sub page to verify data about the business’s address.

5 Open the Telecoms sub page to verify all of the business’s phone numbers. You can add 
new numbers or edit existing numbers.
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6 Open the Financials sub page to verify the types and sources of additional income of the 
business.

7 Open the Liabilities sub page to verify any liability information for the business.
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8 Open the Partners sub page to verify partners linked to the business. 

9 Open the Affiliates sub page to verify the financial details, assets, and liabilities of the 
business. 
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10 Open the Other Details sub page to verify financial details as well as assets and liabilities 
linked to the business. 

In this field: Do this:

Other Details block 
Analysis Frequency Select the analysis frequency (required).
Gross Margin Enter the business’s gross margin (required).
Income Enter the business’s income amount (required).

Financial Details block
Collection Average Enter the collection average (required).
Annual Sales Enter the annual sales amount (required).
Proj. Coll.Avg.Annual Enter the annual projected collection average (required).
Projected Sales Enter the projected sales amount (required).
Ann Proj Sales Amt View the annual projected collection amount (display 

only).
Book List Enter the business booklist (required).
Equity Enter the equity amount (required).
Turnover Enter the turnover amount (required).
Open Delq Enter the open delinquency amount (required).
Capital Amt Enter the capital amount (required).
Business Expenses Enter the business expenses amount (required).
Earned Surplus Enter the earned surplus amount (required).
Personal Expenses Enter the personal expenses amount (required).
Gross Profit Enter the gross profit amount (required).
Total Expenses View the total expenses amount (display only).
Ann Proj Exp Amt View the annual projected expenses amount (display 

only).
Net Profit Enter the net profit amount (required).
Working Capital Enter the working capital amount (required).

Assets block
Current Assets View the current asset amount (display only).
Fixed Assets View the fixed assets amount (display only).
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Intangible Assets View the intangible asset amount (display only).
Total Assets View the total asset amount (display only).
Total Net/Worth View the total net worth amount (display only).
Liabilities block
Current Liabilities View the current liability amount (display only).
Long term liabilities View the long term liabilities amount (display only).
Total Liability View the total liability amount (display only).
Debt Net Worth Ratio View the debt to net worth ratio (display only).
Current Assets/Liability ratio View the current asset to liability ratio (display only).

Signatures block
Title Enter the Title
Signature Enter the Signature

• If you choose Update Financials, Oracle Daybreak updates:

In the Assets block
The Current Asset field with the sum of all current assets from the Financials sub page 
The Fixed Asset field with the sum of all fixed assets from the Financials sub page 
The Intangible Asset field with the sum of all intangible assets from the Financials sub 
page 

In the Liabilities block
The Current Liabilities field with the sum of all current liabilities from the Liabilities sub 
page 
The Long Term Liabilities field with the sum of all long term liabilities from the Liabili-
ties sub page 

The Total Assets field with the sum of all assets in the Assets block (Current Assets + 
Fixed Assets + Intangible Assets) 
The Total Liability field with the sum of all liabilities in the Liabilities block (Current Lia-
bilities + Long Term Liabilities) 
The Total Net Worth field with the difference in amount between the Total Assets field and 
the Total Liability field
The Debt NetWorth Ratio field with the amount of the (Total Net Worth field)/ (Total Lia-
bility field) * 100 
The Current Asset/ Liability Ratio field with the amount of the (Current Assets field/ Cur-
rent Liabilities field) * 100 

Financial Details block
The Total Expense field with the sum of the Personal Expenses field and the Business 
Expenses field
The Ann Proj Exp Amt field with the amount of the Total Expense field * the analysis fre-
quency (for example, 12 for monthly and 52 for weekly) 
The Ann Proj Sales Amt field with the amount of the Annual Sales field * the analysis fre-
quency (for example, 12 for monthly and 52 for weekly) 
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Verifying credit bureau data
The Bureau (4) page on the Underwriting form displays the complete details of the credit 
report (if pulled) for an applicant. The data can be viewed as a text report or parsed into 
categorized sub pages. If there is a need for another pull for any applicant, it can be done 
here manually using the New Request block.

To verify the credit bureau data using the Bureau (4) master tab sub pages

1 Open the Underwriting form and load the application with the credit bureau data you want 
to verify.

2 Choose the Bureau (4) master tab.

3 In the Bureau Details block, view the following information:

In this block: View:

Type The credit bureau request type (display only).
Bureau The credit bureau (display only).
# The credit bureau request number (display only).
Status The status of credit bureau request (display only).
Dt The credit bureau request date (display only).
Report The credit bureau report type (display only).
Credit Bureau Reorder# The credit bureau reorder number, if the credit bureau 

that was pulled was Credco (optional).
App Ind If selected, indicates that a bureau was pulled for an 

application (display only).
Chapter 4 :-18  User Guide - Consumer Loans Origination



4 In the Applicant/Customer Detail block, view the following information:

In this block: Do this:

Type View the relation type (display only).
First Name Enter the first name (required).
MI Enter the middle name (optional).
Last Name Enter the last name (required).
Suffix Select the generation (optional).
SSN Enter the social security number. Note: If the organiza-

tional parameter UIX_HIDE_RESTRICTED_DATA is set 
to Y, this appears as a masked number; for example, 
XXX-XX-1234 (required).

Birth Dt Enter the date of birth (required).
Phone Enter the phone number (required).
Status View the credit bureau request status (display only).
Include Debt Select to include credit bureau information in the Liabil-

ity block of the Summary sub page on the Applicants (2) 
master tab (optional).

Populate Debt Select to load debt information from the credit bureau in 
the Liability block of the Summary sub page on the 
Applicants (2) master tab (optional).

Address Type Select the address type (required).
# Enter the building number (required).
Pre Select the street pre type (optional).
Street Enter the street name (required).
St Type Select the street type (optional).
Post Select the street post type (optional).
Apt No Enter the apartment number (optional).
Address 2 (unlabeled) Enter the address line 2 (optional).
Zip Select the zip code (required).
City Enter the city (required).
St Select the state code (required).
Zip Extension Enter the zip extension (optional).
Country Select the country (required).

5 In the Report Header block, view the following information:

In this block: View:

Bureau The bureau (display only).
First Name The first name (display only).
MI The middle initial (display only).
Last Name The last name (display only).
SSN The social security number. Note: If the organizational 

parameter UIX_HIDE_RESTRICTED_DATA is set to Y, 
this appears as a masked number; for example, XXX-
XX-1234 (display only).

Birth Dt The birth date (display only).
Report Dt The report date (display only).
Onfile Dt The onfile date (display only).
Credit Report Id The credit report id (display only).
Best Match The best match (display only)
.
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6 Choose Details.

Oracle Daybreak parcels out the details from the credit bureau report in the Bureau pages 
sub pages (Summary 1, Summary 2, Tradelines, Public Records, Collections, Fraud 
Messages, Inquiries, AKA, Consumer Statements, and Scores).

7 Open the Summary 1 sub page to view the following information:

In this block: View:

Trades Records of extended installment payments, mortgage, 
and revolving credit, as detailed in the credit bureau 
report.

Statistical Trade Ages Ages of the oldest and newest trades, as well as the aver-
age age of the open and total trades.

Bankruptcy The total number of times the applicant has applied for 
Chapter 7, Chapter 11, and Chapter 13 bankruptcies, 
recently and throughout life.

Past Due The total number of times the applicant has been past due 
on payments by 30, 60, or 90 days in the last year, two 
years, and throughout life.

Derogatory Trades Tradelines that an action other than being late was 
reported; this includes collections, repossessions, charge 
offs, and bankruptcies.

Public Records Number of legal actions, including liens, public records, 
and judgments over the course of the applicant’s life, as 
well as any that are currently open.

Collection Trades referred to an outside vendor for collection.
Scores View the FICO and bankruptcy scores.

8 Open the Summary 2 sub page to view the following information:

In this block: View:

Trades Records of extended credit for auto, bank, credit card, 
retail, loan finance, and sales finance loans, as detailed in 
the credit bureau report.

Inquiries Requests for a credit report regarding loans in the trade 
block over the last six months, as well as total requests 
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over 6, 12, and 24-month periods, as well as the newest 
and oldest request.

Balances The total balance of retail and bank trades, as well as the 
high balance of each.

Open Derogatory The following information for all of the customer’s open 
tradelines: the shortest and longest period of time (in 
months) since the customer’s most recent minor deroga-
tory (30-60 days late), major derogatory (90-180 days 
late), and derogatory (bankruptcy, repossession, or 
charge off).

Derogatory The following information for all of the customer’s total 
tradelines (open and closed): the shortest and longest 
period of time (in months) since the customer’s most 
recent minor derogatory (30-60 days late), major deroga-
tory (90-180 days late), and derogatory (bankruptcy, 
repossession, or charge off).

9 Open the Tradelines sub page to view information about tradelines, such as the creditor’s 
name, trade’s status, type and code, and balance information.

In this field: View:

Creditors Name The creditors name.
Status The status of the tradeline.
Type The type of tradeline, such as bank, first mortgage, travel 

card, and so on.
Type Code The code for the type of tradeline.
Past Due Amt The past due amount
Balance The balance of the tradeline.
Balance Dt The balance date.
Open Dt The date the tradeline was opened.
History Dt The tradeline’s history date.
History Data The tradeline’s history data.
30 The number of times the tradeline was 30 days past due.
60 The number of times the tradeline was 60 days past due.
90 The number of times the tradeline was 90 days past due.
Creditors Subscriber # The creditor’s subscriber number.
Mop The method of payment.
Account # The account number.
Credit Limit The credit limit.
Term Pmt Amt The term payment amount.
High Balance The high balance of the tradeline.
Reported Dt The reported date.
Duplicate If selected, the tradeline is a duplicate.
Special Exclusion If selected, the tradeline is a special exclusion.
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10 Open the Public Records sub page to view information about public records, including 
each one’s type, status, and amount, as well as the date the record was filed and resolved.

In this field: View:

Record Type The record type.
Status The status.
Amount The amount.
Filed Dt The filed date.
Satisfied Dt The satisfied date.

11 Open the Collections sub page to view information about accounts the creditor has in col-
lection, including the creditor’s name, account number, account balances, and the history 
of the account.

In this field: View:

Creditors Name The creditor’s name.
Account # The account number. 
Acct Balance The account balance.
High Balance The high balance.
Term Type The term type.
Balance Dt The balance date.
Open Dt The open date.
Last Activity Dt The last activity date.
History Dt The history date.
ECOA The Equal Credit Opportunity Act label.
Special Exclusion If selected, the collection is a special exclusion.
Duplicate If selected, the collection is a duplicate.
Creditor Subscriber # The creditor subscriber number.
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12 Open the Fraud Messages sub page to view information about fraudulent attempts to use 
the applicant’s credit.

13 Open the Inquiries sub page to view all the credit reports for the applicant in reverse chro-
nological order.

In this field: View:

Inquirer Name The inquirer’s name.
Inquirer Subscriber # The inquirer’s subscriber number.
Inquirer Industry Code The inquirer’s industry code.
Inquiry Dt The inquiry date.
Rate Shopping If selected, the inquiry concerned rate shopping.
Duplicate If selected, if the inquiry was a duplicate.

14 Open the AKA (“Also Known As”) sub page to view other names used by the applicant.

15 Open the Consumer Statements sub page to view statements that the applicant has 
issued to the credit bureau.
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16 Open the Scores sub page to view the score model, the score factor, and the score 
returned from the credit bureau report.

To view the credit bureau data on the Bureau (4) master tab as a text report

1 Open the Underwriting form and load the application with the credit bureau data you want 
to view. 

2 Choose the Bureau (4) master tab.

3 Choose Text Report.

Oracle Daybreak displays an ASCII text file of the information regarding the applicant 
from the credit bureau pull.

4 Use the scroll bar to view more information.

To print the credit bureau data as a text report

1 Open the Underwriting form and load the application with the credit bureau data you want 
to print.

2 Choose the Bureau (4) master tab.

3 Choose Text Report.

Oracle Daybreak displays an ASCII text file of the information regarding the applicant 
from the credit bureau pull.

4 Choose Print Report to send the information to the default printer.
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Verifying collateral information
Having selected and loaded an application, you can view the information about the collat-
eral of the loan. The Collateral page is unavailable if this is an unsecured loan.

Note: For more information about fields in this section, see the Customer Service chap-
ter.

To verify information about the collateral 

1 Open the Underwriting form and load the application with the collateral you want to ver-
ify.

2 Choose the Collateral (6) master tab.

Depending on the type of collateral, the Vehicle, Home, or Other page appears. 

3 Verify the information on the collateral page and its sub pages. (This is information that 
was recorded on the Application Entry form or gathered during the credit pull.)

•  The Vehicle page and verify information about vehicles as collateral.

Oracle Daybreak validates the VIN if you add or modify the Identification Number field 
on the Customer Service form’s Vehicle page. 
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Interface with VINTEK (If interface is installed)
Using the Vintek interface, Oracle Daybreak retrieves the year, make, model, and body of 
the vehicle on the Vehicle page of the Underwriting, Funding, Customer Service, and Con-
version App/Acc forms’ Collateral master tab when you choose Vehicle Details. This time 
saving feature reduces data entry errors. Using the VIN entered in the Identification Num-
ber field, Oracle Daybreak populates the following fields in the Vehicle block:

• Year
• Make
• Model
• Body 

If the Vintek interface is unable to retrieve information based on the VIN entered in the 
Identification Number field, Oracle Daybreak displays an error message.

The Home page and verify information about homes as collateral.

If available, enter the following additional and optional information:

In this field: Do this:

Legal Description Enter the legal description (optional).
Lot Enter the asset lot (optional).
Sub Division Enter the asset sub division (optional).
Parcel ID Enter the parcel id of the home (optional).
Metes-Bounds Select to indicate the home is considered Metes-Bounds.
Flood Zone Select to indicate the home is in a flood zone.
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• The Other page contains information about any thing other than a vehicle or home used as 
collateral.

The Valuation sub page contains information about the value of the asset. The Values 
block allows you enter the value of the asset. The Addons block records information 
about any addons associated with the collateral

• The Tracking sub page allows you to record further information associated with the col-
lateral. What items you choose to track are setup during implementation.

To track attributes on the Collateral (6) master tab

1 Open the Underwriting form and load the account you want to work with.

2 Choose the Collateral (6) master tab.

Depending on the type of collateral for this application, the Vehicle, Home, or Other page 
appears.

3 Choose the Tracking sub tab.

4 On the Tracking sub page, choose Load Details.

5 In the Tracking Items block, select the item you want to track.
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6 In the Tracking Items block, view or edit the following information:

In this field: Do this:

Tracking Item View the tracking type (display only)
Disposition Select the disposition (required).
Start Dt Enter the tracking start date (required).
End Dt Enter the tracking end date (optional).
Follow Dt Enter the next follow-up date (required).
Enabled Select to track the information from the start date in the 

Start Dt field.

7 Complete the Tracking Item Details block by entering information about a parameter in 
the corresponding the Value field.

8 Save any changes you made to the account.
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Calculating debt ratios
Oracle Daybreak offers powerful tools to the underwriter for analyzing an applicant’s 
debt-to-income ratios (total of an applicant’s debt obligation divided by that person’s regu-
lar income). Oracle Daybreak calculates debt ratios in the Ratios block on the Summary 
sub page using the data in the Income and Liability blocks. Information in the Income 
block comes from the Application Entry form. The information in the Liability block 
comes from either the Application Entry form or the credit bureau pull. 

An underwriter may also add information to the Income and Liability blocks during the 
underwriting process.

The debt-to-income ratios in the Ratios block can be recalculated by including or exclud-
ing information from the of the Income block, Liability block, and Financials sub page.

The Dedup Liabilities button removes duplicate (“de-dupes”) liabilities that may be 
present from subsequent (manual) credit bureau pulls for nonspousal joint applications

To calculate debt ratios 

1 Open the Underwriting form and load the application with the ratios you want to validate.

2 Choose the Applicants (2) master tab.

3 Choose the Primary or Others tab, then choose the Summary sub tab.

4 On the Summary sub page, view the display only data in the Totals block.

In this field: View this:

Monthly Income (Stated) The stated monthly income.
Monthly Income (Actual) The actual monthly income.
Monthly Debt (Stated) The stated monthly liability.
Monthly Debt (Actual) The actual monthly liability.
Assets The assets.
Chapter 4 :-29  User Guide - Consumer Loans Origination



Liabilities The liabilities.
Net-Worth The net-worth.

5 In the What if Pmt Amt field, enter the payment amount you want to use in the ratios.

6 In the Income block on the Summary sub page, use the Include check box to select or 
clear the entries that you want to use in the calculation of ratios. You can also enter new 
income information at this time:

In this field: Do this:

Type Select the income type (required).
Amt Enter the income amount (required).
Freq Select the frequency (required).
Comment Enter a comment (optional).

7 In the Liability block in the Summary sub page, use the Include check box to select or 
clear the records that you want to use in the ratios. You can also enter new liability infor-
mation at this time:

In this field: Do this:

Type Select the liability type (required).
Amt Enter the liability amount (required).
Freq Select the frequency (required).
Status View the account status (display only).
Account Type Enter the account type (required).
Open Dt View the date when the account was opened (display 

only).
Past Due Amt View the past due amount (display only).
30 View the number of payments 30 days past due (display 

only).
60 View the number of payments 60 days past due (display 

only).
90 View the number of payments 90 days past due (display 

only).
Balance View or enter the account balance (required).
High Balance View the high balance for the account (display only).
Credit Limit View the credit limit for the account (display only).
Bureau View the credit bureau that reported this liability (display 

only).
Comment Enter a comment (optional).
Term View the term for the account (display only).
Creditor’s Name View the creditor’s name (display only).
Account # View the account number (display only).
Pmt Manner View the manner of payment for the account (display 

only).
Subscriber # View the creditor’s subscription number (display only).
ECOA View the ECOA code for the account (display only).

8 Choose Dedup Liabilities in the Liability block if:

a) If this is a joint application.

b) The contents of the Type field on the Applicants (2) master tab’s Others page is 
SPOUSE or SECONDARY. (Co-signers are not included in the removal of duplicate lia-
bilities.)
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9 Choose Update Ratios.

Oracle Daybreak updates the Ratios block using the new information. 

10 In the Ratios block, view the following information:

In this field: View this:

Debt (Stated Before) The debt ratio based on stated income and liability (with-
out what if payment).

Debt (Stated After) The debt ratio based on stated income and liability (with 
what if payment).

Debt (Actual Before) The debt ratio based on actual income and liability (with-
out what if payment).

Debt (Actual After) The debt ratio based on actual income and liability (with 
what if payment).

Disposable Inc (Stated Before) The disposable income ratio based on stated income and 
liability (without what if payment).

Disposable Inc (Stated After) The disposable income ratio based on stated income and 
liability (with what if payment).

Disposable Inc (Actual Before) The disposable income ratio based on actual income and 
liability (without what if payment).

Disposable Inc (Actual After) The disposable income ratio based on stated income and 
liability (with what if payment).

Revolving Debt (Stated Before) The revolving debt ratio based on actual income and lia-
bility.

Revolving Debt (Stated After) The revolving debt ratio to income ratio based on actual 
income and liability.

Pmt to Income (Stated Before) The payment to income ratio based on stated income and 
liability.

Pmt to Income (Stated After) The payment to income ratio based on actual income and 
liability.

Manually requesting a credit bureau report
The Bureau (4) page allows you to manually request a credit pull. Information from a 
manual credit pull can be used to validate an application.

To manually request a credit bureau report

1 Open the Underwriting form and load the application for which you want to request a 
credit bureau report.

2 Choose the Bureau (4) master tab.
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3 In the New Request block, use the LOV to complete the following fields:

In this field: Do this:

Applicant Select the applicant (optional).
Spouse Select the applicant’s spouse (if applicable) (optional).
Bureau Select the credit bureau (optional).
Report Select the credit bureau report type (optional).

 4 Choose Create Request. 

Oracle Daybreak displays this information in the Bureau Details block to the right of the 
New Request block.

5 On the Bureau (4) page, select Include Debt and Populate Debt in the Applicant/Cus-
tomer Detail block to populate the Liability block on the Applicants (2) page’s Summary 
sub page with data from the credit bureau pull.

6 If you want to receive a copy of a previously pulled credit bureau report, enter the credit 
bureau reorder number in the Credit Bureau Reorder # field on the Bureau Details 
block. This allows you to receive a previously pulled credit report from Credco (currently 
other bureaus do no provide a copy) (optional).

7 Choose Submit Request. 

8 Press F8 to refresh the status of the credit request until the credit pull is completed.

Oracle Daybreak displays the latest status of the currently requested bureau report in the 
Bureau Details block. When the report pull process is complete, the Status field in the 
Applicant/Customer Detail block changes from PENDING to COMPLETED.
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Manually rescoring a credit bureau report
The Credit Score sub page on the Applicant (2) master tab displays the credit scores as 
configured within the Oracle Daybreak system. It also allows you to manually rescore a 
credit report. 

To manually rescore a credit bureau report

1 Open the Underwriting form and load the application for which you want to view Oracle 
Daybreak’s credit scores.

2 Choose the Applicant (2) master tab, then choose the Primary tab.

3 Choose the Credit Scores sub tab.

4 In the Rescore Applicant block, select in the Credit Report Id field the bureau report you 
want to use to rescore the applicant.

5 Choose Rescore.

Oracle Daybreak displays the new information in the Credit Scores and Parameters 
blocks. This new score automatically appears in the System Recommendation block on 
the Decision (3) master tab.
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Entering comments 
When using the Underwriting form, you can add comments to an application at any time 
in the underwriting process by using the Comments page.

To add comments to an application

1 Open the Underwriting form and load the application to which you want to add com-
ments.

2 Choose the Comments (7) master tab, then choose the Comments tab.

3 In the Comments page, enter the comments you want to attach to the application in the 
next available empty Command field. If the Comments page is filled, press F6 to insert a 
new record.

4 Save the comments you added to the application.
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Entering tracking attributes
When using the Underwriting form, you can add tracking attribute information to an appli-
cation at any time in the underwriting process by using the Tracking Attributes page.

To add tracking attributes to an application

1 Open the Underwriting form and load the application to which you want to add tracking 
attributes.

2 Choose the Comments (7) master tab, then choose the Tracking Attributes page.

3 Choose Create Tracking.

Oracle Daybreak loads the tracking parameters.

4 If you want to reduce the list of parameters, select a sub-attribute in the Sub Attribute 
box.

If your system has been configured to use the Sub Attribute field, only attributes in a par-
ticular group appear in the Parameter display.

5 Complete the Tracking block by entering the requested parameter in the Value field.

6 Save any changes you made to the account.
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Viewing an image 
When using the Underwriting form, you can view any images attached to the application 
at any time by using the Image (8) master page.

To view an image associated with an application

1 Open the Underwriting form and load the application with the image you want to view.

2 Choose the Image (8) master tab.

The Fax Image block contains the following display only fields:

In this field: View:

Fax Header The fax header.
Image Id The image id.
Image Status The image status.
Page # The page number.
Of The total number of pages.

The Fax Image block contains the following command buttons:

If you choose: Oracle Daybreak will:

Flip Image Rotate the selected image.
Print Image Send the selected image to a predefined printer.
Pr Display the previous page of the image (if one exists).
Nx Display the next page of the image (if one exists).
Up Scroll up through the selected image.
Dn Scroll down through the selected image.

Depending on the position of the application when it was faxed to Oracle Daybreak, the 
image may be inverted on the Underwriting form.
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3 To rotate an upside-down image, choose Flip Image on the Underwriting form master 
block.

4 To navigate through the application:

• Use the scroll bar 
-or- 

• Choose Dn and Up on the Underwriting form.

The Page # and Of fields display what page is currently displayed in the Underwriting 
form and the total page length of the image.

5 To view other pages of the application, if they exist, choose Nx and Pr on the Underwrit-
ing form master block.
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Making a decision about an application
If the application was initially automatically approved, Oracle Daybreak displays its 
recommendations on the Decision (3) master tab.

If the application was initially automatically rejected, Oracle Daybreak displays its rea-
sons on the Stipulation sub page. 

If you choose to approve or reject the loan manually, you must manually select the 
pricing (rule) set by the portfolio company for a specific product. Oracle Daybreak vali-
dates this pricing against the information in the Requested and System Recommendation 
blocks. The information in the Requested block comes from the Application Entry form 
and can be edited.

• If the data meets your approval, change the status of the application to either 
APPROVED or REJECTED and enter any stipulations. 

• If you choose to reject the application, change the status to REJECTED and enter the 
reasons for the adverse action on the Stipulations sub page.

Note: The Tools (10) master tab can be helpful when completing this section. For more 
information on its use, see the Oracle Daybreak Tools chapter.

To verify the application decision data

1 Open the Underwriting form and load the application you want to verify.

2 Choose the Decision (3) master tab.

• If you are underwriting a loan, use the Loan page to complete the following information: 

In this field: Do this:

Requested block
(Note: The Requested block displays information from the Application Entry form, 
though you may change these entries.)
Advance Enter the requested advance amount (required).
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Down % Enter the approximate down payment percentage 
(required).

Pmt Enter the requested payment amount (required).
Down Pmt Enter the approximate down payment amount (required).
Rate Enter the requested interest rate (required).
Approx Prc Enter the approximate cash price (required).
Term Enter the requested term (required).
Promotion Select the requested promotion (required).
Subvention Plan View the requested subvention plan (display only).

System Recommendation block
(Note: This information is based on Oracle Daybreak’s scoring model.)
Decision View the system recommended decision (display only).
Grade View the system recommended grade (display only).
Score View the system recommended score (display only).

3 On the Underwriting form’s Loan page, choose Select Pricing.

Oracle Daybreak determines the best pricing match of all enabled loan pricing strings in 
the Setup menu and displays the results in the Pricing and Approved blocks. 

• If you are underwriting a fixed rate loan, record the following information on the Loan 
page:

In this field: Do this:

Pricing block
Current If selected, indicates that this is the current decision (dis-

play only).
Pricing View the pricing (display only).
Decision Dt View the decision date (display only).
Status View the application status (display only).
Sub Status View the application sub-status (display only).
Underwriter View the underwriter id (display only).

Approved block
(Approved) Term Enter the approved term (required).
(Approved) Rate Enter the approved rate (required).
(Approved) Pmt Enter the approved payment amount (required).
Promotion View the approved pricing promotion (display only).
(Maturity) Maturity Rate Enter the maturity rate (required).
Grade Select the credit grade (required).
Score Enter the credit score (required).
Buy Rate View the buy rate (display only).
Down Pmt (%) Enter the approved down payment percentage (required).
(Down Pmt) Amt Enter the approved down payment amount (required).
Max Advance (%) Enter the approved advance percentage (required).
(Max Advance Or) Amt Enter the approved advance amount (required).
Max Financed (%) Enter the maximum amount financed percentage 

(required).
(Max Financed Or) Amt Enter the maximum amount financed (required).
Collateral Value View the collateral value (display only).
LTV1 View the loan to value ratio (display only).
LTV2 View the loan to value ratio (display only).
Bureau 1 Select the bureau 1 (optional).
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Bureau 2 Select the bureau 2 (optional).
Bureau 3 Select the bureau 3 (optional).

• If you are underwriting a variable rate loan, record the following information on the 
Loan page:

In this field: Do this:

Pricing block
Current If selected, indicates that this is the current decision (dis-

play only).
Pricing View the pricing (display only).
Decision Dt View the decision date (display only).
Status View the application status (display only).
Sub Status View the application sub-status (display only).
Underwriter View the underwriter id (display only).

Approved block
(Approved) Term Enter the approved term (required).
(Approved) Rate View the approved rate (display only).
(Approved) Pmt Enter the approved payment amount (required).
(Approved) Index Select the approved index (required).
(Approved) Index Rate Select the approved index rate (display only).
(Approved) Margin Enter the approved margin rate (required).
Promotion View the approved pricing promotion (display only).
(Maturity) Index Select the approved post maturity index (required).
(Maturity) Margin Enter the maturity rate (required).
Grade Select the credit grade (required).
Score Enter the credit score (required).
Buy Rate View the buy rate (display only).
Down Pmt (%) Enter the approved down payment percentage (required).
(Down Pmt) Amt Enter the approved down payment amount (required).
Max Advance (%) Enter the approved advance percentage (required).
(Max Advance Or) Amt Enter the approved advance amount (required).
Max Financed (%) Enter the maximum amount financed percentage 

(required).
(Max Financed Or) Amt Enter the maximum amount financed (required).
Collateral Value View the collateral value (display only).
LTV1 View the loan to value ratio (display only).
LTV2 View the loan to value ratio (display only).
Bureau 1 Select the bureau 1 (optional).
Bureau 2 Select the bureau 2 (optional).
Bureau 3 Select the bureau 3 (optional).

4 If you are approving the application, complete the Approved block with the values you 
want to approve as an underwriter. You can update the default values that appeared when 
you selected the pricing string in step 3. (The Oracle Daybreak calculator may be of use 
when completing this block. For more information, see the Oracle Daybreak Tools chap-
ter.)

The Underwriting form’s Loan pages all share the Stipulations, Itemizations, Checklist, 
Trade-In, Rate Schedule (variable rate loans only), Subvention (loans only), and Multi-
ple Offers sub pages.
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Completing the Stipulations sub page
The Stipulations sub page allows to add any stipulations or reasons for adverse action you 
want to attach to the application. Stipulations are items that need to be addressed before 
the loan can be funded. If the application was automatically rejected during the application 
entry edits, Oracle Daybreak displays the automatically generated adverse action codes in 
this sub page.

To add or view stipulations or reasons for adverse action

1 Open the Underwriting form and load the application you want to verify.

2 Choose the Decision (3) master tab, then choose the Stipulations sub tab.

3 Complete the Stipulations block with information about the stipulations you want to add 
to the application or reasons for adverse action.

In this field: Do this:

Type Select the reason type (required).
Code Select the reason (required).
Comment Enter the comment (required).

• If your Oracle Daybreak system is set up to manually load predefined stipulations, choose 
the Load Stipulations button (For more information, see the following section, Loading 
Stipulations.)

4 Use the Yes/No/NA buttons in the Stips Satisfied column to indicate if you verified the 
stipulation(s) in the Type field.

5 Save the record.

After you save your entry, Oracle Daybreak updates the Verified By field with the user id 
of the person who selected Yes or No in the Stips Satisfied column and enters the date the 
change was made in the Verify Dt field.
Chapter 4 :-41  User Guide - Consumer Loans Origination



Copying stipulations
Oracle Daybreak allows you to automatically transfer stipulations from previous decisions 
on the Stipulations sub page with the Copy Stipulations button. This is particularly useful 
when you are rehashing an application and want to use the same stipulations as those in 
place for the previous decision.

Loading stipulations
Oracle Daybreak supports the automatic generation of default stipulations on the Under-
writing form’s Stipulations sub page. The default stipulations can be maintained by com-
pany, branch, product, state, application status and application sub-status. When the 
application status changes (either manually and automatically), Oracle Daybreak popu-
lates the maintained stipulations with a Stips Satisfied indicator of “No.” You can review 
and update the stipulations accordingly.

You have the option to manually load predefined stipulations by choosing the Load Stipu-
lations button on the Stipulation page.

To load predefined stipulations

1 Open the Underwriting form and load the application you want to verify.

2 Choose the Decision (3) master tab, then choose the Stipulations sub tab.

3 Choose Load Stipulations.

Oracle Daybreak loads the default stipulations in the Stipulations block.

4 Use the Yes/No/NA buttons in the Stips Satisfied column to indicate if you verified the 
stipulation(s) in the Type field.

5 Save the record.
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Completing the Itemization sub page
The Itemizations sub page allows you to add or verify any itemized amounts associated 
with the application. The list of itemizations is determined by the product you selected in 
the master block on the Application Entry form. The Itemizations sub page displays an 
itemization record of the amount financed, such as the cash price, cash down payment, 
trade-in, unpaid cash price balance and so on. Information that was entered on the Itemiza-
tion sub page on the Application Entry form will appear in the Requested Amt column. 
Information that you enter as an underwriter in the Approved Amt column will appear in 
the Itemizations sub page on the Funding form.

To add or view itemizations

1 Open the Underwriting form and load the application you want to verify.

2 Choose the Decision (3) master tab, then choose the Itemizations sub tab.

3 Complete the Itemizations block with information about how the loan is to be allocated in 
the 

In this field: Do this:

Itemization View the itemization (display only).
+/- View whether the itemized amount is added or subtracted 

from the loan amount (display only).
Requested Amt Enter the requested amount (required).
Approved Amt Enter the approved amount (required).
Discount Rate Enter the discount rate (optional).
Comment Enter a comment (optional).

4 Save your entry.
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Completing the Checklist sub page
Use the Checklist sub page to complete any remaining tasks in the decisioning process. 
The Checklist helps ensure the proper procedures are followed when approving the appli-
cation by providing a list of required steps.

To complete the Underwriting checklist

1 Open the Underwriting form and load the application you want to verify.

2 Choose the Decision (3) master tab, then choose the Checklist sub tab.

3 If the Checklist sub page is empty, choose Decision Checklist.

4 Complete the tasks listed in the Action column of the Checklist Actions block. 

5 Use the Yes/No/NA buttons to indicate whether or not you completed the task. You can 
use the Comment field to add remarks regarding any of the tasks.

6 When you are finished completing the tasks, choose Complete in the Checklist box.

7 Save the record.

Completing the Trade-In sub page
The Trade-In sub page allows you to add or verify any trade-ins associated with the appli-
cation. If there is any information regarding an itemized trade-in, use the Trade-In sub 
page to enter the details in Oracle Daybreak. (This sub page might already contain infor-
mation supplied during the application entry process.)

To complete the Trade-In sub page

1 Open the Underwriting form and load the application you want to work with.

2 Choose the Decision (3) master tab, then choose the Trade-In sub tab.
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3 On the Trade-In sub page, view or complete the following fields:

In this field: Do this:

Asset block
Asset Type Select the asset type (required).
Asset Sub Type Select the asset sub-type (optional).
Year Enter the year of the asset (required).
Make Enter the make of the asset (required).
Model Enter the model of the asset (required).
Body Enter the body of the asset (optional).
Identification Number Enter the identification number (optional).
Desc View the asset description (display only).
Value block
Wholesale Enter the wholesale value (required).
Retail Enter the retail value (required).
Addons (+) Enter the addons value (required).
Payoff Amt (-) Enter the payoff amount (required).
Total Value = View the total value (display only).
Valuation Dt Enter the valuation date (optional).
Source Select the valuation source (optional).
Supplement Enter the valuation supplement (optional).
Edition Enter the valuation edition (optional).

4 Save any changes you made on the application.
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Viewing the Rate Schedule sub page
The Rate Schedule sub page is only available for variable rate loans and displays the rate 
adjustment frequency information based on product setup.

To view the Rate Schedule sub page

1 Open the Underwriting form and load the variable rare loan application you want to work 
with.

2 Choose the Decision (3) master tab, then choose the Rate Schedule sub tab.

3 On the Rate Schedule sub page, view the following display only information:

In this field: View this:

Rate Schedule block
Seq The rate adjustment sequence number.
Adjustment Frequency Type The rate adjustment frequency type.
Period The rate adjustment period for the frequency.
# of Adjustments The number of rate adjustments for the frequency.
Chapter 4 :-46  User Guide - Consumer Loans Origination



Completing the Subvention sub page
With the Subvention sub page, available only for loans, you can review the subvention 
information from the Application Entry form and calculate the subvention amount, as well 
as override the calculated subvention amount. The participant’s information is automati-
cally populated based on the selected subvention plan.

To complete the Subvention sub page

1 Open the Underwriting form and load the application you want to work with.

2 Choose the Decision (3) master tab, then choose the Subvention sub tab.

3 On the Subvention sub page, view or complete the following fields:

In this field: Do this:

Subvention block:
Plan Select the subvention plan (required).
Description View the subvention plan description (display only).
Sub Plan Description Select the subvention sub plan. (required).
Subvention Type View the subvention type (display only).
Subvention Amount              View the subvention amount for the plan (required).
Include Select to indicate as an active record.

Participants block:
Participant View the participant (display only).
Participant Type                  View the participant type (display only).
Collection Method                View the collection method (display only).
Rate                               View the subvention rate (display only).
Calculation Method View the subvention calculation method (display only).
Factor View the factor (display only).
Calculated Amount View the calculated subvention amount (display only).
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Subvention Amount              Enter the subvention amount (required).
Total Subvention Rate          View the total subvention rate (display only).
Total Subvention Amount    View the total subvention amount (display only).

4 Select the Initialize button to reset the subvention amount to zero.

5 Select the Calculate button to calculate the subvention amount.

6 Save your entry.

Completing the Multiple Offers sub page
When you choose Select Pricing on the Underwriting form’s Decision (3) master tab 
pages, multiple offers appear on the new Multiple Offers sub page. Use the Multiple Offer 
sub page to select the offer you want to use. 

To view multiple pricing offers

1 Open the Underwriting form and load the application you want to verify.

2 Choose the Decision (3) master tab, then choose the Multiple Offers sub tab.

3 On the Multiple Offers sub page, view the following fields:

In this field: Do this:

Seq View the sequence number (display only).
Pricing View the pricing (display only).
Rate Enter the approved rate (required).
Term Enter the approved term (required).
Pmt Enter the approved payment amount (required).
Index Rate View the approved index rate (display only).
Maturity Rate Enter the approved maturity rate (required).
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Rent Factor View the approved rent factor (display only).
Residual % View the approved residual percentage (display only).
Current If selected, indicates that the pricing is current. 

Note: All the available pricings are selected as current.
Accepted If selected, indicates that the pricing is accepted. Only 

one of the current pricings can be accepted.

Completing the Contract (5) (truth-in-lending details) pages
The Contract (5) master tab on the Underwriting form allows you to record and print con-
tract details immediately after the credit decision for direct loans. The availability of the 
Contract (5) master tab on the Underwriting form is very useful for organizations process-
ing direct applications, as the decision and contract information can be recorded with one 
form (Underwriting), not two (Underwriting and Funding), thus streamlining loan origina-
tion. 

In completing the truth-in-lending details on the Contract (5) master tab, you will com-
plete either the Loan page. The truth-in-lending details must be completed before a loan 
can be funded.

Note: The availability of the Contract (5) master tab on the Underwriting form is con-
trolled by the following system parameter:

Parameter Description
UIX_DIRECT_LOAN_COMBO_ULN_UFN SET YES TO COMBINE UNDERWRIT-

ING AND FUNDING FOR DIRECT 
LOANS(YES/NO)

To complete the contract truth-in-lending details

1 Open the Underwriting form and load the application with the contract truth-in-lending 
details you must complete.

2 Choose the Contract (5) master tab.
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Note: For details about completing the Contract (5) master tab on the Underwriting form, 
please refer to the Completing the Contract (5) (truth-in-lending details) pages and 
Completing the Contract (5) (truth-in-lending details) sub pages sections in Chapter 
5: Funding of this document.
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Changing the status of the application
1 On the Underwriting form’s Application block, change the status of the application to 

either APPROVED, CONDITIONED, or REJECTED in the Status box.

Oracle Daybreak checks the information on the Underwriting form using guidelines estab-
lished during implementation.

If Oracle Daybreak finds an error based on these guidelines, the following dialog box 
appears.

2 Choose OK to close the dialog box and begin verifying edits. (For more information, see 
the Verifying edits section in this chapter.)

Verifying edits
Oracle Daybreak can be configured to automatically validate portions of an application 
when you attempt to change its status. The results of this data check appear on the Verifi-
cation (9) tab’s Edit page as an Error, a Warning, or an Override. 

If it is an Error, Oracle Daybreak will not allow you change the application’s status and 
approve the loan until you fix all the errors. 

If it is a Warning, Oracle Daybreak allows you to change an application’s status without 
correcting the matter. While you should still investigate the problem, Warning messages 
are of a lesser importance than Error messages. 

If it is an Override, Oracle Daybreak displays a dialog box informing you that an override 
is needed; your responsibility level does not have the authority required to process this 
step. (Choose Yes on the dialog box to move the application to the queue of the user with 
the required authority.) 

Oracle Daybreak can be configured to verify different sets of information; for example, 
Oracle Daybreak could check one set of data when checking application entries for com-
pleteness and another when approving auto loans. Each one of these “edit types” has its 
own set of “edit details.”
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To verify the data required for decisioning the application

1 Open the Underwriting form and load the application you want to validate.

2 Choose the Verification (9) master tab, then choose the Edits tab.

3 In the Edit Type block, select the type of edit you want to verify.

Note: If the verification process you want to perform doesn’t appear in the Edit Type 
block, use the Edit Type field’s LOV to select it 

4 Choose Check Edits.

Oracle Daybreak checks the data for the verification process selected in the Edit Type 
block and displays the results in the Edit Details block.

The Edit Details block contains the following display only information:

In this field:  View this:

Edit Name The edit.
Result The result.
Expected Value The expected value.
Actual Value The actual value.
Override Responsibility The override responsibility, if an override is 

required.

5 In the Edit Details block, view the verification results and begin making corrections on 
the Underwriting form.

6 When you are finished correcting errors, change the status of the application in the Under-
writing form’s master block Status field.

After making a decision and successfully changing the status of the application, the 
Underwriting process is over. 
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Viewing audits
The Audits page is a display only page that allows you track changes to the contents of 
predetermined fields (which fields are determined during set up). For example, the Audits 
page can be configured to monitor when the contents of the Status and Sub Status is 
changed. The Audits page lists the field that was changed, who made the change, when the 
change was made, and the old and new values in the field.

To view the Audits page

1 Open the Underwriting form and load the application you want to validate.

2 Choose the Verification (9) master tab, then choose the Audits tab.

3 In the Audit Details block, view the following display only information:

In this field: View:

Record Id The record identifier for the record changed.
Field The field which was changed.
Old Value The old value of the column which was changed.
New Value The new value of the column which was changed.
Changed By The user code who made the change.
Changed Date The date and time when the change was made.
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Viewing Status History
You can track the time it took a user to complete each stage of the application process with 
the History page. It displays:

• The date and time when an application changed status / sub status
• The user who changed the status / sub status 
• The elapsed time of how long an application was in a particular status / sub status.

 To view the History page

1 Open the Underwriting form and load the application you want to validate.

2 Choose the Verification (9) master tab, then choose the History tab.

3 In the Application Status History block, view the following display only information:

In this field: View this:

Status The application status.
Sub Status The application sub status.
User Code The user code of the person who changed the status / sub 

status of the application.
User Name The user name of the person who changed the status / sub 

status of the application.
Start Date The date and time when the application moved to that 

status.
End Date The date and time when the application moved from that 

status.
Elapsed The elapsed time between the status change.
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Rehashing an application
Once the application receives a status of APPROVED, REJECTED, or CONDITIONED you 
cannot change the information on the Underwriting form’s Decision (3) pages. If you need 
to update or change the information, you must change the sub status of the application to 
REHASHING. This allows you to edit the Decision (3) pages and rework the application 
when new information is available. 

To rehash the application

1 Open the Underwriting form and load the application with the status of APPROVED, 
REJECTED, or CONDITIONED you want to change.

2 In the Application master block, select REHASHING in the Sub Status field.

3 Save the application.

4 After you enter the information required to decision the application, you can change the 
status to APPROVED, REJECTED, CONDITIONED, or WITHDRAWN. (For more informa-
tion, see the section Making a decision about an application in this chapter.)

Note: Once the status is changed to APPROVED, REJECTED, CONDITIONED, or WITH-
DRAWN no further changes to the information on the Decision (3) page are possible.
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Aging an application
The Underwriting form can be configured so that applications will be moved to a separate 
queue after a certain amount of time. (This time frame is determined in setup). This appli-
cations receive a sub status of AGED APPLICATION. This housekeeping function allows 
you to keep your Oracle Daybreak system free of stagnant application by moving them 
into an archive.
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CHAPTER 5 : ORACLE DAYBREAK TOOLS

The Underwriting and the Funding forms both contain a Tools (10) master tab with a Loan 
calculator tab and the Vehicle Evaluator tab. When processing a loan, you can calculate 
either a payment or an interest rate. You can also view the amortization schedule. This 
information can then be used to complete blocks on the Decision (3) and Contract (5) mas-
ter tabs.

On the Lending menu, the Tools command leads to the Loan Calculator sub command. 
Both open the Calculator Tools form. This is similar to the calculator on the Underwriting 
and Funding form. However, the Calculator Tools form is a stand-alone page; it does not 
link calculations or loan information to any specific application at this time.

If you are processing a vehicle loan, the Vehicle Evaluator tab is available. This allows 
you to calculate the value of a vehicle with the NADA interface. 
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Using the Loan Calculator page (Tools master tab)
The Loan Calculator page is available on the Tools (10) master tab when you load an 
application for a loan. The loan calculator works in one of two modes: Calculate Payment 
or Calculate Interest Rate. 

Calculating loan payments
The Calculate Payment mode calculates the standard payment based on the information 
you provide, such as the amount financed, terms, and interest rate. 

Note: If you want to clear (or “refresh”) the Loan Calculator page at any time, choose Ini-
tialize in the Action block.

To calculate a loan payment (Tools master tab)

1 Using either the Funding or Underwriting form, load the loan application you want to 
work with. (See the Searching for Applications chapter for more information.)

• If you are working with the Underwriting form, the calculator is useful after you 
choose Select Pricing on the Decision (3) master tab.

• If you are working with the Funding form, the calculator is useful after you choose 
Select Instrument on the Contract (5) master tab.

2 Choose the Tools (10) master tab, then choose the Loan Calculator tab.

3 In the Action block, choose Calculate Payment.

Oracle Daybreak completes the fields in the Calculator Options block with default val-
ues.

4 In the Action block, choose Import Values.

• If you are using the Underwriting form, Oracle Daybreak copies values from the 
Decision (3) master tab in the Requested block, as well as values entered in the 
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Requested Amt column on the Itemization sub page. (Note: This information transfers 
only if the information currently appears on the Decision (3) master tab.)

• If you are using the Funding form, Oracle Daybreak copies values currently entered 
on Contract (5) master tab, such as Term and Rate, as well as information from the 
Contract (2) sub page regarding repayment options and values from the Itemization 
sub page regarding loan amounts, pre paid fees, and financed fees.

-OR-

In the Action block, choose Initialize and complete the following fields:

In this field: Do this:

Loan Details block
Contract Dt Enter the contract date. Oracle Daybreak uses today’s 

date as the default value (required).
First Pmt Dt Enter the first payment date. Oracle Daybreak use’s the 

date one month from today as the default value 
(required).

Amt Financed Enter the amount financed (required).
Pre-Paid Fees Enter the prepaid fees, if any exist (required).
Loan Amt View the estimated loan amount: the amount financed 

plus the prepaid fees (display only).
Financed Fees Enter the financed fees, if any exist (required).
Balloon Pmt Amt Enter the balloon payment amount, if any exist 

(required).
Term Enter the number of payments (required).
Maturity Dt View the maturity date (display only).
Rate block
Rate Enter the interest rate (required).

5 In the Calculator Options block, complete the following fields (Oracle Daybreak com-
pletes these fields with default values after you choose Initialize. You can change these 
values if you choose):

In this field: Do this:

Billing Cycle Select the payment frequency (required).
Accrual Base Select the accrual base (required).
Balloon Method Select the balloon method (required).
Time Counting Method Select the time counting method (required).
Installment Method Select the installment method: EQUAL PAYMENTS or 

FINAL PAYMENT DIFFERS. Note: For more informa-
tion, see the Final Payment Amount Amortization 
Options (Last Payment Differs) section in this chapter 
(required).

Bill Method Select the billing method as either LEVEL, PERCENT-
AGE OF PRINCIPAL PLUS INTEREST, INTEREST ONLY, 
FIXED PRINCIPAL PLUS INTEREST, PERCENTAGE OF 
OUTSTANDING BALANCE (required).

6 Funding form only: If the calculation includes a promotion, complete the Rate Schedule 
block.
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In this field: Do this:

Seq   Enter the sequence number of the rate schedule 
(required).

Rate Enter the repayment amount borrower agreed to pay dur-
ing the schedule (required).

Start Date Enter the repayment amount borrower agreed to pay dur-
ing the schedule (required).

(After you enter other required information and select the Calculate button, Oracle Day-
break computes the repayment schedule while considering promotional rate schedule and 
populates the Repayment Schedule block.)

7 Funding form only: If this calculation involves a flexible repayment schedule, complete 
the Repayment Options block.

In this field: Do this:

Type   Select the flexible repayment schedule you want to use 
from the following: SKIP PERIOD, USER DEFINED, 
UNDEFINED, GRADUATED PAYMENT and EXTEND-
ABLE BALLOON.
The Payment Change Schedule block is available when 
you select GRADUATED PAYMENT.
The Extendable Balloon block’s Max Term field is avail-
able when you select EXTENDABLE BALLOON.

Note: If you selected Import Values in the Action block and have completed the Contract 
(5) master tab’s Contract (2) sub page, Oracle Daybreak imports its Repayment block val-
ues.

• If you selected GRADUATED PAYMENT in the Repayment Options block’s Type field, 
complete the Payment Change Schedule block.

In this field: Do this:

Seq Enter the sequence number in which the repayment is 
calculated (required). 
Note: This prioritizes the calculation.

Option Type Select the repayment option type: STEP UP, STEP DOWN, 
and BULLET (required).

Frequency Select the frequency of payment. The default value is 
TERM (required).

Period Enter the period of each adjustment (required).
# of Adj. Enter the number of times the STEP UP, STEP DOWN, or 

BULLET needs to happen (required).
Value Enter the value. For STEP DOWN, value ranges from 1 to 

99. For STEP UP, value ranges from 1 to 990. For BUL-
LET, value ranges from 1 to 99999999.

(After you enter other required information and select the Calculate button, Oracle Day-
break computes the repayment schedule while considering the payment change schedule 
and populates the Repayment Schedule block.)

• If you selected EXTENDABLE BALLOON in the Repayment Options block’s Type field, 
complete the Extendable Balloon block. 
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In this field: Do this:

Max Term Enter the maximum number of terms for the extendable 
balloon payment (optional).

(After you enter other required information and select the Calculate button, Oracle Day-
break computes the repayment schedule while considering extendable balloon and popu-
lates the Repayment Schedule block.)

• Funding form only: If you manually selected SKIP PERIOD in the Repayment Options 
block’s Type field, select the months where repayment needs to be skipped in the Skip 
Months block. 

(After you enter other required information and select the Calculate button, Oracle Day-
break computes the repayment schedule while considering skip period and populates the 
Repayment Schedule block.)

• Funding form only: If you selected USER DEFINED in the Repayment Options block’s 
Type field, complete the Repayment Schedule block. 

In this field: Do this:

Seq   Enter the sequence number of the repayment schedule 
(required).

Pmt Amt   Enter the repayment amount borrower agreed to pay dur-
ing the schedule (required).

# of Pmts   Enter the number of payments borrower agreed to pay for 
stated repayment amount during this schedule (required).

(After you enter other required information and select the Calculate button, Oracle Day-
break computes the repayment schedule while considering the user defined entries and 
completes the Repayment Schedule block.)

When you fund the loan application, Oracle Daybreak copies the repayment schedule 
information to the loan account on the Customer Service form where it appears on the 
Repayment Schedule sub page.

8 In the Action block, choose Calculate.

Oracle Daybreak calculates the following information:

In this field: View this:

Rate block
APR Annual percentage rate (display only).

Payment/Finance Charge block
Pmt Amt Payment amount (display only).
Interest Amt Total estimated interest amount (display only).
Finance Charge Total estimated finance charge (display only).
Total of Pmts Estimated total of payments (display only).
Final Pmt Amount Final payment amount (display only).

First Period block
Calendar Days Number of days in the first payment cycle (display only).
Interest Interest accruing during the first period (display only).
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To create an amortized schedule of loan payments (Tools master tab)

1 Complete steps 1 - 8 in the previous section To calculate a loan payment (Tools master 
tab).

2 In the Action block, choose Amortize.

Oracle Daybreak uses the calculated payment data to complete the Amortization Schedule 
block and displays the following information:

In this field: View this:

Seq Payment number (display only).
Pmt Dt Payment date (display only).
Pmt Amt Payment amount (display only).
Interest Amt Component of the payment amount allocated towards 

reduction of the interest balance (display only).
Principal Amt Component of the payment amount allocated towards 

reduction of the principal balance (display only).
Balance Amt Remaining principal balance (display only).

To copy the payment calculations to the Decision (3) master tab 
(underwriting)

1 Complete steps 1 - 8 in the previous section To calculate a loan payment (Tools master 
tab).

2 In the Action block, choose Copy to Decision.

Oracle Daybreak uses these calculations to complete the Approved block on the Loan 
page of the Decision (5) master tab. Oracle Daybreak will use this information during the 
funding process when you select a pricing.

To copy the payment calculations to the Contract (5) master tab (funding)

1 Complete steps 1 - 8 in the previous section To calculate a loan payment (Tools master 
tab).

2 In the Action block, choose Copy to Contract.

Oracle Daybreak uses these calculations to complete the Contract block on the Loan page 
of the Contract (5) master tab. Oracle Daybreak will use this information during the fund-
ing process when you select an instrument.

To print a report of the loan payment calculations (Tools master tab)

1 Complete steps 1 - 8 in the previous section To calculate a loan payment (Tools master 
tab).

2 In the Action block, choose Print Report.

Oracle Daybreak uses the information on the Loan Calculator page to print a report using 
the default printer. 
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To print a report of the amortized schedule of loan payments (Tools master 
tab)

1 Complete the two steps in the section To create an amortized schedule of loan pay-
ments (Tools master tab).

2 In the Action block, choose Print Report.

Oracle Daybreak uses the information on the Loan Calculator page to print a report using 
the default printer.

Calculating interest rates
The Calculate Interest Rate mode back-calculates the interest rate and the APR using the 
amount financed, standard payment, and terms. It also provides the amortization schedule 
of the loan.

Note: If you want to clear (or “refresh”) the Loan Calculator page at any time, choose Ini-
tialize in the Action block.

To calculate an interest rate (Tools master tab)

1 Using either the Funding or Underwriting form, load the loan application you want to 
work with (See the Searching for Applications chapter for more information.)

2 Choose the Tools (10) master tab, then choose the Loan Calculator tab.

3 In the Action block of the Loan page, choose Calculate Interest Rate, then choose Initial-
ize.

Oracle Daybreak completes the fields in the Calculator Options block with default val-
ues.

4 In the Action block, choose Import Values.

• If you are using the Underwriting form, Oracle Daybreak copies values from the 
Decision (3) master tab in the Requested block, as well as values entered in the 
Requested Amt column on the Itemization sub page. (Note: This information transfers 
only if the information currently appears on the Decision (3) master tab.)

• If you are using the Funding form, Oracle Daybreak copies values currently entered 
on Contract (5) master tab, such as Term and Rate, as well as information from the 
Contract (2) sub page regarding repayment options and values from the Itemization 
sub page regarding loan amounts, pre paid fees, and financed fees.

-OR-

Complete the following fields:

In this field: Do this:

Loan Details block
Contract Dt Enter the contract date. Oracle Daybreak uses today’s 

date as the default value (required).
First Pmt Dt Enter the first payment date. Oracle Daybreak use’s the 

date one month from today as the default value 
(required).

Amt Financed Enter the amount financed (required).
Pre-Paid Fees Enter the prepaid fees, if any exist (required).
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Loan Amt View the estimated loan amount: the amount financed 
plus the prepaid fees (display only).

Financed Fees Enter the financed fees, if any exist (required).
Balloon Pmt Amt Enter the balloon payment amount, if any exist 

(required).
Term Enter the number of payments (required).
Maturity Dt View the maturity date (display only).

Payment/Finance Charge block
Pmt Amt Enter the payment amount (required).

5 In the Calculator Options block, complete the following fields (Oracle Daybreak com-
pletes these fields with default values after you choose Initialize. You can change these 
values if you choose):

In this field: Do this:

Billing Cycle Select the payment frequency (required).
Accrual Base Select the accrual base (required).
Balloon Method Select the balloon method (required).
Time Counting Method Select the time counting method (required).
Installment Method Select the installment method: EQUAL PAYMENTS or 

FINAL PAYMENT DIFFERS. Note: For more informa-
tion, see the Final Payment Amount Amortization 
Options (Last Payment Differs) section in this chapter 
(required).

Bill Method Select the billing method as either LEVEL, PERCENT-
AGE OF PRINCIPAL PLUS INTEREST, INTEREST ONLY, 
FIXED PRINCIPAL PLUS INTEREST, PERCENTAGE OF 
OUTSTANDING BALANCE (required).

6 Funding form only: If the calculation includes a promotion, complete the Rate Schedule 
block. 

In this field: Do this:

Seq   Enter the sequence number of the rate schedule 
(required).

Rate Enter the repayment amount borrower agreed to pay dur-
ing the schedule (required).

Start Date Enter the repayment amount borrower agreed to pay dur-
ing the schedule (required).

(After you enter other required information and select the Calculate button, Oracle Day-
break computes the repayment schedule while considering promotional rate schedule and 
populates the Repayment Schedule block.)
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7 Funding form only: If this calculation involves a flexible repayment schedule, complete 
the Repayment Options block.

In this field: Do this:

Type   Select the flexible repayment schedule you want to use 
from the following: SKIP PERIOD, USER DEFINED, 
UNDEFINED, GRADUATED PAYMENT and EXTEND-
ABLE BALLOON.
The Payment Change Schedule block is available when 
you select GRADUATED PAYMENT.
The Extendable Balloon block’s Max Term field is avail-
able when you select EXTENDABLE BALLOON.

Note: If you selected Import Values in the Action block and have completed the Contract 
(5) master tab’s Contract (2) sub page, Oracle Daybreak imports its Repayment block val-
ues.

• If you selected GRADUATED PAYMENT in the Repayment Options block’s Type field, 
complete the Payment Change Schedule block.

In this field: Do this:

Seq Enter the sequence number in which the repayment is 
calculated (required). 
Note: This prioritizes the calculation.

Option Type Select the repayment option type: STEP UP, STEP DOWN, 
and BULLET (required).

Frequency Select the frequency of payment. The default value is 
TERM (required).

Period Enter the period of each adjustment (required).
# of Adj. Enter the number of times the STEP UP, STEP DOWN, or 

BULLET needs to happen (required).
Value Enter the value. For STEP DOWN, value ranges from 1 to 

99. For STEP UP, value ranges from 1 to 990. For BUL-
LET, value ranges from 1 to 99999999.

• If you selected EXTENDABLE BALLOON in the Repayment Options block’s Type field, 
complete the Extendable Balloon block.

In this field: Do this:

Max Term Enter the maximum number of terms for the extendable 
balloon payment (optional).Funding form only: If you 
manually selected SKIP PERIOD in the Repayment 
Options block’s Type field, select the months where 
repayment needs to be skipped in the Skip Months 
block. 

(After you enter other required information and select the Calculate button, Oracle Day-
break computes the repayment schedule while considering skip period and populates the 
Repayment Schedule block.)
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• Funding form only: If you selected USER DEFINED in the Repayment Options block’s 
Type field, complete the Repayment Schedule block. 

In this field: Do this:

Seq   Enter the sequence number of the repayment schedule 
(required).

Pmt Amt   Enter the repayment amount borrower agreed to pay dur-
ing the schedule (required).

# of Pmts   Enter the number of payments borrower agreed to pay for 
stated repayment amount during this schedule (required).

When you fund the loan application, Oracle Daybreak copies the repayment schedule 
information to the loan account on the Customer Service form where it appears on the 
Repayment Schedule sub page.

8 In the Action block, choose Calculate.

Oracle Daybreak calculates the following information:

In this field: View this:

Rate block
Rate Interest rate (display only).
APR Annual percentage rate (display only).

Payment/Finance Charge block
Interest Amt Total estimated interest amount (display only).
Finance Charge Total estimated finance charge (display only).
Total of Pmts Estimated total of payments (display only).
Final Pmt Amount Final payment amount (display only).

First Period block
Calendar Days Number of days in the first payment cycle (display only).
Interest Interest accruing during the first period (display only).

To create an amortized schedule of payments (Tools master tab)

1 Complete steps 1 - 8 in the section To calculate an interest rate (Tools master tab).

2 In the Action block, choose Amortize.

Oracle Daybreak uses the calculated interest rate data to complete the Amortization 
Schedule block and displays the following information:

In this field: View this:

Seq Payment number (display only).
Pmt Dt Payment date (display only).
Pmt Amt Payment amount (display only).
Interest Amt Component of the payment amount allocated towards 

reduction of the interest balance (display only).
Principal Amt Component of the payment amount allocated towards 

reduction of the principal balance (display only).
Balance Amt Remaining principal balance (display only).
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To copy the interest rate calculations to the Decision (3) master tab 
(underwriting)

1 Complete steps 1 - 8 in the section To calculate an interest rate (Tools master tab).

2 In the Action block, choose Copy to Decision.

Oracle Daybreak uses these calculations to complete the Approved block on the Loan 
page of the Decision (5) master tab. Oracle Daybreak will use this information during the 
underwriting process after you select a pricing.

To copy the interest calculations to the Contract (5) master tab (funding)

1 Complete steps 1 - 8 in the section To calculate an interest rate (Tools master tab).

2 In the Action block, choose Copy to Contract.

Oracle Daybreak uses these calculations to complete the Contract block on the Loan page 
of the Contract (5) master tab. Oracle Daybreak will use this information during the fund-
ing process when you select an instrument.

To print a report of the interest calculations (Tools master tab)

1 Complete steps 1 - 8 in the previous section To calculate an interest rate (Tools master 
tab).

2 In the Action block, choose Print Report.

Oracle Daybreak uses the information on the Loan Calculator page to print a report using 
the default printer. 

To print a report of the amortized schedule of payments (Tools master tab)

1 Complete the two steps in the section To create an amortized schedule of payments 
(Tools master tab).

2 In the Action block, choose Print Report.

Oracle Daybreak uses the information on the Loan Calculator page to print a report using 
the default printer.
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Final Payment Amount Amortization Options (Last Payment Differs)
Oracle Daybreak LS supports an amortized repayment schedule with the final payment 
potentially differing from the regular payment amount in the other billing cycles. In previ-
ous releases, Oracle Daybreak LS amortized loan repayments equally for each billing 
cycle, including the last payment. It then added any excess amount (usually resulting from 
the rounding of payment amount calculations) received during the last cycle, to the 
finance charge. 

With Oracle Daybreak, you may choose:

• Whether the equal installments for each billing cycle includes any minute final pay-
ment differences (EQUAL PAYMENTS)
-or-

• If the final payment amount may be slightly different (LAST PAYMENT DIFFERS).

Equal Payments
On the Loan Calculator page, when you choose EQUAL PAYMENTS in the Calculator 
Options block’s Installment Method field, the repayment amount will be equal for all 
installments (including the final installment). Therefore, in some cases, the final repay-
ment amount may be slightly more or less than the outstanding loan amount due to precise 
rounding calculations. Oracle Daybreak includes this amount as a finance charge as per-
mitted under Regulation Z (Truth-in-Lending) and is commonly utilized within the lend-
ing industry. This amount is included in the finance charge amount as part of the Truth-in-
Lending calculation information.

Oracle Daybreak displays the excess (or shortage) amount with a negative sign (if applica-
ble) on the Loan Calculator’s page Amortization Schedule block. This excess or shortage 
amount is added to or subtracted from the finance charge and appears in the Payment/
Finance Charge block’s Finance Charge field.

Final Payment Differs
With the FINAL PAYMENT DIFFERS installment method, the final payment amount will 
be equal to the outstanding loan amount. 

On the Loan Calculator page, when you select FINAL PAYMENT DIFFERS in the Calcula-
tor Options block’s Installment Method field and choose Amortize in the Action block, 
Oracle Daybreak displays an amortization schedule with the final payment amount differ-
ent from the earlier installments and zeroes the balance amount. 

Notes:

a) For the installment method EQUAL PAYMENTS, the billing will be of equal install-
ments.

For the installment method FINAL PAYMENTS DIFFER, the billing for last payment 
will differ very slightly.

b) When you choose Initialize in the Action block of the Loan Calculator, the default 
value in the Calculator Options block’s Installment Method field is EQUAL PAY-
MENTS.
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Using the Vehicle Evaluator page (Tools master tab)
The Vehicle Evaluator page allows you to calculate the value of a vehicle using the NADA 
interface. The NADA (North American Dealer Association) guide contains 12 months 
(most recent month and the 11 prior) of valuation data This page is only available if you 
are processing a vehicle loan.

You can use the Vehicle Evaluator page to calculate the value of either a vehicle you are 
entering as the new collateral or the vehicle currently listed as the application’s collateral

Note: If you want to clear (or “refresh”) the Vehicle Evaluator page at any time, choose 
Clear in the Action block.

To calculate a vehicle value for the new collateral

1 On the Lending menu, choose Underwriting or Funding and load the vehicle loan appli-
cation you want to work with. (See the chapter Searching for Applications for more 
information.)

2 Choose the Tools (10) master tab, then choose the Vehicle Evaluator tab.

3 In the Action block, use the Asset field’s LOV to choose the vehicle you want to appraise. 
This can be either NEW COLLATERAL or a vehicle entered on the Collateral (6) master 
tab. 

4 The Action block, choose Initialize.

In the Action block, Oracle Daybreak completes the Valuation Source, Period, and 
Region fields.

5 If necessary, change the default contents of the fields in the Action block to the values you 
want to use.

6 If you selected a vehicle from the Collateral (6) master tab in step 3, information from 
the Vehicle page appears in the VIN and Vehicle blocks on the Vehicle Evaluator page. 
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7 If you selected NEW COLLATERAL in step 3, complete the Identification # in the VIN 
block
-or-
Complete the fields in the Vehicle block.

8 In the Action block, choose Evaluate.

• If you completed the VIN block, Oracle Daybreak searches for the value of that vehicle 
with that identification number, then completes the Vehicle Evaluator page with informa-
tion about that exact match. 

• If you completed the Vehicle block, Oracle Daybreak searches for the value of a vehicle 
matching that description. 
 
In either case, Oracle Daybreak displays the following information about the vehicle:

• In the Vehicle block, view the returned information:

In this field: View this:

Year The asset year.
Make The asset make.
Model The asset model.
Body The asset body style.
Usage The asset usage or current mileage.
Weight The asset weight.

• In the Valuation (Total Value) block, view the returned information:

In this field: View this:

MSRP Manufacturer’s suggested retail price value of the 
asset (display only).

Usage Adjusted usage value of the asset (display only).
Total Total value of the asset (display only).

• In the Valuation (Base and Attribute Value) block, view the returned information:

In this field: View this:

Base (Retail) Total retail value of the asset (display only).
Base (Loan) Base loan value of the asset (display only).
Base (Trade) Base trade value of the asset (display only).
Attributes (Retail) Retail value of the asset attributes (display only).
Attributes (Loan) Loan value of the asset attributes (display only).
Attributes (Trade) Base trade value of the asset attributes (display only).

• In the Attributes block, view the following information:

In this field: View this:

Attribute Asset attribute (display only).
Retail Attribute retail value (display only).
Loan Attribute loan value (display only).
Trade Attribute trade value (display only).
Standard Standard indicator. If selected, indicates that the attribute 

is a standard feature.
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9 Note: If you want to re-calculate the values in the Total Value and Base and Attribute 
Value blocks using other data, make changes to the desired fields in the Valuation 
Source, VIN, and Vehicle blocks, then in the Action block, choose Re-calculate field in 
the Vehicle block.

Oracle Daybreak updates the information on the Vehicle Evaluator page without recon-
tacting NADA. 

Oracle Daybreak updates the values in the Total Value and Base and Attribute Value 
blocks.

10 If you choose, use the Attributes block to select or clear the Selected box for attributes of 
the vehicle. This automatically updates the values in the Total Value and Base and 
Attribute Value blocks. (Note: Attribute amounts within brackets reduce the amount in the 
Total field in the Total Value block.)

To copy the calculated value to the Collateral (6) master tab

1 Complete steps 1 - 10 in the section To calculate a vehicle value.

2 In the Action block on the Vehicle Evaluator page, choose Copy to Asset.

Oracle Daybreak uses the calculations on the Vehicle Evaluator page to complete the Val-
uation sub page on the Collateral (6) master tab. Any pre-existing collateral is no longer 
the primary collateral.
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Using the Calculator Tools form’s Loan Calculator page
The Loan Calculator page calculates the payment amount, interest rate, amortization 
schedule and allows for the printing of a report. The functionality is the same as the Loan 
Calculator previously available as opened from the Tools (10) master tab on the Under-
writing and Funding forms. 

However, please note that the Calculator Tools form’s Loan Calculator page does not have 
the Copy to Decision or Copy to Contract buttons in the Action block. 

Calculating loan payments
The Calculate Payment mode on the Calculator Tools form’s Loan Calculator calculates 
the standard payment based on the information you provide, such as the amount financed, 
terms, and interest rate. 

Note: If you want to clear (or “refresh”) the Loan Calculator page at any time, choose Ini-
tialize in the Action block.

To calculate a loan payment (Calculator Tools form)

1 On the Lending menu, choose Tools, then choose Loan Calculator.

2 In the Action block, choose Calculate Payment, then choose Initialize.

3 In the Loan Details block, complete the following fields:

In this field: Do this:

Contract Dt Enter the contract date. Oracle Daybreak uses today’s 
date as the default value (required).

First Pmt Dt Enter the first payment date. Oracle Daybreak use’s the 
date one month from today as the default value 
(required).
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Amt Financed Enter the amount financed (required).
Pre-Paid Fees Enter the prepaid fees, if any exist (required).
Loan Amt View the estimated loan amount: the amount financed 

plus the prepaid fees (display only).
Financed Fees Enter the financed fees, if any exist (required).
Balloon Pmt Amt Enter the balloon payment amount, if any exist 

(required).
Term Enter the number of payments (required).
Maturity Dt View the maturity date (display only).

4 In the Rate block, complete the following fields:

In this field: Do this:

Rate Enter the interest rate (required).

5 In the Calculator Options block, complete the following fields (Oracle Daybreak com-
pletes these fields with default values after you choose Initialize. You can change these 
values if you choose):

In this field: Do this:

Billing Cycle Select the payment frequency (required).
Accrual Base Select the accrual base (required).
Balloon Method Select the balloon method (required).
Time Counting Method Select the time counting method (required).
Installment Method Select the installment method: EQUAL PAYMENTS or 

FINAL PAYMENT DIFFERS. Note: For more informa-
tion, see the Final Payment Amount Amortization 
Options (Last Payment Differs) section in this chapter 
(required).

Bill Method Select the billing method as either LEVEL, PERCENT-
AGE OF PRINCIPAL PLUS INTEREST, INTEREST ONLY, 
FIXED PRINCIPAL PLUS INTEREST, PERCENTAGE OF 
OUTSTANDING BALANCE (required).

6 If the calculation includes a promotion, complete the Rate Schedule block. 

In this field: Do this:

Seq   Enter the sequence number of the rate schedule 
(required).

Rate Enter the repayment amount borrower agreed to pay dur-
ing the schedule (required).

Start Date Enter the repayment amount borrower agreed to pay dur-
ing the schedule (required).

(After you enter other required information and select the Calculate button, Oracle Day-
break computes the repayment schedule while considering promotional rate schedule and 
populates the Repayment Schedule block.)

7 If this calculation involves a flexible repayment schedule, complete the Repayment 
Options block.

In this field: Do this:

Flexible Repayment Options If selected, indicates that this calculation involves flexi-
ble repayment.
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Type   Select the flexible repayment schedule you want to use 
from the following: SKIP PERIOD, USER DEFINED, 
UNDEFINED, GRADUATED PAYMENT and EXTEND-
ABLE BALLOON.
The Payment Change Schedule block is available when 
you select GRADUATED PAYMENT.
The Extendable Balloon block’s Max Term field is avail-
able when you select EXTENDABLE BALLOON.

Note: If you selected Import Values in the Action block and have completed the Contract 
(5) master tab’s Contract (2) sub page, Oracle Daybreak imports its Repayment block val-
ues.

• If you selected GRADUATED PAYMENT in the Repayment Options block’s Type field, 
complete the Payment Change Schedule block.

In this field: Do this:

Seq Enter the sequence number in which the repayment is 
calculated (required). 
Note: This prioritizes the calculation.

Option Type Select the repayment option type: STEP UP, STEP DOWN, 
and BULLET (required).

Frequency Select the frequency of payment. The default value is 
TERM (required).

Period Enter the period of each adjustment (required).
# of Adj. Enter the number of times the STEP UP, STEP DOWN, or 

BULLET needs to happen (required).
Value Enter the value. For STEP DOWN, value ranges from 1 to 

99. For STEP UP, value ranges from 1 to 990. For BUL-
LET, value ranges from 1 to 99999999.

• If you selected EXTENDABLE BALLOON in the Repayment Options block’s Type field, 
complete the Extendable Balloon block.

In this field: Do this:

Max Term Enter the maximum number of terms for the extendable 
balloon payment (optional).

• If you manually selected SKIP PERIOD in the Repayment Options block’s Type field, 
select the months where repayment needs to be skipped in the Skip Months block. 

(After you enter other required information and select the Calculate button, Oracle Day-
break computes the repayment schedule while considering skip period and populates the 
Repayment Schedule block.)

• If you selected USER DEFINED in the Repayment Options block’s Type field, complete 
the Repayment Schedule block. 

In this field: Do this:

Seq   Enter the sequence number of the repayment schedule 
(required).

Pmt Amt   Enter the repayment amount borrower agreed to pay dur-
ing the schedule (required).
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# of Pmts   Enter the number of payments borrower agreed to pay for 
stated repayment amount during this schedule (required).

When you fund the loan application, Oracle Daybreak copies the repayment schedule 
information to the loan account on the Customer Service form where it appears on the 
Repayment Schedule sub page.

8 In the Action block, choose Calculate.

Oracle Daybreak calculates the following information:

In this field: View this:

Rate block
APR Annual percentage rate (display only).

Payment/Finance Charge block
Pmt Amt Payment amount (display only).
Interest Amt Total estimated interest amount (display only).
Finance Charge Total estimated finance charge (display only).
Total of Pmts Estimated total of payments (display only).
Final Pmt Amount Final payment amount (display only).

First Period block
Calendar Days Number of days in the first payment cycle (display only).
Interest Interest accruing during the first period (display only).

To create an amortized schedule of loan payments (Calculator Tools form)

1 Complete steps 1 - 8 in the previous section To calculate a loan payment (Calculator 
Tools form).

2 In the Action block, choose Amortize.

Oracle Daybreak uses the calculated payment data to complete the Amortization Schedule 
block and displays the following information:

In this field: View this:

Seq Payment number (display only).
Pmt Dt Payment date (display only).
Pmt Amt Payment amount (display only).
Interest Amt Component of the payment amount allocated towards 

reduction of the interest balance (display only).
Principal Amt Component of the payment amount allocated towards 

reduction of the principal balance (display only).
Balance Amt Remaining principal balance (display only).
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To print a report of the loan payment calculations (Calculator Tools form)

1 Complete steps 1 - 8 in the previous section To calculate a loan payment (Calculator 
Tools form).

2 In the Action block, choose Print Report.

Oracle Daybreak uses the information on the Loan Calculator page to print a report using 
the default printer. 

To print a report of the amortized schedule of payments (Calculator Tools 
form)

1 Complete two steps in the section To create an amortized schedule of payments (Cal-
culator Tools form).

2 In the Action block, choose Print Report.

Oracle Daybreak uses the information on the Loan Calculator page to print a report using 
the default printer.
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Calculating interest rates
The Calculate Interest Rate mode back-calculates the interest rate and the APR using the 
amount financed, standard payment, and terms. It also provides the amortization schedule 
of the loan.

Note: If you want to clear (or “refresh”) the Loan Calculator page at any time, choose Ini-
tialize in the Action block.

To calculate an interest rate (Calculator Tools form)

1 On the Lending menu, choose Tools, then choose Loan Calculator.

2 In the Action block, choose Calculate Interest Rate, then choose Initialize.

3 In the Loan Details block, complete the following fields:

In this field: Do this:

Contract Dt Enter the contract date. Oracle Daybreak uses today’s 
date as the default value (required).

First Pmt Dt Enter the first payment date. Oracle Daybreak use’s the 
date one month from today as the default value 
(required).

Amt Financed Enter the amount financed (required).
Pre-Paid Fees Enter the prepaid fees, if any exist (required).
Loan Amt View the estimated loan amount: the amount financed 

plus the prepaid fees (display only).
Financed Fees Enter the financed fees, if any exist (required).
Balloon Pmt Amt Enter the balloon payment amount, if any exist 

(required).
Term Enter the number of payments (required).
Maturity Dt View the maturity date (display only).

4 In the Payment/Finance Charge block, complete the following fields:

In this field: Do this:

Pmt Amt Enter the payment amount (required).

5 In the Calculator Options block, complete the following fields (Oracle Daybreak com-
pletes these fields with default values after you choose Initialize. You can change these 
values if you choose):

In this field: Do this:

Billing Cycle Select the payment frequency (required).
Accrual Base Select the accrual base (required).
Balloon Method Select the balloon method (required).
Time Counting Method Select the time counting method (required).
Installment Method Select the installment method: EQUAL PAYMENTS or 

FINAL PAYMENT DIFFERS. Note: For more informa-
tion, see the Final Payment Amount Amortization 
Options (Last Payment Differs) section in this chapter 
(required).

Bill Method Select the billing method as either LEVEL, PERCENT-
AGE OF PRINCIPAL PLUS INTEREST, INTEREST ONLY, 
FIXED PRINCIPAL PLUS INTEREST, PERCENTAGE OF 
OUTSTANDING BALANCE (required).
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6 If the calculation includes a promotion, complete the Rate Schedule block. 

In this field: Do this:

Seq   Enter the sequence number of the rate schedule 
(required).

Rate Enter the repayment amount borrower agreed to pay dur-
ing the schedule (required).

Start Date Enter the repayment amount borrower agreed to pay dur-
ing the schedule (required).

(After you enter other required information and select the Calculate button, Oracle Day-
break computes the repayment schedule while considering promotional rate schedule and 
populates the Repayment Schedule block.)

7 If this calculation involves a flexible repayment schedule, complete the Repayment 
Options block.

In this field: Do this:

Flexible Repayment Options If selected, indicates that this calculation involves flexi-
ble repayment.

Type   Select the flexible repayment schedule you want to use 
from the following: SKIP PERIOD, USER DEFINED, 
UNDEFINED, GRADUATED PAYMENT and EXTEND-
ABLE BALLOON.
The Payment Change Schedule block is available when 
you select GRADUATED PAYMENT.
The Extendable Balloon block’s Max Term field is avail-
able when you select EXTENDABLE BALLOON.

Note: If you selected Import Values in the Action block and have completed the Contract 
(5) master tab’s Contract (2) sub page, Oracle Daybreak imports its Repayment block val-
ues.

• If you selected GRADUATED PAYMENT in the Repayment Options block’s Type field, 
complete the Payment Change Schedule block.

In this field: Do this:

Seq Enter the sequence number in which the repayment is 
calculated (required). 
Note: This prioritizes the calculation.

Option Type Select the repayment option type: STEP UP, STEP DOWN, 
and BULLET (required).

Frequency Select the frequency of payment. The default value is 
TERM (required).

Period Enter the period of each adjustment (required).
# of Adj. Enter the number of times the STEP UP, STEP DOWN, or 

BULLET needs to happen (required).
Value Enter the value. For STEP DOWN, value ranges from 1 to 

99. For STEP UP, value ranges from 1 to 990. For BUL-
LET, value ranges from 1 to 99999999.
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• If you selected EXTENDABLE BALLOON in the Repayment Options block’s Type field, 
complete the Extendable Balloon block.

In this field: Do this:

Max Term Enter the maximum number of terms for the extendable 
balloon payment (optional).

• If you manually selected SKIP PERIOD in the Repayment Options block’s Type field, 
select the months where repayment needs to be skipped in the Skip Months block. 

(After you enter other required information and select the Calculate button, Oracle Day-
break computes the repayment schedule while considering skip period and populates the 
Repayment Schedule block.)

• If you selected USER DEFINED in the Repayment Options block’s Type field, complete 
the Repayment Schedule block. 

In this field: Do this:

Seq   Enter the sequence number of the repayment schedule 
(required).

Pmt Amt   Enter the repayment amount borrower agreed to pay dur-
ing the schedule (required).

# of Pmts   Enter the number of payments borrower agreed to pay for 
stated repayment amount during this schedule (required).

When you fund the loan application, Oracle Daybreak copies the repayment schedule 
information to the loan account on the Customer Service form where it appears on the 
Repayment Schedule sub page.

8 In the Action block, choose Calculate.

Oracle Daybreak calculates the following information:

In this field: View this:

Rate block
Rate Interest rate (display only).
APR Annual percentage rate (display only).

Payment/Finance Charge block
Interest Amt Total estimated interest amount (display only).
Finance Charge Total estimated finance charge (display only).
Total of Pmts Estimated total of payments (display only).
Final Pmt Amount Final payment amount (display only).

First Period block
Calendar Days Number of days in the first payment cycle (display only).
Interest Interest accruing during the first period (display only).
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To create an amortized schedule of payments (Calculator Tools form)

1 Complete steps 1 - 8 in the section To calculate an interest rate (Calculator Tools 
form).

2 In the Action block, choose Amortize.

Oracle Daybreak uses the calculated interest rate data to complete the Amortization 
Schedule block and displays the following information:

In this field: View this:

Seq Payment number (display only).
Pmt Dt Payment date (display only).
Pmt Amt Payment amount (display only).
Interest Amt Component of the payment amount allocated towards 

reduction of the interest balance (display only).
Principal Amt Component of the payment amount allocated towards 

reduction of the principal balance (display only).
Balance Amt Remaining principal balance (display only).

To print a report of the payment calculations (Calculator Tools form)

1 Complete steps 1 - 8 in the previous section To calculate an interest rate (Calculator 
Tools form).

2 In the Action block, choose Print Report.

Oracle Daybreak uses the information on the Loan Calculator page to print a report using 
the default printer. 

To print a report of the amortized schedule of payments (Calculator Tools 
form)

1 Complete two steps in the section To create an amortized schedule of payments (Cal-
culator Tools form).

2 In the Action block, choose Print Report.

Oracle Daybreak uses the information on the Loan Calculator page to print a report using 
the default printer.
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CHAPTER 6 : FUNDING

At this stage of the loan origination process, the application has been entered into Oracle 
Daybreak and approved manually by an underwriter or automatically by Oracle Daybreak. 
The next step is to view and complete the contract information and make a funding deci-
sion to finance or reject the application. This is accomplished by using the Funding form. 
The Funding form transfers data from an approved applications to the loan servicing mod-
ule (Customer Service form), validating the data in the process and creating an account 
number.

This chapter explains how to:

• Load an application on the Funding form
• Change the status of the application to begin the funding process
• Verify the applicant information
• View the credit pull and underwriting information
• Verify the collateral
• Add comments and tracking attributes
• Complete the Contract (5) (truth-in-lending details) pages and sub pages
• View an application’s contract edits
• Audit changed fields and status history.
• Change the status at the end of the funding process.
Chapter 6 :-1  User Guide - Consumer Loans Origination



Funding with Oracle Daybreak (an overview)
In Oracle Daybreak, the funding process follows these basic steps:

1 Open the Funding form and load the application you want to work with.

2 Change the status of the application to APPROVED - VERIFYING.

3 Using the Applicants (2) master tab, view and verify information about the applicant 
(data recorded from the Application Entry form). This includes verifying the appli-
cant’s actual address and employment information.

4 Using the Decision (3) master tab, view and verify information supplied during the 
credit bureau pull and underwriting process. This is display only information and can-
not be edited.

5 Using the Collateral (6) master tab, view and verify information regarding the collat-
eral for the application.

6 Using the Contract (5) master tab, complete the truth-in-lending information. 

7 In the Funding form’s master block, change the status to FINAL DOCUMENT CHECK.

8 On the Verification (9) master tab, view any errors and warnings that prevent the sta-
tus change.

9 Make changes to the application data that correct the errors until you can change the 
status.

When Oracle Daybreak changes the status of the application to FINAL DOCUMENT 
CHECK, it sends the application to a supervisor or loan officer queue where it is viewed 
and verified. After this, the application’s status is changed to APPROVED - VERIFIED. If 
the supervisor/loan officer decides to fund the loan, he or she will change the status of the 
application to APPROVED - FUNDED. The application then becomes an account, and 
accounts are funded either manually or automatically. 

Loading an application on the Funding form 
The first step in the funding process is to open the Funding form and manually or automat-
ically load the application you want to work with. You can manually select an application 
using the Search (1) master tab. If your Oracle Daybreak system is configured to load 
applications based on work queues, applications automatically appear on the Results page 
when you open the Funding form.

To manually load an application

1 On the Lending menu, choose Funding.

The Funding form appears.

2 Use the Search and Results pages under the Search (1) master tab to find and load the 
application you want to work with. (See the Searching for Applications chapter for more 
information on this process.)

Oracle Daybreak opens the Applicant (2) master tab and loads the information about the 
selected application.
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To automatically load an application

1 On the Lending menu, choose Funding.

The Funding form appears and opens at the Results page. Applications automatically 
appear in the list box.

2 Begin the funding process by selecting the first application on the list.

Oracle Daybreak opens the Applicant (2) master tab and loads the information about the 
selected application.

Funding form’s master block
The Funding form’s master block displays information from the Application Entry and 
Underwriting forms’ master blocks, such as the application number, product, and pro-
ducer. It also contains the Status and unlabeled Sub Status field that allows you to change 
the status/sub status of the account and begin the funding process.

In this field: Do this:

App # View the application number (display only).
Dt View the application number (display only)
Joint Joint application indicator. If selected, indicates this is a 

joint application.
Cos Co-singed application indicator. If selected, indicates this 

is a co-signed application.
Purpose Select or view the purpose of the application (optional).
Priority Select or view the priority of the application (required).
Status Select or view the status of the application (required).
Sub Status (unlabeled) View the sub status of the application (display only).
Company Select or view the company of the application (required).
Branch (unlabeled) View the branch of the application (display only).
Product Select or view the product of the application (required).
Existing Customer Existing customer indicator. If selected, indicates this 

applicant has a previous account.
Dup Duplicate application indicator. If selected, indicates this 

is a duplicate application.
Contact Select or view the contact of the application (optional).
Channel Select or view how the application was received 

(optional).
Producer Select or view the producer type of the application 

(required).
Producer (unlabeled) Select or view the producer of the application (required).
Sales Agent Select or view the sales agent of the application 

(required).
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Changing the status to begin the funding process
After opening the Funding form and loading the application you want to work with, you 
must change its status to APPROVED - VERIFYING before you can begin the funding pro-
cess. This allows you to begin working with the application.

To change the status and begin work on the application 

1 Open the Funding form and load application you want to verify.

2 In the Funding form’s master block, use the Status field’s LOV to select APPROVED - 
VERIFYING.

3 Save your entry.

You can now begin making changes to the application.
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Verifying applicant information
Having selected and loaded an application, you can use the Applicant (2) master tab to 
view information about the applicant (s). This is information that was recorded on the 
Application Entry form or gathered during the credit pull. You can edit the data from the 
Application Entry form at anytime in the following steps. Remember to save your work 
with each change. Information from the credit bureau pull is available to view only. 

For more information about the fields on the pages and sub pages in this section, see the 
Entering an Application chapter.

Note: If the actual application was attached as an image, you can view it by choosing the 
Image (8) master tab. This can be used to double-check data.

To verify information on the Applicants (2) master tab

1 Open the Funding form and load the application you want to verify.

2 Choose the Applicants (2) master tab.

3 Open the Primary page to verify personal information about the primary applicant, includ-
ing name, license, and e-mail address.
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4 Open the Address sub page to verify data about the applicant’s place of residence. The 
Stated/Actual block allows you to record the actual monthly housing payment against the 
amount stated on the application.

5 Open the Employment Information sub page to verify data about the applicant’s place of 
employment. The Stated/Actual block allows you to record the actual monthly incomes 
against the amount stated on the application.
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6 Open the Telecoms sub page to verify all of the applicant’s phone numbers.

7 Open the Financials sub page to verify the types and sources of additional income. Oracle 
Daybreak uses this information when calculating an applicant’s net worth.
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8 Open the Existing Accounts sub page to view information regarding existing accounts 
for the applicant, if any exist. 

If you select an account record and open the Customer Service form from the Lending 
menu, Oracle Daybreak loads that existing account on the Customer Service form. On the 
Customer Service form, the other accounts for the applicant appear in the Accounts block 
of the master block.

9 Open the Others page to verify personal information about other applicants, including 
name, license, e-mail address, and the relationship (Type) to the primary applicant.

Note: The Others page and sub pages only need to be verified if a secondary or joint 
applicant exists. The Others sub pages are the same as the Primary sub pages.
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10 If this is an SME loan, open the Business page to verify information about business, 
including organization type, name of the business, and tax and banking details.

Note: The Business sub pages on the Funding form are the same as the Business sub 
pages on the Underwriting form.

11 Save any changes you made to the application.
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Viewing underwriting information
On the Decision (3) master tab, Oracle Daybreak displays information gathered during the 
underwriting process. Depending on the type application you are working with, Oracle 
Daybreak will display either the Loan page. Each of these pages all share the following 
sub pages: Stipulations, Itemization, and Checklist. They are all view only pages; you can-
not edit the contents.

Note: The fields on the Decision (3) master tab’s pages and sub pages are described in 
detail in the Underwriting chapter.

To verify the underwriting decision data

1 Open the Funding form and load the application you want to verify.

2 Choose the Decision (3) master tab.

• If you are funding a  loan, the following Loan page appears.

The Funding form’s Loan pages all share the Stipulations, Itemizations, Checklist, Rate 
Schedule (variable rate loan only), and Subvention sub pages.
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3 Open the Stipulations sub page to view any stipulations or reasons for adverse action 
attached to the application. If a stipulation entry was verified on the Underwriting form, 
the Verified By field notes who verified the entry and the Verify Dt notes when the entry 
was verified.

4 Open the Itemizations sub page to view any itemized amounts associated with the appli-
cation, such as the cash price, cash down payment, trade-in, unpaid cash price balance, 
and so on.
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5 Open the Checklist sub page to view tasks performed during the underwriting process. 

6 Open the Rate Schedule sub page and view the rate adjustment frequency information 
based on product setup. 

Note: The Rate Schedule sub page is only available for variable rate loans.
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7 Open the Subvention and view any subvention information recorded on the Underwriting 
form.

Note: The Subvention sub page is only available for loans.

8 Open the Multiple Offers and view the multiple pricing offers available to the customer. 

Note:You must select one of the offers before you wan fund the loan.
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Verifying the collateral
The Collateral (6) master tab contains pages with information regarding any collateral 
associated with an account. Depending on the type of loan, collateral can be a vehicle, 
home, or something else, such as major household appliances. The Collateral (6) master 
tab is not available if the account is an unsecured loan, as such loans by definition do not 
include collateral.

Note: A detailed explanation of the fields found on the Collateral (6) master tab’s pages 
and sub pages can be found in the Entering an Application and Underwriting chapters.

To verify information about the collateral 

1 Open the Funding form and load the application with the collateral you want to verify.

2 Choose the Collateral (6) master tab, if it is available. 

3 Verify the information regarding the collateral and its sub pages. (This is information that 
was recorded on the Application Entry form or gathered during the credit pull.)

Interface with VINTEK (If interface is installed)
Using the Vintek interface, Oracle Daybreak retrieves the year, make, model, and body of 
the vehicle on the Vehicle page of the Underwriting, Funding, Customer Service, and Con-
version App/Acc forms’ Collateral master tab when you choose Vehicle Details. This time 
saving feature reduces data entry errors. Using the VIN entered in the Identification Num-
ber field, Oracle Daybreak populates the following fields in the Vehicle block:

• Year
• Make
• Model
• Body 
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If the Vintek interface is unable to retrieve information based on the VIN entered in the 
Identification Number field, Oracle Daybreak displays an error message.

• The Home page contains information about homes used as collateral.

• The Other page contains information about anything other than a vehicle or home used as 
collateral. 

• The Valuation sub page contains information about the value of the asset. 
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• The Tracking sub page allows you to track additional data related to an asset, such as the 
title or insurance information.

4 Save any changes you have made to the pages on the Collateral (6) master tab.
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Adding comments
Using the Funding form, you can add any number of comments pertaining to an applica-
tion. Comments can be added at any time during the funding process.

To add comments to an application 

1 On the Funding form, choose the Comments (7) master tab.

2 In the Type block, use the LOV to select the type of comment you are adding.

3 In the Sub Type block, use the LOV to select the sub type of comment you are adding.

4 In the Comments block, type your comment.

5 If you want Oracle Daybreak to recognize this comment as an alert, selected Alert.

6 Save your entry.
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Entering tracking attributes
When using the Funding form, you can add tracking attribute information to an applica-
tion at any time in the underwriting process by using the Comments page.

To enter the comments for an application

1 Open the Funding form and load the application to which you want to add tracking 
attributes.

2 Choose the Comments (7) master tab, then choose the Tracking Attributes page.

3 Choose Create Tracking.

Oracle Daybreak loads the tracking parameters.

4 If you want to reduce the list of parameters, select a sub-attribute in the Sub Attribute 
box.

If your system has been configured to use the Sub Attribute field, only attributes in a par-
ticular group appear in the Parameter display.

5 Complete the Tracking block by entering the requested parameter in the Value field.

6 Save any changes you made to the account.
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Viewing an image 
When using the Funding form, you can view any images attached to the application at any 
time by using the Image (8) master page.

To view an image associated with an application

1 Open the Funding form and load the application with the image you want to view.

2 Choose the Image (8) master tab.

The Fax Image block contains the following display only fields:

In this field: View:

Fax Header The fax header.
Image Id The image id.
Image Status The image status.
Page # The page number.
Of The total number of pages.

The Fax Image block contains the following command buttons:

If you choose: Oracle Daybreak will:

Flip Image Rotate the selected image.
Print Image Send the selected image to a predefined printer.
Pr Display the previous page of the image (if one exists).
Nx Display the next page of the image (if one exists).
Up Scroll up through the selected image.
Dn Scroll down through the selected image.

Depending on the position of the application when it was faxed to the Oracle Daybreak, 
the image may be inverted on the Funding form.
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3 To rotate an upside-down image, choose Flip Image on the Fax Image block.

4 To navigate through the application:

• Use the scroll bar 
-or- 

• Choose Dn and Up on the Funding form.

The Page # and Of fields display what page is currently displayed in the Funding form 
and the total page length of the image.

5 To view other pages of the application, if they exist, choose Nx and Pr on the Funding 
form master block.
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Completing the Contract (5) (truth-in-lending details) pages
The pages associated with the Contract (5) master tab are the core of the funding process. 
They allow you to perform the important task of completing the truth-in-lending details. 
These pages include information mandated by Regulation Z; information about the 
financed amount, the payment schedule, the total of these payments, the finance charge, 
and the resulting annual percentage rate (calculated according to Federal guidelines; that 
is, within .125% of the Treasury OCC calculated APR). Use the loan packet to supply the 
required information.

In completing the truth-in-lending details on the Contract (5) master tab, you will com-
plete either the Loan page. The truth-in-lending details must be completed before a loan 
can be funded.

Note: The Tools (10) master tab can be helpful when completing this section. For more 
information on its use, see the Oracle Daybreak Tools chapter.

To complete the contract truth-in-lending details

1 Open the Funding form and load the application with the contract truth-in-lending details 
you must complete.

2 Choose the Contract (5) master tab.

• If the application you opened is for a loan, the following Loan page appears. 
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• If the application you opened involves an escrow, the Escrow Analysis page is available. 

3 Using the information in the contract packet, complete the Contract block. (The Oracle 
Daybreak calculator may used when completing this block. For more information, see the 
Oracle Daybreak Tools chapter.)

• On the Loan page for fixed rate loans, the Contract block contains the following fields:

In this field: Do this:

Contract Dt Enter the contract date (required).
Amt Financed Enter the amount financed: the loan amount applied 

minus the prepaid finance charges. Prepaid finance 
charges can be found on the Good Faith Estimate/Settle-
ment (HUD-1 or 1A). For example, if the borrower’s 
note is for $100,000 and the prepaid finance charge total 
is $5,000, the amount financed would be $95,000. The 
amount financed is the figure on which the annual per-
centage rate (APR) is based (required).

Term Enter the term/number of payments (required).
Rate Enter the interest rate (required).
Balloon Method View the balloon payment method (display only).
Balloon Amt Enter the balloon amount (required).
Due Day Enter the due day (required).
1st Pmt Dt Enter the first payment date (required).
Maturity Dt Enter the maturity date (required).
Finance Chg Enter the finance charge: the amount of interest, prepaid 

finance charge, and certain insurance premiums (if any) 
that the borrower will be expected to pay over the life of 
the loan (required).

Total of Pmts Enter the total of payments (required).
Down Pmt Enter the down payment amount (required).
Total Sale Price Enter the total sales price (required).
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Payment Amt View the payment amount (display only).
Final Pmt Amount View the final payment amount.This amount will be 

same as that in the Payment Amt field when the install-
ment method is EQUAL PAYMENTS.(required).

APR Enter the annual percentage rate: the cost of the loan in 
percentage terms taking into account various loan 
charges of which interest is only one such charge. Other 
charges which are used in calculating the APR are private 
mortgage insurance of FHA mortgage insurance pre-
mium (when applicable) and prepaid finance charges 
(loan discount, origination fees, prepaid interest and 
other credit costs). The APR is calculated by spreading 
these charges over the life of the loan, which results in a 
rate higher than the interest rate shown on you mortgage/
deed-of-trust note. If interest was the only finance 
charge, then the interest rate and the annual percentage 
rate would be the same (required).

Rcvd Dt Enter the contract received date (required).
Verify Dt Enter the contract verification date (optional).
Verified By View the user id who verified the contract (display only).
Principal Balance View the principal balance (display only).

• On the Loan page for variable rate loans, the Contract block contains the following fields:

In this field: Do this:

Contract Dt Enter the contract date (required).
Amt Financed Enter the amount financed: the loan amount applied 

minus the prepaid finance charges. Prepaid finance 
charges can be found on the Good Faith Estimate/Settle-
ment (HUD-1 or 1A). For example, if the borrower’s 
note is for $100,000 and the prepaid finance charge total 
is $5,000, the amount financed would be $95,000. The 
amount financed is the figure on which the annual per-
centage rate (APR) is based (required).

Term Enter the term/number of payments (required).
Index Select the index (required).
Index Rt View the index rate (display only).
Margin Rt Enter the margin rate (required).
Rate View the interest rate (display only).
Balloon Method View the balloon payment method (display only).
Balloon Amt Enter the balloon amount (required).
Due Day Enter the due day (required).
1st Pmt Dt Enter the first payment date (required).
Maturity Dt Enter the maturity date (required).
Finance Chg Enter the finance charge: the amount of interest, prepaid 

finance charge, and certain insurance premiums (if any) 
that the borrower will be expected to pay over the life of 
the loan (required).

Total of Pmts Enter the total of payments (required).
Down Pmt Enter the down payment amount (required).
Total Sale Price Enter the total sales price (required).
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Payment Amt Enter the payment amount (required).
Final Pmt Amount Enter the final payment amount.This amount will be 

same as that in the Payment Amt field when the install-
ment method is EQUAL PAYMENTS.(required).

APR Enter the annual percentage rate: the cost of the loan in 
percentage terms taking into account various loan 
charges of which interest is only one such charge. Other 
charges which are used in calculating the APR are private 
mortgage insurance of FHA mortgage insurance pre-
mium (when applicable) and prepaid finance charges 
(loan discount, origination fees, prepaid interest and 
other credit costs). The APR is calculated by spreading 
these charges over the life of the loan, which results in a 
rate higher than the interest rate shown on you mortgage/
deed-of-trust note. If interest was the only finance 
charge, then the interest rate and the annual percentage 
rate would be the same (required).

Rcvd Dt Enter the contract received date (required).
Verify Dt Enter the contract verification date (optional).
Verified By View the user id who verified the contract (display only).
Principal Balance View the principal balance (display only).

4 If applicable, enter information regarding any promotion associated with the application in 
the Promotion block.

• On the Loan page for fixed rate loans, the Promotion block contains the following fields:

In this field: Do this:

Promotion Select the promotion (required).
Type View the promotion type (display only).
Dlq Days View the cancel delinquency days (display only).
Period Type View the period type (display only).
Period View the promotion period (display only).
Tolerance Amt View the tolerance amount (displays only).
Rate View the promotion margin rate (display only).

• On the Loan page for variable rate loans, the Promotion block contains the following 
fields:

In this field: Do this:

Promotion Select the promotion (required).
Type View the promotion type (display only).
Dlq Days View the delinquency days (display only).
Period Type View the period type (display only).
Period View the promotion period (display only).
Tolerance Amt View the tolerance amount (displays only).
Index View the promotion index (displays only).
Index Rt View the promotion index rate (displays only).
Margin Rt View the promotion margin rate (displays only).
Rate View the promotion rate (display only).

5 Choose Select Instrument and use the LOV to select the predefined pricing instrument 
you want use to fund this application.
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Oracle Daybreak loads all the rules established by the company that are required at the 
time of funding; for example, the accrual method, billing method, type of billing, toler-
ance, due dates, extensions, and so on.

• On the Loan page for fixed rate loans, Oracle Daybreak displays the following informa-
tion:

In this field: Do this:

Instrument View the instrument (display only).
Accrual Mthd View the accrual calculation method (display only).
Start Days View the accrual start days (display only).
Start Dt Basis View the accrual start basis (display only).
Base Mthd View the accrual base method (display only).
Bill Mthd View the billing method (display only).
Bill Type View the billing type (display only).
Time Counting Mthd View the time counting method (display only).
Installment Mthd View the installment methods (display only).

Escrow block
Allowed View the escrow allowed indicator. If selected, escrow is 

allowed for this account (display only).
Opt Out Select if you want to decline all escrow options for this 

loan instrument.

Post Maturity block
Default Rate If selected, indicates the default rate is available.
Rate Enter the past maturity rate (required).

Others block
1st Pmt Deduction View the first payment deduction indicator. If selected, 

the first payment deduction is in use (display only).
(1st Pmt Deduction) Days View the first payment deduction days (display only).

1st Pmt Refund View the first payment refund indicator. If selected, the 
first payment refund is in use.

(1st Pmt Refund) Days View the first payment refund days (display only).
Pre-Payment Penalty View the prepayment penalty indicator. If selected, a pre-

payment penalty can be applied (display only).
% Term View the prepayment penalty percentage of term (display 

only).
Recourse View the recourse indicator. If selected, there is a 

recourse associated with the loan (display only).
Max % View maximum recourse percentage (display only).
Payoff Fee View the payoff fee indicator. If selected, a payoff fee can 

be applied to the loan (display only).

Rebate block
Rebate Mthd View the rebate calculation method (display only).
Rebate Term Mthd View the rebate term method (display only).
Rebate Min Fin Chg Mthd View the rebate minimum finance charge calculation 

method (display only).
Value View the minimum finance charge value (display only).
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Acquisition Charge Amt View the acquisition charge amount (display only).

• On the Loan page for variable rate loans, Oracle Daybreak displays the following infor-
mation:

In this field: Do this:

Instrument View the instrument (display only).
Accrual Mthd View the accrual calculation method (display only).
Start Days View the accrual start days (display only).
Start Dt Basis View the accrual start basis (display only).
Base Mthd View the accrual base method (display only).
Bill Mthd View the billing method (display only).
Bill Type View the billing type (display only).
Time Counting Mthd View the time counting method (display only).
Installment Mthd View the installment methods (display only).

Escrow block
Allowed View the escrow allowed indicator. If selected, escrow is 

allowed for this account (display only).
Opt Out Select if you want to decline all escrow options for this 

loan instrument.

Post Maturity block
Default Rate If selected, indicates the default rate is available.
Index Select the post maturity index (required).
Maturity Rt Enter the past maturity rate (required).

Others block
1st Pmt Deduction View the first payment deduction indicator. If selected, 

the first payment deduction is in use (display only).
(1st Pmt Deduction) Days View the first payment deduction days (display only).
1st Pmt Refund View the first payment refund indicator. If selected, the 

first payment refund is in use.
(1st Pmt Refund) Days View the first payment refund days (display only).
Pre-Pmt Penalty View the prepayment penalty indicator. If selected, a pre-

payment penalty can be applied (display only).
% Term View the prepayment penalty percentage of term (display 

only).
Recourse View the recourse indicator. If selected, there is a 

recourse associated with the loan (display only).
Max % View maximum recourse percentage (display only).
Payoff Fee View the payoff fee indicator. If selected, a payoff fee can 

be applied to the loan (display only).

Rate Caps and Adjustments
Increase (Per Adj.) View the maximum rate increase allowed in a year (dis-

play only).
Increase (Max Lifetime) View the maximum rate increase allowed in the life of 

the loan (display only).
Increase (Floor) View the rate cap (minimum) (display only).
Increase (Ceiling) View the rate cap (maximum) (display only).
Decrease (Per Adj.) View the maximum rate decrease allowed in a year.
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Decrease (Max Lifetime) View the maximum rate decrease allowed in the life of 
the loan (display only).

# of Adjs. (Per Adj.) View the maximum number rate changes allowed in a 
year (display only).

# of Adjs. (Max Lifetime) View the maximum number of rate changes allowed in 
the life of the loan (display only).

You are now ready to complete the Contract (5) master tab’s sub pages.
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Completing the Contract (5) (truth-in-lending details) sub pages
The Loan page share the following sub pages:

• Contract
• Contrac... (Contract (2))
• Itemizati... (Itemization)
• Trade-In
• Insurance
• ESC
• Escrow
• Compe... (Compensation - loan)
• Subven... (Subvention)
• Proceeds
• Disburs... (Disbursement)
• Fee
• ACH
• Coupon
• Refere... (References)
• Checklist
• Real Est... (Real Estate)

This section describes how to complete each one.

Contract sub page
The Contract sub page records the application’s servicing branch and collector. It also dis-
plays additional information regarding the contract not covered on the Loan page, such as 
the tolerance, delinquencies, due dates, billings, and extensions.

To complete the Contract sub page

1 Open the Funding form and load the application you want to work with.

2 Choose the Contract (5) master tab, then choose the Contract sub tab.
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3 On the Contract sub page, view or complete the following fields:

In this field: Do this:

Servicing Branch Select the servicing branch (required).
Collector Select the default collector (required).
Misc block
Link To Existing Customer Select to link the application to the existing customer.
Anniversary Period View the anniversary term (display only).
Default Pmt Spread View the spread (display only).

Billing block
Pre Bill Days View the pre billing days (display only).
Bill Cycle View the billing cycle (display only).

HMDA block
Lien Status Select the lien status (required).
HOEPA Select the home owner equity protection act (HOEPA) 

code (required).
Rate Spread Enter the rate spread. You can calculate this spread from 

a tool on the Home Mortgage Disclosure Act (HMDA) 
website (required).

Tolerance block
Refund View the refund allowed indicator. If selected, the refund 

policies in this block are in use (display only).
Refund Tolerance View the refund tolerance amount (display only).
Pmt Tolerance View the payment tolerance percentage (display only).
Pmt Tolerance (%) View the payment tolerance percentage (display only).
Writeoff Tolerance View the write-off tolerance amount (display only).

Delinquency block
Late Charge Grace Days View the late charge grace days (display only).
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Delq Grace Days View the delinquency grace days (display only).
Delq Cat Mthd View the delinquency category method (display only).

Due Date block
Max Due Day Chg Days View the maximum due days (display only).
Min Due Day View the minimum due day (display only).
(Due Day) Max View the maximum due day (display only).
Max Due Day Chg Yr View the maximum due day changes allowed (year) (dis-

play only).
(Max Due Day Chg) Life View the maximum due day changes allowed (life) (dis-

play only).

Extension block
Max Extn Period Yr View the maximum extension allowed (year) (display 

only).
(Max Extn Period) Life View the maximum extension allowed (life) (display 

only).
Max # Extn Yr View the maximum number of extensions allowed (year) 

(display only).
(Max # Extn) Life View the maximum number of extensions allowed (life) 

(display only).

4 Save any changes you made to the application.

Contract (2) sub page
The Contract (2) sub page records the application’s advance information, repayment 
schedule, and skipped repayment months for variable rate loans.

To complete the Contract (2) sub page

1 Open the Funding form and load the application you want to work with.

2 Choose the Contract (5) master tab, then choose the Contract (2) sub tab (Contrac...).
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3 On the Contract (2) sub page, view or complete the following fields:

In this field: Do this:

Advance block
Multi Disbursement Allowed If selected, indicates that multiple disbursements are 

allowed.
Draw End Dt Enter the advance draw end date (optional).
Initial Advance (Min) View the minimum initial advance amount (display 

only).
Initial Advance (Max) View the maximum initial advance amount (display 

only).
Advance (Min) View the minimum subsequent advance amount (display 

only).
Advance (Max) View the maximum subsequent advance amount (display 

only).
Late Charge Allowed If selected, late charges are allowed during the disburse-

ment period.
Billing Allowed If selected, billing is allowed during the disbursement 

period.
Billing Method View the billing method during the disbursement period 

(display only).
Rate Enter the applicable interest rate during the disbursement 

period (required).

Repayment block:
Flexible Repayment Allowed If this display only check box is selected, then the flexi-

ble repayment functionality is set up and allowed for this 
application's product type.

Type   Select the flexible repayment schedule you want to use 
from the following: SKIP PERIOD, USER DEFINED, 
UNDEFINED.
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If you select the repayment schedule type of SKIP 
PERIOD, you then select the months for which borrower 
won't make any payments in the Skip Months block. 

If you select the repayment schedule type of USER 
DEFINED, you then enter the repayment schedule 
requested by borrower in the Schedule block; for exam-
ple, $300.00 for first 12 months, $350.00 for next 18 
months, and so on. 

Note: The borrower may not provide a complete repay-
ment schedule with the contract. Provisions are available 
with Oracle Daybreak to compute the repayment sched-
ule for remaining periods at a later time, if borrower pro-
vides partial repayment schedule. (optional).

Skip Months block
Jan If selected, indicates that repayment is skipped for Janu-

ary.
Feb If selected, indicates that repayment is skipped for Febru-

ary.
Mar If selected, indicates that repayment is skipped for 

March.
Apr If selected, indicates that repayment is skipped for April.
May If selected, indicates that repayment is skipped for May.
Jun If selected, indicates that repayment is skipped for June.
Jul If selected, indicates that repayment is skipped for July.
Aug If selected, indicates that repayment is skipped for 

August.
Sep If selected, indicates that repayment is skipped for Sep-

tember.
Oct If selected, indicates that repayment is skipped for Octo-

ber.
Nov If selected, indicates that repayment is skipped for 

November.
Dec If selected, indicates that repayment is skipped for 

December.

Schedule block
Note: Complete the Schedule block only if you entered USER DEFINED in the Repayment 
block’s Type field.
Seq   Enter the sequence number of the repayment schedule 

(required).
Pmt Amt   Enter the repayment amount borrower agreed to pay dur-

ing the schedule (required).
# of Pmts   Enter the number of payments borrower agreed to pay for 

stated repayment amount during this schedule (required).
Generated If selected, indicates that the schedule is system gener-

ated.
Enabled If selected, indicates that the schedule is enabled.

Extendable Balloon block
Max Term Enter maximum number of payments (optional).
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Payment Change Schedule block
Seq Enter the payment sequence number (required).
Option Type Select the option type (required).
Freq Enter the payment change frequency (required).
Period Enter the period (required).
# of Adj Enter the number of adjustments (required).
Value Enter the adjustment value (required).

4 Save any changes you made to the application.

Itemization sub page
Oracle Daybreak lists the distribution of the loan proceeds on the Itemization sub page 
when you choose Select Instrument on the Loan page. It lists amounts paid to the borrower 
directly, amount paid to the borrower’s account, and amount’s given on the borrower’ 
behalf to third parties. Itemizations are categorized according to advances, finance fees, 
prepaid fees, producers, or escrows. If you entered itemization amounts during on the 
Application Entry or Underwriting forms, you will see these values in the Amount or 
Approved Amt columns.

The Itemization sub page on the Funding form offers the option of computing the values 
for itemization according to a itemization formula associated with the selected instrument 
based on system setup.

Note: If you require any new itemizations, you can add them using the Setup menu Prod-
ucts command. (For more information, see the Products chapter in the i-flex solutions 
Oracle Daybreak Setup Guide.)

To complete the Itemization sub page 

1 Open the Funding form and load the application you want to work with.

2 Choose the Contract (5) master tab, then choose the Itemization sub tab (Itemizati...).
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3 On the Itemization sub page, view the following information:

In this field: Do this:

Itemization View the itemization (display only).
+/- View whether the itemization is added or subtracted (display

only).
Approved View the approved amount. This is information recorded on
  the Underwriting form (required).
Discount Rate Enter the discount rate (optional).
Tax View whether the itemization is taxable (Sales) if box is

selected.

4 Choose the option button for the type of itemization you want to use: Advance, Financed 
Fees, Pre-Paid Fees, Producer, or Escrow.

5 In the Amount column, enter the amount corresponding with what is listed in the Itemiza-
tion column.

6 If the Itemization Formula field contains an entry other that UNDEFINED, you can choose 
Compute to auto-compute the value in the Amount field using a predefined itemization 
formula. 

Itemization formulas are created on the Product Setup form’s Origination Fees pages. (For 
more information, see the Org. Fees tab section of the Products chapter in the i-flex 
solutions Oracle Daybreak Setup Guide.)

To ensure you create the correct computed value, choose Compute after entering values 
for all base itemizations; that is, values of all such itemizations with an Itemization For-
mula of UNDEFINED. 

You can also manually enter amounts for auto-computed itemizations.

Note: If you choose Initialize, Oracle Daybreak sets the values of auto-computed itemiza-
tions to 0 (zero).

7 If you choose, use the Comment field to add remarks.

8 Save any changes you made on the application.
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Trade-In sub page
If there is any information regarding an itemized trade-in, use the Trade-In sub page to 
enter the details in Oracle Daybreak. (This sub page might already contain information 
supplied during the underwriting process.)

To complete the Trade-In sub page

1 Open the Funding form and load the application you want to work with.

2 Choose the Contract (5) master tab, then choose the Trade-In sub tab.

3 On the Trade-In sub page, view or complete the following fields:

In this field: Do this:

Asset block
Asset Type Select the asset type (required).
Asset Sub Type Select the asset sub-type (optional).
Year Enter the year of the asset (required).
Make Enter the make of the asset (required).
Model Enter the model of the asset (required).
Body Enter the body of the asset (optional).
Identification Number Enter the identification number (optional).
Desc View the asset description (display only).

Value block
Base (Wholesale) Enter the wholesale value (required).
Base (Retail) Enter the retail value (required).
Addons (+) Enter the addons value (required).
Payoff Amt (-) Enter the payoff amount (required).
Total Value = View the total value (display only).
Valuation Dt Enter the valuation date (optional).
Source Select the valuation source (optional).
Supplement Enter the valuation supplement (optional).
Edition Enter the valuation edition (optional).

4 Save any changes you made on the application.
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Insurance sub page
If there is any information regarding an itemized insurance amount, enter the details on the 
Insurance sub page. The Insurance sub page also allows you to calculate the commission if 
there is a commission rule defined during Contract setup.

To complete the Insurance sub page

1 Open the Funding form and load the application you want to work with.

2 Choose the Contract (5) master tab, then choose the Insurance sub tab.

3 On the Insurance sub page, view or complete the following information in the Policy 
Information block:

In this field: Do this:

Insurance Plan Select the insurance plan associated with the financed 
insurance product (optional).

Insurance Type View the insurance type associated with the insurance 
plan (display only).

Sub Type Select the insurance sub type offered under the insurance 
plan (required).

Insurance Company Enter the insurance company associated with the insur-
ance plan. Oracle Daybreak populates the default insur-
ance plan defined during product setup. (optional).

Policy Number Enter the insurance policy number (required).
Phone No Enter the insurance company’s primary phone number 

(optional).
Ext Enter the insurance company’s primary phone extension 

(optional).
Effective Dt Enter the insurance effective date (required).
Expiration Dt Enter the insurance expiry date (optional).
Phone No Enter the insurance company’s alternate phone number 

(optional).
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Ext Enter the insurance company’s alternate phone extension 
(optional).

Premium Amt Enter the insurance premium amount (optional).
Term Enter the insurance term (required).
Commission Rule View the insurance premium amount (display only).
Commission Amt View the insurance commission amount (display only).
Primary Enter the primary beneficiary of the insurance (optional).
Secondary Enter the secondary beneficiary of the insurance 

(optional).
Comment Enter a comment (optional).

4 In the Cancellation/Refund block, view the following display only information:

In this field: Do this:

Allowed If selected, a refund is allowed. A selected box indicates 
that the insurance premium can be rebated to the cus-
tomer in case of early payoff.

Grace Days   View the number of grace days allowed for cancellation 
without charging a cancellation fee.

Calculation Method View the insurance premium refund/rebate calculation 
method to be used when insurance is cancelled.

Grace Day's Cancellation If selected, indicates that cancellation fees during grace
Fee Allowed period is allowed.
Cancellation Fee View the amount of the cancellation fee to be charged 

when the insurance is cancelled.

5 If you choose the Calculate button, Oracle Daybreak computes the commission based on 
the commission method in the Cancellation/Refund block. 

The commission appears in the Commission Rule and Commission Amt fields of the 
Policy Information block. It also appears on the Itemization sub page.

Note:You can overwrite the suggested value if you choose.

6 Save any changes you made to the application.
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ESC sub page
If there is information regarding an itemized extended service contract or warranty 
amount, enter the details on the ESC sub page.

To complete the ESC (extended service contracts) sub page 

1 Open the Funding form and load the application you want to work with.

2 Choose the Contract (5) master tab, then choose the ESC sub tab.

3 On the ESC sub page, view or complete the following information in the Warranty Infor-
mation block:

In this field: Do this:

Service Contract View the extended service contract type (display only).
Warranty Company Enter the ESC company’s name (optional).
Policy Number Enter the ESC number (required).
Phone No Enter the ESC company’s primary phone number 

(optional).
Ext Enter the ESC company’s primary phone extension 

(optional).
Effective Dt Enter the ESC effective date (required).
Expiration Dt Enter the ESC expiry date (optional).
Phone No Enter the ESC company’s alternate phone number 

(optional).
Ext Enter the ESC company’s alternate phone extension 

(optional).
Premium Amt View the ESC premium amount (display only) (optional).
Term Enter the ESC term (required).
Comment Enter a comment (optional).

4 In the Cancellation/Refund block, view the following information.
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• If the Allowed box is selected, a refund is allowed. A selected box indicates that the ESC 
premium can be rebated to the customer in case of early payoff.
The Method field displays the refund method.

5 If you choose the Calculate button, Oracle Daybreak computes the commission based on 
the commission method in the Cancellation/Refund block. 

The commission appears in the Commission Rule and Commission Amt fields of the 
Policy Information block. It also appears on the Itemization sub page

Note: You can overwrite the suggested value if you choose.

6 Save any changes you made to the application.

Escrow sub page
If there is escrow information selected on the Itemization sub page, enter information 
about it on the Escrow sub page. The Escrow sub page records escrow details regarding 
disbursement, insurance, and property tax -- information that is parsed to the Customer 
Service form on the Customer Service (2) master tab, where it is available for mainte-
nance.

Note: This sub tab is available if escrow is allowed for the instrument selected on the Loan 
page.

The Escrow Analysis page allows you to view and perform the initial escrow analysis. 
You can perform multiple analyses; however, Oracle Daybreak records only the most 
recent analysis.

To complete the Escrow sub page 

1 Open the Funding form and load the application you want to work with.

2 Choose the Contract (5) master tab, then choose the Escrow sub tab.
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3 The Escrow Information block displays information regarding the escrow recorded on 
the Itemization sub page. In the Escrow Information block, view the following informa-
tion:

In this field: View:

Escrow The escrow itemization code and description (display 
only).

Escrow Type The escrow type (display only).
Escrow Sub Type The escrow sub type (display only).
Advance Amt The advance amount (display only).
Required Escrow If selected, indicates that escrow itemization is required 

(display only).
Cushion Allowed If selected, indicates that cushion is allowed (display 

only).

4 Select the Opt Out box only if you want to ignore this particular escrow. 

5 In the Disbursement block, enter the following information:

In this field: Do this:

Rule Select disbursement rule (required).
Yearly Amt Enter yearly disbursement amount (required).
Account # Enter reference account number for vendor. Note: If the 

organizational parameter 
UIX_HIDE_RESTRICTED_DATA is set to Y, this appears 
as a masked number; for example, XXXXX1234. 
(optional).

Vendor Enter the vendor name (required).
Maturity Dt Enter the maturity date, if one exists (optional).

6 If this escrow involves an insurance, use the Insurance block to enter the following infor-
mation:

In this field: Do this:

Coverage Type Enter the coverage type (optional).
Coverage Term Enter the coverage term (required).
Coverage Amt Enter the coverage amount (required).
Policy Nbr Enter the policy number (required).
Effective Dt Enter the effective date (required).
Expiration Dt Enter the expiration date (optional).
Comment Enter a comment (optional).

7 If this escrow involves a tax, use the Tax block to enter the following information:

In this field: Do this:

Property Tax Type Enter property tax code (optional).

8 Save your entry.
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Compensation (loan) sub page
The Compensation (loan) sub page records and displays the terms of compensation 
between the finance company and the dealer for loan transactions. 

To complete the Compensation (loan) sub page

1 Open the Funding form and load the application you want to work with.

2 Choose the Contract (5) master tab, then choose the Compensation (loan) sub tab 
(Compe...).

3 Choose Load.

The Compensation Plan LOV dialog box appears.

4 Use the LOV to select the compensation plan you want to load and choose OK.

Oracle Daybreak loads the following information on the Compensation sub page:

In this field: Do this:

Compensation Plan View the compensation plan (display only).
Disbursement Method View the compensation payment method (display only).
Calculation Method View the compensation calculation method (display 

only).

Chargeback block
Paid Calc Method View the charge back calculation method (early payoff) 

(display only).
Paid % View the charge back percentage (early payoff) (display 

only).
Paid Basis View the charge back basis (early payoff) (display only).
Paid Term View the charge back term (early payoff) (display only).
Paid Days View the charge back days (early payoff) (display only).
Charge off Calc Method View the charge back calculation method (charge off) 

(display only).
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Charge off % View the charge back percentage (charge off) (display 
only).

Charge off Basis View the charge back basis (charge off) (display only).
Charge off Term View the charge back term (charge off) (display only).
Charge off Days View the charge back days (charge off) (display only).

Calculation block
Spread Formula View the compensation spread formula (display only).
Buy Rate Enter the buy rate (required).
Factor View the compensation factor (display only).
Addl Factor View the additional compensation factor (display only).
Max Spread Percent View the maximum spread or percent allowed (display 

only).
Upfront % View the upfront compensation percentage (display 

only).
OR Flat Amt View the flat amount (display only).
Upfront Compensation Amt View the compensation amount paid upfront (display 

only).
Remaining Compensation Amt View the compensation amount remaining (display only).
Compensation Amt View the compensation amount (display only).

5 Make any necessary changes in the Buy Rate field.

6 Choose Calculate.

Oracle Daybreaks displays the details and amounts for this compensation plan.

7 Save the changes on the application.

Subvention sub page
With the Subvention sub page, you can enter the subvention information and calculate the 
subvention amount, as well as override the calculated subvention amount. The partici-
pant’s information is automatically populated based on the selected subvention plan.

To use the Subventions sub page

1 Open the Funding form and load the application you want to work with.

2 Choose the Contract (5) master tab, then choose the Subventions sub tab (Subven...).
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3 On the Subvention sub page, view or enter the following information:

In this field: Do this:

Subvention block:
Plan Select the subvention plan code (required).
Description View the subvention plan description (display only)
Sub Plan Description Select the subvention sub plan (required).
Subvention Type View the subvention type (display only)
Subvention Amount View the subvention amount for the plan (required).

Participants block:
Participant View the participant (display only).
Participant Type View the participant type (display only)
Collection Method View the collection method (display only).
Rate View the subvention rate (display only).
Rent factor View the subvention rent factor (display only).
Calculation Method View the subvention calculation method (display only).
Factor View the factor (display only).
Calculated Amount View the calculated subvention amount (display only).
Subvention Amount Enter the subvention amount (required).
Total Subvention Rate View the total subvention rate (display only).
Total Subvention Amount View the total subvention amount (display only).

4 Select the Initialize button to reset the subvention amount to zero.

5 Select the Calculate button to calculate the subvention amount.

6 Save your entry.
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Proceeds sub page
The Proceeds sub page displays the payment amount due to the dealer, based on the Com-
pensation and Itemization sub pages. It is a view only sub page, though you can record 
comments.

To use the Proceeds sub page

1 Open the Funding form and load the application you want to work with.

2 Choose the Contract (5) master tab, then choose the Proceeds sub tab.

3 On the Proceeds sub page, view or enter the following information:

In this field: Do this:

Proceed View the proceed itemization (display only).
+/- View whether the itemization is added to or subtracted 

from the total proceeds (display only).
Amount Enter the amount (display only).
Comment Enter a comment (optional).

4 Save any changes you made to the application.

Disbursement sub page
The Disbursement sub page records how the loan payment is disbursed and records pay-
ments to third parties, such as the Department of Motor Vehicles. This sub page needs to 
be completed if there is an itemized disbursement.

To complete the Disbursement sub page

1 On the Funding form, open the application you want to work with.

2 Choose the Contract (5) master tab, then choose the Disbursement sub tab (Disburs...). 
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3 On the Disbursement sub page, view or complete the following fields:

In this field: Do this:

Disbursement block
Description View the disbursement description (display only).
Validate Payee View the validate payee indicator. If selected, indicates 

that the payee needs to be validated.
Number Enter the disbursement party’s number (optional).
Name Enter the company name (required).
Amount View the payment amount (display only).
Address Enter the address line 1 (required).
Address 2 (unlabeled) Enter the address line 2 (optional).
Zip Enter the zip code (required).
City Enter the city (required).
St Select the state (required).
Extension (unlabeled) Enter the zip extension (optional).
Country Select the country (required).
Phone Enter the primary phone number (optional).
Extn Enter the primary phone extension (optional).
Phone Enter the alternate phone number (optional).
Extn Enter the alternate phone extension (optional).
Comment Enter a comment (optional).
Payment Mode Select the payment mode (required).
Account # Enter the account number. Note: If the organizational 

parameter UIX_HIDE_RESTRICTED_DATA is set to Y, 
this appears as a masked number; for example, 
XXXXX1234 (optional).

ACH Bank Enter the bank number (optional).
ACH Routing # Enter the routing number (optional).
ACH Account Type Enter the account type (optional).
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ACH Account # Enter the account number. Note: If the organizational 
parameter UIX_HIDE_RESTRICTED_DATA is set to Y, 
this appears as a masked number; for example, 
XXXXX1234 (optional).

4 Save any changes you made to the application.

Fee sub page
The Fee sub page is a view-only table displaying what fees on the loan instrument are in 
use, based on the contract.

To view the Fee sub page

1 Open the Funding form and load the application you want to work with.

2 Choose the Contract (5) master tab, then choose the Fee sub tab.

3 In the Fee sub page, view the following information:

In this field: Do this:

Fee View the fee type (display only).
Fee Calc Method View the fee calculation method (display only).
Txn Amt From View the minimum transaction amount (display only).
Percent View the maximum percentage (display only).
Min Amt View the minimum fee amount (display only).
Max Amt View the maximum fee amount (display only).
Enabled If selected, the fee rule is enabled (optional).
Chapter 6 :-46  User Guide - Consumer Loans Origination



ACH sub page
The ACH sub page records details about automatic clearinghouse, if this is a direct deposit 
payment account; otherwise, it remains empty. This information is used to receive pay-
ments, primarily when working with the Consumer Lending (Advance and Payment) 
form.

To complete the ACH sub page

1 Open the Funding form and load the application you want to work with.

2 Choose the Contract (5) master tab, then choose the ACH sub tab.

3 On the ACH sub page, enter the following information:

In this field: Do this:

Bank Information block
ACH If selected, the ACH is enabled.
Bank Enter the bank name (required).
Start Dt Enter the ACH start date (required).
Routing # Enter the routing number (required).
Account Type Select the account type (required).
Account # Enter the account number. Note: If the organizational 

parameter UIX_HIDE_RESTRICTED_DATA is set to Y, 
this appears as a masked number; for example, 
XXXXX1234 (required).

ACH Debit Amt Enter the payment amount (required).
Debit Freq Select the payment frequency (required).
Debit Day Enter the payment day (required).

4 Save any changes you made to the application.
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Coupon sub page 
The Coupon sub page allows you to order (or re-order) new coupon books. Note: This sub 
page is only available if the bill type for this application is a coupon payment, not a state-
ment.

To complete the Coupon sub page

1 Open the Funding form and load the application you want to work with.

2 Choose the Contract (5) master tab, then choose the Coupon sub tab.

3 On the Coupon Book Information sub page, enter or view the following information:

In this field: Do this:

Order Select to order coupon book (optional).
Order Dt Enter the coupon book order date (required).
Ordered By Select the user id of the user who ordered the coupon 

book (optional).
# of Coupons Enter the number of coupons (required).
First Pmt Dt Enter the first payment date (required).
Coupon Starting # Enter the starting number of the coupon book (required).
First Coupon Dt View the first coupon date (display only).
Coupon Ending # View the ending number of the coupon book (display 

only).
Last Coupon Dt View the last coupon date (display only).

4 Save any changes you made to the application.
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References sub page
The References sub page allows you to enter any number of people as a reference on the 
application.

To enter references for an application 

1 Open the Funding form and load the application you want to work with.

2 Choose the Contract (5) master tab, then choose the References sub tab (Refere...).

3 On the References sub page, complete the following fields with information about the 
reference:

In this field: Do this:

Relationship Select the reference type (required).
Name Enter the reference name (required).
Yrs Enter the number of years (required).
Mths Enter the number of months (required).
Address Enter the address line 1 (optional).
Address 2 (unlabeled) Enter the address line 2 (optional).
Zip Select the zip code (optional).
City Enter the city (optional).
St Select the state (optional).
Zip Extension (unlabeled) Enter the zip extension (optional).
Country Select the country (required).
Phone Enter the reference’s primary phone number (optional).
Ext Enter the reference’s primary phone extension (optional).
Phone Enter the reference’s secondary phone number (optional).
Ext Enter the reference’s secondary phone extension 

(optional).
Comment Enter a comment (optional).

4 Save the reference information.

Note: If you want to add another reference, insert a new record (press F6) and repeat steps 
3 and 4.
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Checklist sub page
The Funding form checklist helps ensure you follow the necessary procedures when fund-
ing an application. Complete this sub page if your business work flow requires you to use 
a checklist in the funding process.

To complete the Checklist sub page

1 Open the Funding form and load the application you want to work with.

2 Choose the Contract (5) master tab, then choose the Checklist sub tab.

3 If nothing appears on the Checklist sub page, choose Contract Checklist.

4 Complete the Checklist sub page with the following information:

In this field: Do this:

Checklist block
Checklist View the contract checklist (display only).
Comment Enter a comment (optional).
Complete Select box to indicate that the checklist is complete 

(optional).
Contract Checklist block
Action View the checklist action (display only).
Action Type Select the response (Yes/No/NA).
Comment Enter a comment (optional).

5 Read the tasks in the Checklist Actions block and use the Yes, No, or NA buttons to indi-
cate if you completed the task.

6 If necessary, add comments in the Comment column.

7 When you finish, select Complete and save the application.
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Real Estate sub page
The Real Estate sub page records additional information regarding manufactured home 
loans.

To complete the Real Estate sub page

1 Open the Funding form and load the application you want to work with.

2 Choose the Contract (5) master tab, then choose the Real Estate sub tab (Real Est...).

3 On the Real Estate sub page, complete the Real Estate Fields sub page with the following 
optional information:

In this field: Do this:

Note Transmittal Number Enter the note transmittal number.
Cancel/Cashout Transmittal Number Enter the deeding transmittal number.
Deed Input Date Enter the deed input date.
Deed Recording Date Enter the deed recording date.
Deeding Book Number Enter the deeding book number. 
Deeding Page Number Enter the deeding page number.
Mortgage Recording Date Enter the mortgage recording date.
Mortgage Book Number Enter the mortgage book number.
Mortgage Page Number Enter the mortgage page number.

4 Save your entry.
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Analyzing escrow
If escrow is allowed for the selected instrument, the Escrow Analysis page is available on 
the Contract (5) master tab. This page allows you to view and perform the initial escrow 
analysis. When you are satisfied with the analysis, complete the Approval Dt field in the 
Approval block and save your entry.

Note: You can perform multiple analysis; however, the Escrow Analysis page only records 
the last analysis performed. No record of any earlier analysis is currently available.

To complete the Escrow Analysis page

1 Open the Funding form and load the application you want to work with.

2 Choose the Contract (5) master tab, then choose the Escrow Analysis sub tab.

3 In the Escrow Analysis block, view or enter the following information:

In this field: View:

Escrow The escrow item.
Disbursement Rule The escrow disbursement rule.
Yearly Amt The escrow disbursement yearly amt.

4 Choose Analyze.

Note: Information on the Analysis Details sub page is based on expected cash flow from 
contract and escrow disbursement setup. Payments received appear before escrow dis-
bursement in any given month.

5 In the following blocks, view or enter the following information:

In this field: View:

Parameters block
Date The date.
Escrow Activity (From Dt) The FROM date.
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Escrow Activity (To Dt) The TO date.
Opening Bal (Act) The opening balance actual amount.
Opening Bal (Est) The opening balance estimated amount.
Cushion Type The cushion type.
Cushion Value The cushion value.
Cushion Amt The cushion amount.

Results block
Std Pmt Amt The standard payment amount.
(+) Escrow Pmt Amt The escrow payment amount.
(+) Spread Pmt Amt The spread payment amount.
(+) Other Pmt Amt The other payment amount.
= New Pmt Amt The new payment amount.

Surplus /<Shortage Amt> block
Surplus /<Shortage Amt> The surplus shortage amount.
Refund Amt The refund amount.

6 On the Analysis Details sub page, view the following information:

In this field: View:

Txn Dt The transaction date.
Transaction The escrow transaction.
Vendor The vendor name.
Txn Amt The amount of the transaction.
Bal Amt (Est) The estimated amount of balance.
Bal Amt (Act) The actual amount of balance.

Note: Information on the Analysis Details sub page is based on expected cash flow from 
contract and escrow disbursement setup. Payments received appear before escrow dis-
bursement in any given month.

7 If you want to re-analyze the escrow analysis, change the escrow information on the Con-
tract (5) master tab’s sub pages.

If you want to approve the escrow analysis, complete the following information fields on 
the Approval block:

In this field: View:

Approval block
Approval Dt The approval date (optional).
Approved By The person who approved the loan.

8 Save your entry.
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Verifying an application’s contract edits
Oracle Daybreak can be configured to automatically validate portions of an application 
when you attempt to change its status. The results of this data check appear on the Verifi-
cation (9) tab’s Edit page as an Error, a Warning, or an Override. 

If the edit is an Error, Oracle Daybreak will not allow you change the application’s status 
until you fix all the errors. 

If the edit is a Warning, Oracle Daybreak allows you to change an application’s status 
without correcting the matter. While you should still investigate the problem, Warning 
messages are of a lesser importance than Error messages. 

If the edit is an Override, Oracle Daybreak displays a dialog box informing you that an 
override is needed; your responsibility level does not have the authority required to pro-
cess this step. (Choose Yes on the dialog box to move the application to the queue of the 
user with the required authority.) 

Oracle Daybreak can be configured to verify different sets of information; for example, 
Oracle Daybreak could check one set of data when checking application entries for com-
pleteness and another when approving auto loans. Each one of these “edit types” has its on 
set of “edit details.”

To verify the data required for decisioning the application

1 Open the Funding form and load the application you want to work with.

2 Choose the Verification (9) master tab, then choose the Edits tab.

3 In the Edit Type block, select the type of edit you want to verify. (For the funding process, 
choose APPLICATIONS CONTRACT EDITS.)

Note: If the verification process you want to perform doesn’t appear in the Edit Type 
block, use the Edit Type field’s LOV to select and load it.
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4 Choose Check Edits.

Oracle Daybreak checks the data for the verification process selected in the Edit Type 
block and displays the results in the Edit Details block.

5 In the Edit Details block, view the verification results and begin making corrections on 
the Funding form.

6 When you are finished correcting errors, change the status of the application in the Fund-
ing form’s master block Status field.

Viewing audits
The Audits page is a display only page that allows you track changes to the contents of 
predetermined fields (which fields are determined during set up). For example, the Audits 
page can be configured to monitor when the contents of the Status and Sub Status is 
changed. The Audits page lists the field that was changed, who made the change, when the 
change was made, and the old and new values in the field.

To view the Audits page

1 Open the Funding form and load the application you want to validate.

2 Choose the Verification (9) master tab, then choose the Audits tab.

3 In the Audit Details block, view the following display only information:

In this field: View:

Record Id The record identifier for the record changed.
Field The field which was changed.
Old Value The old value of the column which was changed.
New Value The new value of the column which was changed.
Changed By The user code who made the change.
Changed Date The date and time when the change was made.
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Viewing Status History
You can track the time it took a user to complete each stage of the application process with 
the History page. It displays:

• The date and time when an application changed status / sub status
• The user who changed the status / sub status 
• The elapsed time of how long an application was in a particular status / sub status.

 To view the History page

1 Open the Funding form and load the application you want to validate.

2 Choose the Verification (9) master tab, then choose the History tab.

3 In the Application Status History block, view the following display only information:

In this field: View this:

Status The application status.
Sub Status The application sub status.
User Code The user code of the person who changed the status / sub 

status of the application.
User Name The user name of the person who changed the status / sub 

status of the application.
Start Date The date and time when the application moved to that 

status.
End Date The date and time when the application moved from that 

status.
Elapsed The elapsed time between the status change.
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Funding of an application
After you have verified the application, entered the contract information, and completed 
the contract edits, the application is ready to be funded. Applications can be approved 
automatically or manually. To manually fund and application, change the status to 
APPROVED - FUNDED. 

After an application is funded, the loan origination cycle is over. Oracle Daybreak moves 
the application to the loan servicing module (Customer Service form) where is receives an 
account number. Oracle Daybreak also automatically creates a check requisition for the 
funded account.

To fund an application

1 Using the Funding form, verify the information on the application.

2 To complete the verification process, choose APPROVED - VERIFIED in the Status field 
on the Application block at the top of the Funding form 

Note: After you approve the application, the information on the Decision (3) master tab is 
unavailable. The application remains in this status of APPROVED - VERIFIED until a user 
(usually a supervisor) changes the status to APPROVED - FUNDED. When the status is 
changed to APPROVED - FUNDED, the account is created.
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CHAPTER 7 : IMAGE MAINTENANCE / DOCUMENT TRACKING

The Documents menu opens the Image Maintenance form. Both allow for the paperless 
storage of documents within Oracle Daybreak, the first with applications during the loan 
origination cycle.

Image Maintenance form
The Image Maintenance form contains two pages: the Application Image Maintenance 
page and the Application Document Maintenance page.

Credit applications are often sent or faxed to financial institutions from producers (or 
“dealers”) on behalf of the customer. These credit applications, if received as fax, can be 
stored in Oracle Daybreak as images. Frequently, more than one application is received in 
a single fax or a single application is received across multiple faxes. In such cases, the 
Application Image Maintenance form can help you organize and maintain your image col-
lection.

The Application Document Maintenance page allows you to attach documents to an appli-
cation in the form of GIF files, PDF files, DOC files, XLS files, and TXT files. 
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Application Image Maintenance page (Image Maintenance form)
You can view any image in the Oracle Daybreak system in the upper list box of the Image 
Maintenance form.

To view an image

1 On the Documents menu, choose Application > Image Maintenance.

The Image Header block displays the images currently not attached to applications.

2 Scroll through the list of images in the Image Header block to view each image.

The Image Header block displays the following information for each image:

In this field: View this:

Image Id The image identification number.
Fax Header The fax header.
Status The image status.
Pages The total number of pages of the image.
Company The company the image came from.
Branch (unlabeled) The branch the image came from.

3 If an image is more than one page long, select the page you want to view in the Pages 
block.

Oracle Daybreak displays that page in the upper list box.
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To view all images

1 On the Documents menu, choose Application > Image Maintenance.

2 In the Image Header block, select View All Images.

All images entered in Oracle Daybreak appear in the Image Header block, including those 
that are attached to applications. Images attached to applications have a status of PRO-
CESSED.

3 In the Image Header block, select the image you want to view.

To search for an image

1 On the Documents menu, choose Application > Image Maintenance.

The Image Maintenance form appears.

2 On the Oracle Daybreak toolbar, choose Enter Query.
-or-
Press F7 to move to Enter-Query mode.

The Image Maintenance form clears.

3 In the Image Header block, complete the field(s) you want to use as search criteria 
(Image Id, Fax Header, Status, or Company) to find and load an image.

4 On the Oracle Daybreak toolbar, choose Execute Query.
-or-
Press F8 to perform the query.

Oracle Daybreak displays the images that match your search criteria in the Image Header 
block.

5 In the Image Header block, select the image you want to open.

The selected image appears in the upper list box of the Image Maintenance form.

Image Maintenance command buttons
The Image Maintenance command buttons are located to the right of the Image Header 
block. They allow you to change the appearance of the image in the list box, as well as 
send it to a printer.

If you choose: Oracle Daybreak will:

Flip Image Rotate the selected image.
Print Image Send the selected image to a predefined printer.
Up Scroll up through the selected image.
Dn Scroll down through the selected image.
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Splitting an image
If an image is more than one page long, you can split it into two separate images using the 
Split Image button. This option button is only available when an image contains more than 
one page. Also, you cannot split images with a status of “PROCESSED” or “SKIP.”

To split an image

1 On the Image Maintenance form, open the multiple page image you want to split.

2 In the Action block, select Split Image.

The Pages and New Image Id fields appear in the Action block.

3 In the Pages block, select the Select Page(s) boxes for the pages where you want to split 
the image.

The selected pages appear in the Pages field on the Actions block.

Note: You can select more than one page; however, you cannot select page # 1.

4 In the Actions block, choose Post.

Oracle Daybreak removes the selected pages and completes the New Image Id field with 
the image id of the new image.

Note: The new image does not appear in the Image Header block after you choose Post. 
However, if you refresh the Image Maintenance form by closing and opening the form or 
selecting View All Images, the new image id appears in the Image Header block and the 
change of page length in the original image is displayed.

Changing the status of an image
The Action block on the Image Maintenance form allows you to change the status of the 
image.

The Image Maintenance form uses the following statuses:

Status: What is does:

RUSH Moves the image to the front of the queue of images to be 
processed.

NEW Places an image in a queue in the order of which it was 
received and allows you to process it as an application.

SKIP Makes the image unavailable for processing until the sta-
tus is changed.

BAD Notes that the image is illegible and should be deleted.
PROCESSED Notes that the information on the image has been entered 

and is attached to an application.

Note: Only images with a status of RUSH or NEW can be attached to an application.

To change the status of an image
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1 On the Image Maintenance form, open the image whose status you want to change.

2 In the Action block, select Change Status.

The Status field appears.

3 Select the Status field and use the LOV to select the new status for the image.

4 Choose Post.

Oracle Daybreak changes the status of the image.

Attaching an image to an existing image
You can combine two images to make one image. This is the reverse of splitting an image.

To combine images

1 On the Image Maintenance form, open the image to which you want to attach an existing 
image.

2 In the Action block, select Attach to an Image.

The Image Id field appears.

3 Use the Image Id field’s LOV to select the image id of the image to which you want to 
attach the selected image.

4 Choose Post.

Oracle Daybreak joins the two images: the id of the image you selected in step 3 remains 
on the Image Header block. The image you selected in step 1 now appear as part of the 
remaining image.

Attaching an image to an existing credit application
You can attach one or more images to an existing credit application. 

Note: Attaching specific pages from a multiple page image to an application requires that 
you split the image to isolate the pages you want to attach, attach those pages, and, if nec-
essary, link pages of the original image back together.

To attach an image to an existing application image

1 On the Image Maintenance form, open the image you want to attach to an existing appli-
cation.

2 In the Action block, select Attach to an Application.

The App# field appears.

3 In the App # field, use the LOV to select the application number of the application to 
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which you want to attach the image. (This involves using the Oracle Daybreak LOV long-
list feature.)

4 Choose Post.

Oracle Daybreak attaches the image to the application. You can view the image in the 
Image (8) master tab on the Underwriting and Funding forms.

Printing an image
The Print Image button sends the selected image to a predefined printer.

To print an image

1 On the Image Maintenance form, open the image you want to print.

2 Choose Print Image.
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Application Document Maintenance page (Image Maintenance form)
Oracle Daybreak supports the online attachment of document images to an application 
with the Image Maintenance form’s Application Document Maintenance page. You can 
attach the documents from either a client machine or server. A default image directory can 
be maintained in Oracle Daybreak using the system parameter: 
UIX_DEFAULT_IMAGE_PATH. 

When you choose List File in the New Document block on the Document Maintenance 
page, Oracle Daybreak displays all available files in the selected directory in the Docu-
ment Details block. You can use the Document Maintenance and Action blocks to attach 
selected documents to a particular account.

To attach a document to an application from a server

1 On the Documents menu, choose Application > Document Maintenance.

The Image Maintenance form’s Application Document Maintenance page appears.

2 In the Action block, choose Attach Document (Server).

3 In the Select Document block, use the default image directory in the Directory Path 
field. (The default path is the value for the system parameter 
UIX_DEFAULT_IMAGE_PATH).
-or-
In the Directory Path field, enter the full path name to the document on the server that you 
want to attach to an account.

Note: You can choose Reset Path at any time to return to the default image directory.

4 In the Select Document block, choose List File. 

Oracle Daybreak displays the files from the entry in the Select Document block’s Direc-
tory Path in the Document Details block.

5 In the Document Details block, enter the following information:

In this field: Do this:

File Name View the file name for the document (display only).
Document Type   Select the type for the document (required).
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Document Sub Type   Select the sub type for the document (required).
Comments   Enter any comments regarding the document (optional).
App #   Select the application number to attach/copy/move the 

document image (optional).

6 Select the Attach indicator to attach the file to the account.

7 Save your entry.

8 In the Action block, choose Post.

Oracle Daybreak attaches the document to the application. 

You can view the document in a browser by choosing View Document in the Action 
block.

To attach a document to an application from a client machine

1 On the Documents menu, choose Application > Document Maintenance.

2 In the Action block, choose Attach Document (Client).

3 In the Select Document block, choose Upload From Client. 

An Open dialog box appears.

5 In the Open dialog box, use the Look in: list box to locate the document you want to 
attach to the account.

Note: You can select multiple files by holding the CTRL or SHIFT key on your keyboard.

6 When you have located the document you want to attach to the account in the Open dialog 
box’s File name: field, choose Open.

7 Oracle Daybreak uploads the selected file to the Document Maintenance page and dis-
plays the progress in the Upload Status block.

In this field: View this:

Total File(s) The total files uploaded from client.
Last File The last uploaded file name.
Bytes Uploaded The file upload status in bytes.
File Upload Status (%) The file upload status in percentage.
Overall Upload Status (%) The overall upload status in percentage.

8 In the Document Details block, enter the following information:

In this field: Do this:

File Name View the file name for the document (display only).
Document Type   Select the type for the document (required).
Document Sub Type   Select the sub type for the document (required).
Comments   Enter any comments regarding the document (optional).
App #   Select the application number to attach/copy/move the 

document image (optional).
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Note: If a document is attached to an application, and the application is loaded on the 
Underwriting or Funding form, when you open the Image Maintenance form’s Applica-
tion Document Maintenance page, the application number appears in the Document Main-
tenance block’s App # field. You can then select the document you want to work with in 
the Document Details block. 

You can also view the document in a browser by choosing View Document in the Action 
block.

9 Select the Attach indicator to attach the file to the application.

10 Save your entry.

11 In the Action block, choose Post.

Oracle Daybreak attaches the document to the application. 

Copy Document
The Action block’s Copy Document command copies the document image from one appli-
cation to another application. This command has no impact on the source application or 
the source application’s document image.

To copy a document to an application from another application

1 On the Documents menu, choose Application > Document Maintenance.

2 In the Action block, choose Copy Document.

3 In the Document Maintenance block, use the App# field to locate the account with the 
image you want to copy.

4 In the Document Maintenance block, choose Search. 

Oracle Daybreak displays the files attached to that application in the Document Details 
block.

5 In the Document Details block, select the document you want to copy.

6 In the Copy/Move App # field, enter the application number of the application to which 
you want to copy the document.

7 Save your entry.

8 In the Action block, choose Post.
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Move Document
The Action block’s Move Document command moves an existing document image from 
one application to another application. This command detaches the document image from 
the source application and attach to second application. 

To move a document to an application from another application

1 On the Documents menu, choose Application > Document Maintenance.

2 In the Action block, choose Copy Document.

3 In the Document Details block, use the App # field to locate the application with the 
image you want to move.

4 In the Document Maintenance block, choose Search. 

Oracle Daybreak displays the files attached to that application in the Document Details 
block.

5 In the Document Details block, select the document you want to move.

6 In the Copy/Move Acc # field, enter the application number of the application to which 
you want to move the document.

7 Save your entry.

8 In the Action block, choose Post.
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CHAPTER 8 : CORRESPONDENCE

Oracle Daybreak features two types of correspondence: predefined correspondence tem-
plates for loans included in the baseline system and ad-hoc correspondence that you create 
yourself. The predefined correspondence address matters regarding loan origination for 
applications. They also enable financial organizations to manage bulk mailings.

Origination: DECISION FAX/EMAIL
ADVERSE ACTION LETTER
CONDITIONAL ADVERSE ACTION LETTER
CONTRACT FUNDING FAX/EMAIL
CUSTOM LETTER 1
CUSTOM LETTER 2

Ad-hoc correspondence allows you to include information from applications in documents 
templates you create yourself without manually transferring the data. Ad-hoc documents 
can be generated as either Microsoft Word or PDF files.

Note: Predefined correspondence templates are stored on the Product Setup form’s Letters 
tab’s pages (Setup > Products > Loan > Letters > Loan Letters).
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Request page
Ad-hoc correspondence can be viewed on the Request page when you have opened an 
application. The page allows you to generate a new letter or view a previously generated 
letter.

To generate an ad hoc correspondence

1 On the Lending menu, choose Funding, Underwriting, or Customer Service and load 
the application for which you want to generate the ad hoc correspondence.

2 On the Letters menu, choose Ad-hoc.

3 In the Correspondence Request block, the following information appears regarding the 
application currently loaded:        

In this field: View this:

Level The correspondence type.
Number/Title The entity number and title.
Company The entity company.
Branch The entity branch.

4 In the Correspondence block, use the Correspondence field’s LOV to select the type of 
correspondence you want to generate.

Oracle Daybreak displays the following information in the Correspondence block for the 
selected type of correspondence:

In this field: View this:

Id View the correspondence id (display only).
Correspondence Select the correspondence you want to generated 

(required).
Date View the correspondence generation date (display only).
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5 Press F10 to save your entry.

The Documents block displays all the types of documents available for the type of corre-
spondence you selected. 

6 In the Documents block, view the following information for each document:

In this field: View this:

Document Id The document Id.
Document The document description.
Recipient The recipient description.
E-Form Source The e-form source.
Source Type The source type.
Generated If selected then Oracle Daybreak generated the docu-

ment.

7 In the Documents block, select the correspondence you want to view.

The Elements block displays the elements Oracle Daybreak used to generate the corre-
spondence. 

• If you choose All, Oracle Daybreak displays all elements in the correspondence.

• If you choose User Defined, Oracle Daybreak displays user-defined elements in the corre-
spondence.

8 In the Elements block, view the following information:

In this field: Do this:

Element View the element description.
Content Enter/view the value of the element.

9 Choose User Defined and complete the Content fields for the Element fields you want to 
include in the correspondence.

10 Choose Generate.

Oracle Daybreak “locks” the information included in the correspondence and prevents it 
from being changed.

11 Choose View.

Oracle Daybreak displays a PDF of the ad hoc correspondence.
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Samples of Oracle Daybreak LS predefined correspondence

Origination: Decision fax/email
The predefined Decision fax/email is automatically sent after an application receives a sta-
tus of APPROVED, REJECTED, or CONDITIONED on the Underwriting form.

The Decision fax/email is available for loans (fixed and variable rate).

To generate the Decision fax/email

1 On the Funding or Underwriting form, load the application you want to receive the Deci-
sion fax/email.

2 On the Letters menu, choose Pre-defined.

3 On the Run submenu, choose how you want to view the correspondence (Print or Pre-
view).

4 On the Origination sub menu choose Decision Fax.
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Example of the Decision fax (loan - fixed and variable rate)
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Origination: Adverse Action letter
The predefined loan Adverse Action letter is automatically sent to the producer after a 
configurable number of days when an application receives a status of REJECTED on the 
Underwriting form.

The Adverse Action letter is available for loans (fixed and variable rate) and lines of 
credit.

To generate the Adverse Action letter

1 On the Funding or Underwriting form, load the application you want to receive the 
Adverse Action letter.

2 On the Letters menu, choose Pre-defined.

3 On the Run submenu, choose how you want to view the correspondence (Print or Pre-
view).

4 On the Origination sub menu choose Adverse Action.
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Example of the Adverse Action letter (loan - fixed and variable rate)
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Origination: Conditional Adverse Action letter
The predefined Conditional Adverse Action letter is automatically sent to the producer a 
configurable number of days after an application receives a status of CONDITIONED on 
the Underwriting form.

The Conditional Adverse Action letter is available for loans (fixed and variable rate) and 
lines of credit.

To generate the Conditional Adverse Action letter

1 On the Funding or Underwriting form, load the application you want to receive the Con-
ditional Adverse Action letter.

2 On the Letters menu, choose Pre-defined.

3 On the Run submenu, choose how you want to view the correspondence (Print or Pre-
view).

4 On the Origination sub menu choose Conditional Adverse Action.
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Example of the Conditional Adverse Action letter (loan - fixed and 
variable rate)
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Origination: Contract Funding fax/email

The predefined Contract Funding fax/email can be automatically sent to a producer after an 
application receives a status of APPROVED or CONDITIONED on the Funding form.

The Contract Funding fax/email is available for loans (fixed and variable rate).

To generate the Contract Funding fax/email

1 On the Funding form, load the application you want to receive the Contract Funding fax/
email.

2 On the Letters menu, choose Pre-defined.

3 On the Run submenu, choose how you want to view the correspondence (Print or Pre-
view).

4 On the Origination sub menu, choose Contract/Funding Fax.

Example  of the Contract Funding Fax
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CHAPTER 9 : USER PRODUCTIVITY

The User Productivity form is a supervisor feature that allows you to monitor the daily 
performances of Oracle Daybreak users completing loan origination and loan servicing 
tasks. These tasks are categorized as either underwriting/funding tasks (loan origination) 
or customer service/collection tasks (loan servicing). 

Note: Oracle Daybreak updates this display only form every day.

Using the User Productivity form, you can review the following daily tallies: 

• Number of applications entered, by user
• Number of underwriting decisions (approved, rejected, conditioned, or withdrawn), 

by user
• Number of funding decisions (verified or funded), by user
• Number of applications entered, by queue

This chapter explains how to use the User Productivity form to view this information.
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Viewing the Underwriting/Funding tasks
Daily tallies from the loan origination module appear on the following pages:

• Application Entry
• Underwriting
• Funding
• Queues Status

Application Entry page
The Application Entry page displays the number of applications each Oracle Daybreak 
user entered that day.

To view the Application Entry page

1 On the Monitor menu, choose Users > Productivity > Underwriting/Funding.

2 Choose the Application Entry tab.

3 In the Application Entry by User block, view the following information:

In this field: View this:

User User code.
Name User name.
Applications Number of applications entered.
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Underwriting page
The Underwriting page displays the number of applications that were approved, rejected, 
conditioned, or withdrawn by each Oracle Daybreak user that day.

To view the Underwriting page

1 On the Monitor menu, choose Users > Productivity > Underwriting/Funding.

2 Choose the Underwriting tab.

3 In the Underwriting Entry by User block, view the following information:

In this field: View this:

User User code.
Name User name.
Approved Number of applications approved.
Rejected Number of applications rejected.
Conditioned Number of applications conditioned.
Withdrawn Number of applications withdrawn.
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Funding page
The Funding page displays the number of applications that each Oracle Daybreak user 
either verified of funded that day.

To view the Funding page

1 On the Monitor menu, choose Users > Productivity > Underwriting/Funding.

2 Choose the Funding tab.

3 In the Funding By User block, view the following information:

In this field: View this:

User User code.
Name User name.
Verified Number of applications verified.
Funded Number of applications funded.
Chapter 9 :-4  User Guide - Consumer Loans Origination



Queues Status page
The Queues Status page displays the number of applications worked by queue that day, as 
well as the users who worked the queue.

To view the Queues Status page

1 On the Monitor menu, choose Users > Productivity > Underwriting/Funding.

2 Choose the Queues Status tab.

3 In the Queues block, view the following information:

In this field: View this:

Company Company.
Branch Branch.
Queue Name Queue name.
Applications Number of applications in the queue.

4 In the Users block, view the following information for the selected queue:

In this field: View this:

User User code.
Name User name.
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APPENDIX A : ORACLE DAYBREAK INTERFACE

This appendix explains the Oracle Daybreak’s graphical user interface (GUI). It defines 
the components commonly found on a GUI, provides an overview of their functions, and 
explains how to:

• Use Oracle Daybreak’s windows and forms
• Work with the parent-child relationships between blocks
• Navigate within the Oracle Daybreak system.

Oracle Daybreak’s graphical user interface
All the forms in Oracle Daybreak appear as graphical user interfaces (GUIs). To use Ora-
cle Daybreak, you need to understand the components found on a GUI, as well as their 
functions. 

Windows and forms
Oracle Daybreak uses two basic GUIs in completing tasks: windows and forms.

Oracle Daybreak Lending Suite uses two windows, the iAS window and the Oracle Day-
break window. The Oracle Daybreak window is the java applet that is running Oracle 
Daybreak. The iAS window is the browser that launched the applet. In this sense, the iAS 
window is the parent of the Oracle Daybreak window. 
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Windows can be maximized, minimized, opened, closed, and repositioned. More than one 
window can be opened on your desktop; windows can overlap or appear adjacent to each 
other. The window that you are currently using, or is currently selected, is the “active” 
window. It appears on the top of the overlapping windows. Windows that are open but not 
selected are “inactive.” The title bar of an active window is a different color than the other 
inactive windows.

For more information on window components, see the Window components section of 
this chapter.

Oracle Daybreak uses forms to complete tasks. A form is an organized display of a mod-
ule’s fields, contained within a window. Forms allow you to enter, view, and update infor-
mation in the Oracle Daybreak system. Each module has its own form. Forms are opened 
from the Oracle Daybreak menu. For example, on the Lending menu, the Underwriting 
command opens the Underwriting form, the Funding command opens the Funding form, 
and the Customer Service command opens the Customer Service form. You can open mul-
tiple forms simultaneously. The forms that are available to you are based on your assigned 
responsibility.

Windows and forms have a very similar appearance, as forms always appear within win-
dows. An easy way to distinguish a window from a form is that a window contains the 
Minimize, Maximize, and Close buttons in the upper right corner, while a form does not. 

For more information on form components, see the Form components section of this 
chapter.
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Window components
This section presents an overview of the components found on windows, as well as their 
use.

Window title bar A horizontal bar containing the name of the window. The active 
window has a different colored title bar to distinguish it from 
other inactive windows.

The title bar also contains the Minimize, Maximize, and Close 
buttons.

The Minimize button reduces the Oracle Daybreak LS applica-
tion to a taskbar button on your desktop’s status bar.

The Maximize button allows you to resize Oracle Daybreak’s 
window on your desktop. (Note: You may have to choose the 
Maximize button to ensure Oracle Daybreak’s window is not cov-
ered by your desktop’s status bar.)

The Close button will quit Oracle Daybreak without logging off. 
(Note: Do not use the Close button to end a Oracle Daybreak ses-
sion.)

Menu bar The horizontal bar containing the menu names. The menu bar is 
located beneath the title bar and contains commands that allow 
you to open, view, and maintain a form. 

Note: You view the contents of a menu by clicking it or pressing 
ALT + [THE UNDERLINED LETTER IN THE MENU NAME]. 
For example, ALT + R opens the Reports menu. Commands can 
be selected using the mouse or by pressing the key of the under-
lined letter in the command name.

The following menus are available from the Oracle Daybreak menu bar. 

File Contains the following commands: 
Save - Records the current data on a form in the 
database.
Re-Logon - Closes the current Oracle Daybreak 
session and refreshes the Login form, allowing 
you to re-log on to Oracle Daybreak without 
leaving the system.
Change Responsibility - Allows you to change 
your Oracle Daybreak responsibility. Responsi-
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bilities determine what Oracle Daybreak features 
are available.
Change Password - Allows you to change your 
Oracle Daybreak password.
Clear Form - Clears the active form of its 
unsaved data.
Print - Prints the contents of an active form.
Exit - Closes the Login form and ends your cur-
rent Oracle Daybreak session.

Edit Contains the following commands:
Cut - Removes selected text from a form and 
stores it in the clipboard buffer.
Copy - Copies selected text from a form and 
stores it in the clipboard buffer.
Paste - Moves data from the clipboard buffer to 
a selected field on a form.
Edit Field - Opens the Editor dialog box with the 
contents of a selected field. 
List of Values - Opens a field’s List of Values 
dialog box, if one exists.

Query Contains the following commands:
Enter - Changes Oracle Daybreak to Enter-
Query mode. This allows you to search the data-
base.
Execute - Performs the query entered during 
Enter-Query mode.
Cancel - Changes Oracle Daybreak back to user 
mode.
Last Criteria - Repeats the most recently per-
formed query entered in Enter-Query mode.
Count Hits - Displays the number of records the 
current query produced in the message line.
Get Next Set - Retrieves the next set of records 
using the most recent query entered while in 
Enter-Query mode.

Navigation Contains the following commands:
Block - Allows you to navigate to the previous 
or next block, or clear the current block.
Record - Allows you to navigate between the 
previous and next record, scroll up and down 
between records, insert or remove a record, or 
duplicate or clear a record.
Field - Allows you to navigate between the pre-
vious and next field, as well as clear or duplicate 
a field.

Lending Contains the following commands:
Sales Lead - Allows you to open the Sales Lead 
form at the Lead Entry, Follow-up, or Mainte-
nance master tabs.
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Application Entry - Opens the untitled Applica-
tion Entry form.
Underwriting - Opens the Underwriting form.
Application Retrieval - Opens the Application 
Retrieval form.
Funding - Opens the Funding form.
Customer Service - Opens the Customer Ser-
vice form.
Collection - Opens the Customer Service form 
designed for a Oracle Daybreak user focussing 
on collections, as the Bankruptcy (4), Repo/Fore-
closure (5), and Deficiency (6) master tabs are 
unavailable.
Repossession/Foreclosure - Opens the Cus-
tomer Service form designed for a Oracle Day-
break user focussing on repossessions or 
foreclosures, as the Bankruptcy (4), and Defi-
ciency (6) master tabs are unavailable.
Bankruptcy - Opens the Customer Service form 
designed for a Oracle Daybreak user focussing 
on bankruptcies, as the Repo/Foreclosure (5) and 
Deficiency (6) master tabs are unavailable.
Deficiency - Opens the Customer Service form 
designed for a Oracle Daybreak user focussing 
on deficiencies, as the Bankruptcy (4) and Repo/
Foreclosure (5) master tabs are unavailable.
Collateral - Opens the Collateral form (currently 
unavailable).
Producers - Opens the Producer Management 
form.
Vendors - Allows you to open the Vendor Man-
agement form at the Vendors, Work Orders, or 
Invoices tab.
Securitization - Opens the Securitization form at 
the Loan tab.
Tools - Opens the Calculator Tools form at the 
Loan Calculator tab.
Transaction Authorization - Opens the Trans-
action Authorization form at the Authorization 
tab.
Custom Forms - [This is a placeholder for any 
forms customized (or added) by the client.]

Letters Contains the following commands:
Pre-defined - Allows you to generate a pre-
defined letter, either as a file or a printed docu-
ment, or preview it as a PDF file.
Ad-hoc - Opens the Correspondence form.

Documents Contains the following commands:
Application - Allows you to open the Image 
Maintenance form at either the Application 
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Image Maintenance or Application Document 
Maintenance master tab.
Account - Allows you to open the Account Doc-
ument Tracking form at either the Document 
Tracking or Document Maintenance master tab.

Reports Contains the following commands:
Run - Allows you to generate a wide array or 
predefined reports. (Note: For a complete list of 
reports available in Oracle Daybreak, please 
refer to the Oracle Daybreak Lending Suite 
Reports Catalog.)
Print - Modifies the Run command to generate a 
predefined report, either as a file or a printed 
document.
Preview - Modifies the Run command to gener-
ate a predefined report and view it as a PDF file 
with a browser.

Interfaces Contains the following commands:
GL Transactions - Opens the General Ledger 
form.
AP Transactions - Opens the AP Transactions 
form.
Card Transactions - Opens the Card Transac-
tions form.
Conversions - Opens the Conversion App/Acc 
form.

Batch Contains the following commands:
Transactions Advances - Allows you to open the Consumer 

Lending (Advance and Payment) form at either 
the Advance Entry or Advance Maintenance tab.
Payments - Allows you to open the Consumer 
Lending (Advance and Payment) form at either 
the Payment Entry or Payment Maintenance tab.
Escrow - Allows you to open the Escrow Analy-
sis and Disbursements form at the Escrow Anal-
ysis, Escrow Analysis Maintenance, Escrow 
Disbursement Entry, or Escrow Disbursement 
Maintenance master tabs.

Monitor Contains the following commands:
System - Allows you to open the Utilities form 
at the Setup, Monitor Batch Jobs, Monitor Jobs, 
Monitor Users, Services, Log Files, or Parked 
Transactions master tab.
User - Allows you to open the Utilities form at 
the Monitor Users master tab or open the User 
Productivity form at the Underwriting/Funding 
or Customer Service/Collection master tab.
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Setup Contains the following commands:
Administration - Allows you to open the 
Administration form at the System or User mas-
ter tab.
Products - Allows you to open the Product 
Setup form at the Setup, Loan master tab.
Queues - Allows you to open the Queue Setup 
form at the Setup, Origination, or Customer Ser-
vice master tab.
Correspondence - Opens the Correspondence 
form.
Events - Allows you to open the Events form at 
the Loan master tab.
Credit Bureau - Allows you to open the Credit 
Bureau Setup form at the Request or Reporting 
master tab.
Batch Jobs - Opens the Utilities form. 
Producers - Opens the Producer Management 
form.
Vendors - Opens the Vendor Management form.
Subvention - Opens the Subvention form at the 
Loan master tab.
Escrow - Opens the Escrow Setup form at the 
Loan master tab.
Securitization - Opens the Securitization form.
General Ledger - Opens the General Ledger 
form.

Window Contains the following commands:
Cascade - Arranges the open forms on your 
screen so that they overlap, with the active form 
on top.
Tile Horizontally - Arranges the open forms on 
your screen so that they appear one on top of 
another.
Tile Vertically - Arranges the open forms on 
your screen so that they appear one next to 
another.
Note: The lower portion of the menu displays the 
Oracle Daybreak forms you have opened. You 
can use this menu to move between forms by 
selecting a specific form.

Help Contains the following commands:
Keys - Opens the Keys dialog box, containing a 
listing of all the hot keys available for the current 
form in use. Hot keys are shortcuts that perform 
Oracle Daybreak tasks with a minimum of key-
strokes.
Display Error - Displays information about 
recently encountered Oracle errors. (i-flex solu-
tions Corp. requests that you create a screen shot 
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of this information and send it to us when you 
have a system error.)
Debug - Contains two commands: Set On and 
Set Off.
Oracle Daybreak Help - Allows you to open a 
browser and view .pdfs of either the User Guide 
or Setup Guide.
Oracle Daybreak On the Web - Allows you to 
open the i-flex solutions home page and report to 
Technical Support department when you encoun-
ter an error.
About Oracle Daybreak and Audit - Opens the 
About Oracle Daybreak dialog box, displaying 
version and audit information such as object data 
and recent updates. It also allows you access the 
column audit.

Oracle Daybreak toolbarThe row beneath the menu bar containing 19 icon buttons used 
to perform tasks and carry out commands. The toolbar buttons are 
labeled with the action they perform. To view the label, use the 
mouse to place the mouse pointer on the button without clicking 
and the label appears.

If you choose: (hot key) Oracle Daybreak will:

[A] Save Changes (F10) Save any pending changes on the 
form.

[B] Print (SHIFT + F8) Print the current screen.
[C] Exit (CTRL + E) Close the current form or exits the 

application.
[D] Cut (CTRL+X) Remove selected text and stores it 

on the clipboard.
[E] Copy (CTRL+C) Copy selected text and stores in on 

the clipboard.
[F] Paste (CTRL+V) Insert text stored on the clipboard 

in a selected field.
[G] Enter Query (F7) Change Oracle Daybreak to Enter-

Query mode.
[H] Execute Query (F8) Perform the query entered while in 

Query mode.
[I] Cancel Query (CTRL+Q) Change Oracle Daybreak back to 

user mode.
[J] First Record Display the first record.
[K] Previous Record (SHIFT + UP) Display the previous record.
[L] Next Record (SHIFT + DOWN) Display the next record.
[M] Last Record Display the last record.
[N] Insert Record (F6) Create a new record.
[O] Remove Record Delete the current record from the 

database.
[P] Clear Record (SHIFT+F4) Clear the current record from the 

form. 
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[Q] Lock/Unlock Record Lock and unlocks a record.
[R] Copy with Details Record Copy the selected record to the 

clipboard.
[S] Help (CTRL + H) Display help for the selected item.

Note: Depending on the context of the selected field, some toolbar buttons may not be 
available. For example, if you select a field that does not allow a query, the Enter Query 
button is unavailable.

Message lineThe message line is located in the lower left corner of the Oracle Daybreak 
window and displays field prompts, error messages, or additional details about a field. In 
the illustration below, the message line contains the error message: “Query caused no 
records to be retrieved.”

Status line The status line appears below the message line and displays status 
information about the current form or field. A status line can con-
tain the following indicators:

Enter-Query Indicates that Oracle Daybreak is in Enter-Query 
mode, allowing you to specify search criteria for 
a query.

List of Values Appears when a List of Values (LOV) is avail-
able for the selected field.

Form components
This section presents an overview of the components found on forms and how to use them.

Tab Oracle Daybreak uses tabs as a primary navigation tool. 

Tabs are small flaps used for quick access to pages of informa-
tion, not unlike the tabs on a folder in your file cabinet. There are 
three types of tabs in Oracle Daybreak system: master tab, tab, 
and sub tab. 

Master tabs are the highest level of tab. If present on a form, they 
are usually numbered and appear near the top of the form. Master 
tabs are used primarily to navigate to other pages. 

Tabs and sub tabs open pages that contain information. 

Sub tabs, if present, appear at the bottom of the form.
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Page (or tabbed page) The information items associated with a tab (blocks, records, 
check boxes, command buttons, and so on) are located on a page. 
The name of the page is the same as the name of the tab. The 
information associated with a sub tab is a sub page. 

In the illustration below, the Primary page and Address sub pages 
are is circled.
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Block A frame, or box, that encloses a set of related functions or data. A 
shadowed line marks a block’s perimeter. The title of the block 
appears across the top of the block in bold, black text. 

Command button A rectangle button that initiates a predefined action. Buttons do 
not contain values as fields do. A button is usually labeled with 
text noting the action that it performs. In the illustration below, 
the Loan page contains six command buttons: “Calculate,” 
“Amortize,” “Initialize,” “Copy to Decision,” “Copy to Con-
tract,” and “Print Report.” All three are located in the Action 
block.

Note: The “Copy to Contract” button is unavailable.

Field A box on a form used to enter, view, update, or delete informa-
tion. Each page contains fields. Fields can display values in dif-
ferent formats; including text, numbers, and dates.

Text field A field that stores characters and numbers.

Number field Number fields store only numbers, often dollar 
figures, with or without decimals.

Date field Date fields store dates and sometimes time val-
ues.

IMPORTANT: 
When you select a field, messages appear in the message area in 
the lower left corner of the Oracle Daybreak window. The mes-
sages describe the field or what type of information can be 
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entered in the field. (See Message line and Status line later in this 
section for more information.)

Option button A round button used to select an action from a group of options. 
You can select only one option button in a group at a time. In the 
illustration below, option buttons are used to select whether Ora-
cle Daybreak calculates payment or calculates interest rate. 

Check box A check box indicates a state for a particular field, such as 
enabled/disabled, primary/secondary, and current/not current. For 
that reason, check boxes are sometimes called “indicators.” The 
title of the check box indicates what it controls. A check denotes 
that the check box is selected. Click a selected check box to 
“clear” it. 

Note: One or more check boxes can be selected, since each one 
acts independently.

List of Values (LOV) A dialog box linked to a field that enables you to select a single 
item from a predefined list. To view a field's List of Values, press 
F9. Move the blue highlighted bar using the UP or DOWN ARROW 
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keys or the slide bar on the LOV dialog box to the value you want 
to select. In the example below, 55001 AFTON MN is selected. 
Some LOV contain lists long enough to require a scroll bar to 
view the entire contents. Choose OK, press ENTER, or double-
click the LOV item to populate the field with the selected value. 

Blue square (cursor) Oracle Daybreak uses a blue square as a cursor. The blue square 
indicates the active item, usually a field or record. You can move 
the blue square using the arrow keys on your keyboard or by 
clicking an item with the mouse.

Record A logically related collection of fields within a block about one 
person, place, or thing.

There are two types of records in Oracle Daybreak; table records 
and block records. A scroll bar allows you view records not cur-
rently displayed. The message bar informs you of the total num-
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ber of records in the table block, as well as the record you are 
currently viewing.

Table records Appear as a grid, where each record is a single 
row of related data.

Block records Record appears as a single block.

Record line Located in the lower left corner of the Oracle 
Daybreak window, the record line displays how 
many records exist within the record on display.

Next Record/ The presence of a record scroll bar indicates that 
Previous there are records above or below the one on
Record which you are working. If the scroll bar does not
scroll bar stretch the entire length between the two arrows, 

this indicates there are additional records avail-
able. If the scroll bar stretches the entire length 
between the two arrows this indicates no other 
records are available. Click the arrows to view 
these records. Click the up ( ) or left ( ) arrow 
for previous records. Click the down ( ) or right 
( ) arrow for following records.

Hint box A yellow box that appears when the mouse pointer is moved over 
a field. The hint box will display a description of the field’s con-
tent. If the field is associated with a List of Value dialog box, the 
hint box displays the Lookup Type of the LOV.

Using colors as a guide
Fields appear in different colors to indicate what type of information the field contains. 

Aqua Required - Information is required in an aqua field to complete a 
form.

White Optional - A white field is not required to contain information 
when completing a form. 

IMPORTANT:
Some optional fields may be required by your organization. Such 
fields, though not mandatory on the form, must be completed dur-
ing edit verification.

Gray Display only - Data cannot be entered in these fields. 

Note: Aqua, white, and gray are the default colors in the Oracle 
Daybreak system. Your organization may have selected different 
colors during implementation.
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Understanding parent-child relationships
A parent-child relationship is an association between a master block and one or more 
detail pages. The master-detail relationship is arranged in the shape of a pyramid, from the 
top of the form to the bottom. The top block contains the basic, or master, information. 
The detail pages then expand on the contents of the master block. Detail pages themselves 
can serve as master blocks for other sub detail pages that follow. When a block and pages 
are linked in a master-detail relationship, the following conditions exist:

1 The detail page displays only those records that are associated with the current record 
in the master block.

2 Querying between the master block and detail pages is always coordinated.

When a record is displayed in a master block, the detail pages contain information that 
corresponds to that record. If you perform query or change information in the master 
block, Oracle Daybreak updates the detail pages to match the new record in the master 
block. If you use the master block to perform a query and gain access to the records for a 
different application, the detail pages refresh to display information for the new record in 
the master block.

Note: You can perform a query from a detail page if the master block (or page) is com-
pleted. Otherwise, it is not possible to directly query from a detail page.

Example: Parent-child relationship
In the illustration below, note that the Underwriting form is divided into three sections. 
The top section (the Application block) is the master page. It contains such information as 
application number, product, and other items related to a specific application. The Appli-
cants (2) master tab has been selected to display the Primary page and Address Informa-
tion sub page. These detail pages contain further information about the application; in this 
case, the application’s primary applicant and that person’s address information.
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APPENDIX B : NAVIGATING AND QUERYING IN ORACLE DAY-
BREAK

This appendix explains how to use Oracle Daybreak to complete these frequently com-
pleted tasks:

• Navigate within and between forms
• Print a form
• Save an entry
• Edit data (including cutting, copying, and pasting data)
• Clear data
• Duplicate data
• Create and delete records
• Use the Editor dialog box
• Enter and query data using the List of Values (LOV) dialog box
• Use additional LOV tools (auto reduction, long-list, list search, and power list)
• Query data
• Use query operators and wildcard characters (including Query by example, Query/

Where, and Query count)
• Use hot keys.
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Navigating within a form
The following procedures can be used to navigate within a Oracle Daybreak form. Choose 
the one you are most comfortable using:

• Move the cursor with your mouse
• Select a command from the menu bar (Navigation menu)
• Select a command from the Oracle Daybreak toolbar
• Enter a keyboard shortcut (hot key)

The Navigation menu
The Navigation menu contains the following commands, all of which allow you to navi-
gate within a form: Block, Record, and Field.

The Block command contains the following sub commands:

If you choose: (hot key) Oracle Daybreak will:

Previous (CTRL + PAGE UP) Move the cursor to the previous block (if one 
exists).

Next (CTRL + PAGE DOWN) Move the cursor to the next block (if one exists).
Clear (SHIFT + F5) Clear the block currently containing the cursor.

The Record command contains the following sub commands:

If you choose: (hot key) Oracle Daybreak will:

Previous (SHIFT + F8) Display the previous record (if one exists).
Next (SHIFT + DOWN) Display the next record (if one exists).
Scroll Up (PAGE UP) Perform that same action as pressing PAGE UP.
Scroll Down (PAGE DOWN) Perform that same action as pressing PAGE 

DOWN.
Insert (F6) Create a new record.
Remove (SHIFT + F6) Remove the current record.
Duplicate (F4) Duplicate the current record.
Clear (SHIFT + F4) Clear the current record.

The Field command contains the following sub commands:

If you choose: (hot key) Oracle Daybreak will:

Previous (SHIFT + TAB) Move the cursor to the previous field (if one 
exists).

Next (TAB) Move the cursor to the next field (if one exists).
Clear (CTRL + U) Clear the current field.
Duplicate (F4) Duplicate the current field.

IMPORTANT:
The TAB and ENTER keys move the cursor between fields. F8 refreshes the record.
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Navigating between forms
You can open multiple forms in each window and navigate between them with the Win-
dow menu. The lower part of the Window menu lists the forms that are currently open. 
Selecting the form’s option button moves you to that form.

To navigate between forms

1 On the Oracle Daybreak menu bar, choose Window.

2 Select the form you want to move to by selecting it with one of the following methods:

• Click the option button for the corresponding form. 
-or-

• Move the cursor on the open Windows menu with the UP and DOWN ARROW keys and press 
ENTER to open a highlighted form.
-or-

• Type the number on the Windows menu next to the form you want to open.

Oracle Daybreak displays the form you selected.

Common Oracle Daybreak tasks
This section explains tasks common to many Oracle Daybreak modules and forms. Here 
you will learn how to:

• Print a form
• Save your work
• Editing data
• Using the Editor dialog box
• Close a form/leave Oracle Daybreak

Printing a form
You can print a form at any time. Make sure a printer driver is installed and at least one 
printer is defined before printing. (Contact your system administrator for information on 
how to install printer drivers and define printers.)

To print a window

• On the File menu, choose Print
-or-

• Click Print on the Oracle Daybreak tool bar.
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Saving your entry
When you save your work, the database is updated with all changes made since the last 
time the data was saved. 

To save your work in Oracle Daybreak

• On the File menu, choose Save
-or-

• On the Oracle Daybreak tool bar, choose Save (the yellow disk icon)
-or-

• Press F10.

When you save an entry, the message line at the bottom of your screen displays a “Trans-
action complete” message to inform you of the changes.

Editing data
In this section, you will learn how to use Oracle Daybreak to edit data. You will learn how 
to:

• Cut, copy, and paste data
• Clear data
• Duplicate data
• Create and delete records
• Use the Editor dialog box

Cutting, copying, and pasting data
The cut, copy, and paste commands on the Oracle Daybreak menu bar allow you to move 
and edit data. 

To cut, copy, and paste with the Oracle Daybreak menu bar

1 Open the form and select the data in the field you want to edit. (You can either drag your 
mouse over the data or double-click the data to select it.)

2 On the Edit menu, select Cut or Copy. (Copy leaves the data in the field while copying it; 
Cut clears the field when it copies the data.)

3 Move the cursor to the field where you want to place the copied data. 

4 On the Edit menu, choose Paste.

Oracle Daybreak pastes the cut or copied data in the new field.
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Keyboard guide for the previous steps

These three tasks can also be completed with the keyboard by doing the following:

Press this: To do this:

CTRL+X Cut
CTRL+C Copy
CTRL+V Paste

Clearing data
You can clear data from a form at any time. The data you clear is simply erased from the 
form, not deleted from the database. You can clear fields, records, blocks, or entire forms. 
This is particularly useful when you went to add an new entry to a record, block, or form 
that appears “full.”

If the data is new and has never been saved in the database, it will be permanently lost 
when you clear it from the form. Some items cannot be cleared of information. If you 
attempt to clear an item that cannot be cleared, the error message “Field is protected 
against update” appears in the message line.

To clear a field

• Select the field you want to clear and use one of the following methods to clear data:

On the Navigation menu, choose Field > Clear.
-or-
Select and type over the existing data, or use the BACKSPACE or DELETE key to remove the 
data.
-or-
Press CTRL+U.

IMPORTANT:
The data you clear from the field is not available for pasting into another field. If you want 
to paste the data elsewhere, use the Copy or Cut commands on the Edit menu.

To clear a record 

• Select the record you want to clear and use one of the following methods to clear data:

On the Navigation menu, choose Record > Clear.
-or-
On the Oracle Daybreak tool bar, choose the Clear Record icon.
-or-
Press SHIFT+F4.

Oracle Daybreak clears the values in all the fields of your current record and returns the 
cursor to the first field of the next record.

To clear the current block

• Select a field in the block you want to clear and use one of the following methods to clear 
data:

On the Navigation menu, choose Block > Clear.
-or-
Press SHIFT+F5.
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Oracle Daybreak clears the block and returns your cursor to the first field in the current 
block.

IMPORTANT: 
If the current block is a multi-record block, this action erases all records displayed in the 
block.

To clear a form

• Open the application of the form you want to clear and press SHIFT+F7.

Oracle Daybreak clears the data from all the fields of the current form and returns your 
cursor to the first field of the form.

Duplicating data
If data needs to be repeated in a new record, you can duplicate data from a previous 
record.

To copy a field from a previous record

1 Depending on the form you are using, enter a new record or query an existing record.

2 On the Navigation menu, choose Record > Insert
-or-
On the Oracle Daybreak tool bar, choose the Insert Record icon
-or-
Press F6.

Oracle Daybreak inserts a new record after the existing record.

3 Move the cursor to the field you want to duplicate in the new record.

4 On the Navigation menu, choose Field > Duplicate.
-or-
Press F3.

Oracle Daybreak copies the field value from the previous record to the current record.

To copy all fields from a previous record

1 Enter a new record, or query an existing record in your form.

2 On the Navigation menu, choose Record > Insert
-or-
On the Oracle Daybreak tool bar, choose the Insert Record icon
-or-
Press F6.

Oracle Daybreak inserts a new record after the existing record.

3 On the Navigation menu, select Record > Duplicate.

-or-
Press F4.
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IMPORTANT: 
If your current block requires all records to be unique, the Duplicate command does not 
duplicate those fields that must be unique.

To copy all information on a page and its sub pages

1 Move the cursor to the first field on the page you want to duplicate.

2 On the Oracle Daybreak tool bar, choose the Copy with Details Record icon.

Note: For this process to work, the entry has to be locked (lock parameter set to y)

3 Make the changes you desire to the details in the duplicate entry to make it unique.

4 Choose the Copy with Details Record icon to complete sub tabs.

5 Make the changes you desire to the sub page details in the duplicate entry to make it 
unique.

6 Save your new entry.

Creating and deleting records
You can enter new records in the database or delete existing records from the database. 
Only users who have the appropriate permissions set up in their user responsibility can 
create or delete records.

To create a new record

1 On the Navigation menu, choose Record > Insert.
-or-
On the Oracle Daybreak tool bar, click Insert Record.
-or-
Press F6.

Note: When you create a record in a multi-record block, Oracle Daybreak inserts a new 
blank row below the selected row. In a single-record block, Oracle Daybreak clears the 
fields in the block. 

2 Once the selected field is cleared, enter the data for the new record. 

3 On the File menu, choose Save.
-or-
On the Oracle Daybreak tool bar, click Save.
-or-
Press F10.

Oracle Daybreak saves the record in the database.

IMPORTANT: 
If you exit the form without saving your work, the record is not added to the database.
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To delete a record 

1 Select the record you want to delete. 

2 Use one of the following methods to delete data from a field:

On the Navigation menu, choose Record > Remove.
-or-
On the Oracle Daybreak tool bar, choose the Remove Record icon.

Oracle Daybreak erases the current record from your form and returns your cursor to the 
first field of the next record; however, the record is not yet deleted.

3 On the File menu, choose Save.
-or-
On the Oracle Daybreak tool bar, click Save.
-or-
Press F10.

IMPORTANT:
If you exit the form without saving your work, the record is not deleted from the database.
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Using the Editor dialog box
You can use the Editor dialog box to view, enter, or update the entire contents of an entry 
field. The Editor dialog box is especially useful for editing scrollable text fields. A scrolla-
ble text field is a field whose actual width is longer than its display width and whose con-
tent you can view by scrolling through the field. Searches performed in the Editor dialog 
box are case-sensitive.

IMPORTANT:
If a text field is set up to use a default system editor, then the following procedures open 
the editor determined by the profile option “Editor (Character).”

To use the Editor dialog box

1 Open the form and select the field you want to edit.

2 On the Edit menu, choose Edit Field.

The Editor dialog box appears with the text from the field you selected.

Note: You can also open the Editor dialog box by pressing CTRL+E.

3 Enter a new text or edit the existing text in the Editor dialog box and choose Ok.

IMPORTANT: 
If the current field is a display-only field, then the Editor dialog box appears in display-
only mode.

To search for a phrase and replace it with another phrase

1 On the Edit menu, choose Edit Field.

The Editor dialog box appears.

2 Choose Search.

The Search/Replace dialog box appears.
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3 In the Search for field, type the text or characters you want to find on the form.

If you want to replace that data with other data, type the new data in the Replace with 
field.

4 Choose the Search button to search for the value.
-or-
Choose Replace to search for the value and replace the first occurrence.
-or-
Choose Replace All to search for the value and replace all occurrences.

5 To close the Search/Replace dialog box, choose Cancel.

6 When you are finished editing the value in the Editor window, choose Ok.

The Editor dialog box closes the window and the edited value appears in the field.

Exiting a form/leaving Oracle Daybreak
You can close a Oracle Daybreak form, or end a Oracle Daybreak session, using the mouse 
or keyboard.

To save exit a form/leave Oracle Daybreak

• On the File menu, choose Exit
-or-

• On the Oracle Daybreak tool bar, choose Exit (the blue door icon)
-or-

• Press CTRL + Q.

Oracle Daybreak will end a Oracle Daybreak session when you perform one of these 
actions from the Login form.

Entering and querying data
This chapter explains how to use the List of Values dialog boxes and search for data while 
using a form.

List of Values (LOV) dialog box
Many fields on Oracle Daybreak forms are linked to a List of Values (LOV) dialog box. 
An LOV displays all possible entries that Oracle Daybreak will accept for a particular 
field. You can select data from the LOV to complete the field instead of having to search 
for acceptable entries. Likewise, a field that is associated with an LOV only accepts 
entries found on the list of values. Using the LOV increases accuracy and productivity, as 
it ensures uniformity and efficiency during data entry.

Note: If you are in Enter-Query mode, the LOV cannot be used.
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When an LOV is available for a field, “List of Values” appears on the status line. Also, 
when you move the cursor to the field with an LOV from a Lookup field in the Setup 
menu, a yellow hint box appears, citing the lookup type for the LOV.

When you open an LOV from an entry field, the field’s LOV dialog box appears.

An example of a List of Values box. This one appears from the Street Type field on an 
Address block.
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An LOV might contain more than one column of information. Most LOVs provide a 
descriptive heading at the top of each column. 

To select data from an LOV

1 Move the cursor to an entry field with an LOV.

“List of Valu...” appears on the status line.

2 On the Edit menu, choose List of Values.
-or-
Press F9.

When the LOV appears, you can either use the mouse to scroll through the list box and 
double-click on a value to select it, or press the UP ARROW or DOWN ARROW keys to high-
light a value with the blue bar. 

If you choose Cancel, the LOV closes and no entry appears in the field.

3 Press ENTER or choose OK to select the value.

Once you select a value, the LOV dialog box closes and the selected value appears in the 
field. 
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Additional LOV tools 
In addition to allowing you to select a field value, LOVs provide tools to simplify entering 
data and working with long lists. Auto Reduction lets you view a condensed portion of the 
entire list of values. Power List allows you to quickly enter data without opening the LOV.

In some cases, an LOV is too large to fit entirely in the list box and the Long-List LOV 
appears. 

Auto reduction
Using Auto Reduction, you can shorten an LOV. With a shortened list, you only need to 
scan a subset of the original values. 

To use the Auto reduction feature

• In the Find field on the LOV dialog box, type the first character(s) of a value you want to 
locate. (A percent sign appears by default in the Find field.)

Oracle Daybreak automatically reduces the list to just those values in the first column that 
match the characters you enter. 

Note: To return to the entire contents of the LOV, type the wildcard character % in the 
Find field and press ENTER.

List search
If you do not know the initial characters of your value, but do know that your value con-
tains a certain word or set of characters, you can perform a list search to find the values 
that contain those words or characters.

To perform a list search

1 In the Find field on the LOV dialog box, enter any group of characters as search criteria. 
Use wildcard characters, such as the percent sign (%), which represents any number of 
characters, or underline ( _ ), which represents a single character in your search criteria.

IMPORTANT:
The criteria you enter for a list search is not case-sensitive. For example, to reduce a 
search list to just those values containing the word “schedule,” enter %schedule% in the 
Find field.

2 Choose Find. 

A reduced list appears, containing just those values that match the search criteria.
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Long-list
Long-List is the other tool you can use to shorten an LOV. Long-List works similarly to 
Auto Reduction. The Long-List dialog box appears when a field has a list too large for 
Auto Reduction. 

To perform a list search

1 In the Find field on the long list LOV dialog box, type the first few characters that occur in 
your value in the Find field

2 Choose Find.

Oracle Daybreak reduces the long list to a smaller sub set of values meeting the search cri-
teria in the Find field in a regular LOV.

3 Select the value you want to use and choose Find. 

 Other LOV features
You do not have to use a field’s LOV to complete a field. If your entry appears in the 
field’s’ LOV, Oracle Daybreak will accept it when you type it in the field.

The Auto Reduction logic that applies to the LOV also applies to your entry in a field with 
an LOV. If you type the first letter of your entry and press TAB, Oracle Daybreak will auto-
matically complete the field if there is a single match in the LOV.

If more than one entry in the LOV share the characters you typed, Oracle Daybreak will 
open the LOV displaying only the entries beginning with those characters.

If no entry in the LOV matches the characters you typed, Oracle Daybreak opens the LOV 
displaying all of its entries when you press TAB.
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Querying data
Oracle Daybreak provides you with search options to locate information when working 
with a form. You can retrieve and review all available information in your database with-
out having to remember the information from a previously displayed form or printing 
lengthy reports to view an item. Instead, you can perform a search to obtain and review the 
information you want.

This section describes the methods you can use to locate and retrieve records in Oracle 
Daybreak. These include:

• Using query operators
• Query-by-example
• Query/Where
• Using query count

Note: If you are in Enter-Query mode, the LOV cannot be used.

IMPORTANT: 
Searches cannot be performed in forms that require using the Search page to retrieve infor-
mation. These forms (for example, the Underwriting form, the Funding form, and Cus-
tomer Service form) only display run-time output, or only run specific processes. The 
following message appears in the message line if you attempt to search such a form: 
“Function key not allowed. Press Ctrl+F1 for list of valid keys.”

Using query operators
Query operators are used to create search criteria to limit searches to specific information. 
The query operators available in most fields include:

Operator Meaning Example Expression

= equal to = 'Janet' or = 107
!= not equal to != 'Bob' or != 107
> greater than > 99 or > '01-JAN-93'
>= greater than or equal to >= 55
< less than < 1000.00
<= less than or equal to <= 100
#BETWEEN between two values #BETWEEN 1 AND 1000

The query operator expressions retrieve results according to character-ordering rules for 
character fields and numeric-ordering rules for numeric fields. For example, look at the 
following field values:

002, 003, 004, 005, 078, 123, 253, 441, 576, 775, 1274, 3298, 
4451, 5600, 9578, 10500, 58437, 708445
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These values are shown in the order you expect for numeric values, where 005 is between 
004 and 078. If the field is defined as a numeric field, then the phrase “#BETWEEN 004 
AND 078” would retrieve 004, 005, and 078.

However, if the field is defined as a character field, then the phrase “#BETWEEN 4 AND 
7” would retrieve the values 441, 576, 4451, 5600, and 58437, which all start with 
characters between 4 and 7. The values 775 and 005 would not appear because 775 is 
lexically greater than 7, and 0 is lexically less than 4.

Some fields contain date values that are actually “Date-format” character values. These 
fields act like character fields in that the value 01-FEB-92 would be lexically less than 01-
JAN-92, because F precedes J in a character set.

IMPORTANT: 
Sometimes you cannot instantly determine if a field containing numeric values is defined 
as a character or numeric field. To identify what the field type is, you may have to enter 
and experiment with different search criteria expressions and see what results are returned.

Tips for using Query Operators
• Use single quotation marks ('  ') to enclose the character or date value in your 

expression. For example:

'Texas'
'01-MAY-93'

• Query operators cannot be used in time fields.

When you use the #BETWEEN query operator, the search criteria “#BETWEEN value1 
AND value2” retrieves all records containing values between and including value1 and 
value2. The same applies to dates. For example, using the search criteria “#BETWEEN 
'01-JAN-93' AND '01-MAR-93'” in a date field retrieves all records with dates between 
and including January 1, 1993 and March 1, 1993.

Finding patterns with wildcard characters
In addition to query operators, you can include wildcard characters in your search criteria. 
Wildcard characters search for particular patterns in your data. Use the percent (%) wild-
card character within a field to represent any number of characters (including no charac-
ters), or use the underline ( _ ) wildcard character to represent any single character. 

For example, if you want to retrieve all records that contain the word “XXX” in a specific 
field, you would enter the search criteria %XXX% in that field.
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Enter-Query mode
If you want to retrieve a group of records in a Oracle Daybreak from using search criteria, 
you can use Enter-Query mode.The Enter-Query mode may be used to specify complex 
search criteria in any of the fields on your current block. 

The search criteria can include:

• Specific values
• Phrases containing wildcard characters
• Phrases containing query operators 
• Any combination of the three to help you pinpoint the data of interest.

IMPORTANT: 
When your application is in Enter-Query mode, you will not be able to navigate out of the 
current form. To navigate from the form, you must exit Enter-Query mode by choosing 
Cancel Query or Exit on the task bar or pressing CTRL+Q.

To user Query-by-example

1 On the Query menu, choose Enter
-or-
Press F7
-or-
On the Oracle Daybreak toolbar, click the Enter Query icon.

Oracle Daybreak switches from data entry mode to Enter-Query mode and clears the form. 
The Enter-Query message appears in the status line. 

2 Enter search criteria in any of the fields, using wildcard characters and query operators as 
necessary. You can also choose Last Criteria on the Query menu to display the search cri-
teria used in your last search, if there was one.   

Note: Pressing F7 twice will also display the search criteria from your last search.

IMPORTANT: 
While in Enter-Query mode, all check boxes are in a neutral state; that is, they are neither 
selected nor cleared as a default. If you want your search criteria to include a selected 
check box, you have to select it, regardless of whether it already appears to be checked. 
Similarly, if you want your search criteria to include a cleared check box, you have to clear 
it, regardless of how it currently appears. (To clear it, first select the check box to activate 
it, then select it again to clear it.)

3 On the Query menu, choose Execute
-or-
Press F8
-or-
On the Oracle Daybreak toolbar, click the Execute Query icon.

IMPORTANT: 
To retrieve all the database records for a block, you can bypass steps 1 and 2 and select 
Execute on the Query menu. This is known as a blind query. To retrieve all records for a 
block, press F7, then press F8 to perform the query.
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4 To leave the Enter-Query mode, choose Cancel from the Query menu
-or- 
Press CTRL+Q
-or-
On the Oracle Daybreak toolbar, click the Cancel Query icon.

Query/where 
An even more sophisticated search method is to use Query/where. Query/where allows 
you to modify a query by using a SQL Plus statement as your search criteria.

To use Query/where

1 On the Query menu, choose Enter
-or-
Press F7
-or-
On the Oracle Daybreak toolbar, click the Enter Query icon.

Oracle Daybreak switches to Enter-Query mode.

2 Enter the character & (or a blind variable) in the field from which you want to run the 
query.

3 On the Query menu, choose Execute
-or-
Press F8
-or-
On the Oracle Daybreak toolbar, click the Execute Query icon.

The Query/Where dialog box appears.

4 Type the search criteria in the format of a SQL Plus statement in the window. 

For example, the following Query/Where search criteria:

:P like '%VEH%' and :A in ('0000000374', '0000000532')

Would produce the following results:

The two loan loans, 0000000374 and 0000000532.

5 Choose OK to execute the query. 
-or-
Choose Cancel to close the Query/Where dialog box without running a query. 

Note: If you have a long statement as your search criteria, you can use a field editor to 
make changes to your statement by choosing Search. 
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Query count 
If you do not need to retrieve the records from a query-by-example search, but only want 
to know how many records match your search criteria, you can perform a query count.

To obtain a count of the number of records

1 On the Query menu, choose Enter
-or-
Press F7
-or-
On the Oracle Daybreak toolbar, click the Enter Query icon.

2 Enter the search criteria in the field you want to perform the query.

3 On the Query menu, choose Count Hits.
-or-
Press SHIFT+F2.

Oracle Daybreak counts your query. A message appears on the message line displaying 
the number of records query-by-example would retrieve if you ran the search.

IMPORTANT: 
If you select Count Hits on the Query menu without specifying any search criteria in a 
block, query count displays the total number of records in the database for that block.
Appendix B :-19  User Guide - Consumer Loans Origination



Hot keys
“Hot keys” are keystroke shortcuts that perform navigation and data entry tasks. A dialog 
box containing a form’s available hot keys can be viewed by selecting Help > Keys on the 
Oracle Daybreak menu bar. Below is a list of these keys:

Function Key(s)
Block Menu F5
Cancel Query CTRL + Q
Clear Block SHIFT + F5
Clear Field CTRL + U
Clear Form SHIFT + F7
Clear Record SHIFT + F4
Copy CTRL + C
Count Query SHIFT + F2
Cut CTRL + X
Delete Record SHIFT + F6
Display Error SHIFT + F1
Down DOWN ARROW
Down CTRL + L
Duplicate Item F3
Duplicate Previous Record F4
Exit CTRL + E
Enter Query F7
Execute Query F8
Help CTRL + H
Insert Record F6
List Tab Pages F2
Move between master tabs

Master tab 1 SHIFT + CTRL + F1
Master tab 2 SHIFT + CTRL + F2
Master tab 3 SHIFT + CTRL + F3
Master tab 4 SHIFT + CTRL + F4
Master tab 5 SHIFT + CTRL + F5
Master tab 6 SHIFT + CTRL + F6
Master tab 7 SHIFT + CTRL + F7
Master tab 8 SHIFT + CTRL + F8
Master tab 9 SHIFT + CTRL + F9
Master tab 10 SHIFT + CTRL + F10

Move to next page/sub page CTRL+TAB
Move to previous page/sub page CTRL+SHIFT+TAB
Next Block/Page to sub page CTRL + PAGE DOWN
Next Field TAB
Next Primary Key SHIFT + F3
Next Record SHIFT + DOWN ARROW
Next Set of Records SHIFT + CTRL + PAGE DOWN
Paste CTRL + V
Previous Block/Sub page to page CTRL + PAGE UP
Previous Field SHIFT + TAB
Previous Record SHIFT + UP ARROW
Print SHIFT + F8
Return ENTER
Save changes F10
Scroll Down PAGE DOWN
Scroll Up PAGE UP
Scroll Keys CTRL + F1
Up CTRL + P
Up UP ARROW
Update Record CTRL + U
Appendix B :-20  User Guide - Consumer Loans Origination



Appendix B :-21  User Guide - Consumer Loans Origination



APPENDIX C : PAYMENT AMOUNT CONVERSIONS

The following table contains the calculations Oracle Daybreak uses to convert the differ-
ent payment frequencies (weekly, biweekly, semimonthly, and so on) to standard monthly 
values for installment accounts.

Payment Frequency: Scheduled Monthly Income Amount:

D = Deferred Zero fill

P = Single payment loan Zero fill

W = Weekly (due every week) Multiple by 4.33

B = Biweekly (due every two weeks) Multiple by 2.16

E = Semimonthly (due twice a month) Multiple by 2

M = Monthly (due every month) As given

L = Bimonthly (due every two months) Divide by 2

Q = Quarterly (due every three months) Divide by 3

T = Triannually (due every four months) Divide by 4

S = Semiannually (due twice a year) Divide by 6

Y = Annually (due every year) Divide by 12
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